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IMPORTANT: PLEASE READ THIS SOFTWARE 
LICENSE AGREEMENT BEFORE USING THE 
SOFTWARE. BY USING THE SOFTWARE, YOU ARE TO 
BE BOUND BY THE TERMS AND CONDITIONS 
STATED. IF YOU DO NOT AGREE WITH THE TERMS OF 
THIS LICENSE,RETURN THE UNUSED SOFTWARE TO 
THE POINT OF PURCHASEYOUR MONEY WILL BE 
REFUNDED.

1. License. (a)If your license is for Eudora Planner. 
QUALCOMM Incorporated (“QUALCOMM”) grants to the 
Licensee purchasing this copy of Eudora Planner Software 
a nonexclusive, nontransferable license to use the Eudora 
software and other software and fonts contained in this 
package (collectively the “Software”) and its 
documentation for use in accordance with this License. 
QUALCOMM or QUALCOMM's Licensors retain title to the 
Software and related documentation although the 
Licensee owns the media on which the Software and 
documentation are recorded, if any.

This License allows use of the Software and 
documentation only by the number of Users and on the 
platform specified on the UPC label on the diskette(s) or, 
for electronic transactions, the number of Users licensed. 
“User(s)” means Licensee, if Licensee is an individual 
purchasing the Software for use at office or home, or, if 
Licensee is a corporation or similar business or 
commercial entity or government agency, its current 
employees. For qualifying educational institutions, “Users” 
also means faculty and staff teaching for or employed by 
Licensee and registered students enrolled at a single 
campus operated by Licensee. Subject to the limitations of 
this License, each authorized User may only use the 
Software on (i) any central processing unit (“CPU”), 
workstation or portable which is owned or controlled by 
Licensee, and (ii) any User-owned CPU, workstation or 
portable. 

(b)If your license is for Eudora Group Planner. 
QUALCOMM Incorporated (“QUALCOMM”) grants to the 
Licensee purchasing this copy of Eudora Group Planner a 
nonexclusive, nontransferable license to use one copy of 
the Eudora Group Planner software and other software 
contained in this package (collectively the “Software”) and 
its documentation in accordance with this License. 
QUALCOMM or QUALCOMM’s Licensors retain title to the 
Software and related documentation and all copies thereof 
although the Licensee owns the media on which the 
Software and documentation are recorded, if any. This 
License allows use of the Software and documentation for 
up to the number of accounts licensed for Licensee's 
internal business purposes. Licensee may only use the 
Software on one computer system at a time which shall be 
owned or controlled by Licensee.     

For Trial Version Customers of either Eudora Planner or 
Eudora Group Planner. This License allows use of the 
Software for a period of up thirty (30) days after initial 
download for demonstration and evaluation purposes only 
on the platform licensed for Licensee’s internal business 
purposes. Licensee may only use the Software on one 
central processing unit at a time which shall be owned or 
controlled by Licensee. This Software is not for resale. 

2. Restrictions. This License sets forth the terms and 
conditions governing the use of the Software and 
documentation. Licensee may not rent, lease or otherwise 
transfer the Software or its documentation. Licensee may 
make a limited number of copies of the Software based on 
the number of licensed Users and a reasonable number of 
back-up copies. The Software contains copyrighted 



iii
material, trade secrets and other proprietary material. 
Licensee must reproduce on all such copies of the 
Software the copyright notices and any other proprietary 
legends that were on the original copy of the Software. 
Licensee shall not, without the prior written permission of 
QUALCOMM, nor permit anyone else to, decompile, 
reverse engineer, disassemble or otherwise reduce the 
Software to a human perceivable form, or to modify, 
network, rent, lease, loan, distribute, or create derivative 
works based upon the Software or the documentation in 
whole or in part. Notwithstanding, 

if the Software is lawfully acquired outside of the United 
States within a jurisdiction which is a member of European 
Economic Community (EEC) subject to the EEC Council 
Directive of May 14, 1991, Licensee agrees that within that 
jurisdiction it shall not, and shall not allow any party on 
Licensee’s behalf, to attempt to reverse engineer or 
decompile the Software into another computer language, 
except as expressly and specifically provided in the EEC 
Council Directive of May 14, 1991. Any and all information 
obtained during such lawful reverse engineering and/or 
decompiling activities, including but not limited to, the 
organization, logic, algorithms and processes of the 
Software, shall be deemed to be the confidential and 
proprietary information of QUALCOMM or its Licensors. 
Licensee shall not make copies of the copyrighted 
Software documentation without the prior written 
permission of QUALCOMM provided that for electronic 
transactions, Licensee may make one (1) hard copy of 
such documentation for each User.

3. Technical Support. Licensee must register in order to be 
eligible for technical support via telephone or electronic 
mail. For a period of ninety(90) days, commencing with the 
date of Licensee’s first telephone call requesting support, 
Licensee will have access to technical support for the 
Software for the technical contact designated on the 
product registration card included with this package or 
specified via electronic mail registration, subject to 
Licensee’s compliance with QUALCOMM’s instructions for 
accessing such support and standard verification 
procedures.   Upon the expiration of the above-described 
ninety (90) day period, Licensee may extend technical 
support on a per-incident or annual fee basis in 
accordance with QUALCOMM’s then current pricing and 
terms. Upgrades to the Software and its documentation, if 
any, are not included and may be sold separately.

4. Termination. This License is effective until terminated. 
Licensee may terminate this License at any time by 
destroying all copies of the Software and its 
documentation. This License will terminate immediately 
without notice from QUALCOMM if Licensee fails to 
comply with any provision of this License. Upon 
termination, Licensee must destroy all copies of the 
Software and its documentation.

5. Export Law Assurances. Licensee agrees and certifies 
that neither the Software nor any other technical data 
received from QUALCOMM, nor the direct product thereof, 
will be exported outside the United States except as 
authorized and as permitted by the laws and regulations of 
the United States. If the Software has been rightfully 
obtained by Licensee outside of the United States, 
Licensee agrees that Licensee will not re-export the 
Software nor any other technical data received from 
QUALCOMM, nor the direct product thereof, except as 
permitted by the laws and regulations of the United States 
and the laws and regulations of the jurisdiction in which 
Licensee obtained the Software. The Software may not be 
exported to any of the following countries: Cuba, Iran, Iraq, 
Libya, North Korea, Sudan or Syria.

6. Government End Users. If Licensee is acquiring the 
Software on behalf of any unit or agency of the United 
States Government, the following provisions apply. The 
Government agrees: (i) if the Software is supplied to the 
Department of Defense (“DOD”), the Software is classified 
as “Commercial Computer Software” and the Government 
is acquiring only “restricted rights” in the Software and its 
documentation as that term is defined in Clause 252.227-
7013(c)(1) of the DFARS; and (ii) if the Software is 
supplied to any unit or agency of the United States 
Government other than DOD, the Government's rights in 
the Software and its documentation will be as defined in 
Clause 52.227-19(c)(2) of the FAR or, in the case of 
NASA, in Clause 18-52.227-86(d) of the NASA 
Supplement to the FAR or the successor clauses to any of 
these clauses.

7. Limited Warranty on Diskettes. (Not applicable to 
Software purchased electronically.) QUALCOMM warrants 
the diskettes on which the Software is recorded to be free 
from defects in materials and workmanship under normal 
use for a period of ninety (90) days from the date of 
purchase. QUALCOMM's entire liability and Licensee's 
exclusive remedy will be replacement of the diskettes not 
meeting QUALCOMM's limited warranty and which are 
returned to the place of purchase within such warranty 
period. QUALCOMM will have no responsibility to replace 
a diskette damaged by accident, abuse or misapplication. 
ANY IMPLIED WARRANTIES ON THE DISKETTES 
INCLUDING THE IMPLIED WARRANTIES 
OFMERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE LIMITED INDURATION 
TO NINETY (90) DAYS FROM THE DATE OF 
PURCHASE.

8. Disclaimer of Warranty. Licensee expressly 
acknowledges and agrees that the use of the Software and 
its documentation is at Licensee's sole risk. The Software, 
documentation, and technical support are provided “AS 
IS” and without warranty of any kind. Information regarding 
any third party services included in this package, if any, is 
provided as a convenience only, without warranty by 
QUALCOMM, and will be governed solely by the terms 
agreed upon between Licensee and the third party 
providing such services. TO THE MAXIMUM EXTENT 
PERMITTED UNDER APPLICABLE LAWS,QUALCOMM 
AND QUALCOMM'S LICENSOR(S) (FOR THE 
PURPOSES OF PROVISIONS 8 AND 9, QUALCOMM 
AND QUALCOMM'S LICENSOR(S) SHALL BE 
COLLECTIVELY REFERRED TO AS QUALCOMM) 
EXPRESSLY DISCLAIM ALL WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO THE 
IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, AND 
NONINFRINGEMENT. QUALCOMM DOES NOT 
WARRANT THAT THE FUNCTIONS CONTAINED IN THE 
SOFTWARE WILL MEET LICENSEE'S 
REQUIREMENTS, OR THAT THEOPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-
FREE, OR THAT DEFECTS IN THE SOFTWARE WILL 
BE CORRECTED. FURTHERMORE, QUALCOMM DOES 
NOT WARRANT OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE OR ITS DOCUMENTATION IN 
TERMS OF THEIR CORRECTNESS, ACCURACY, 
RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN 
INFORMATION OR ADVICE GIVEN BY QUALCOMM OR 
ITS AUTHORIZED REPRESENTATIVE SHALL CREATE 



A WARRANTY OR IN ANY WAY INCREASE THE SCOPE 
OF THIS WARRANTY. SOME JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, 
SO THE ABOVE EXCLUSION MAY NOT APPLY.

9. Limitation of Liability. TO THE MAXIMUM EXTENT 
PERMITTED UNDER APPLICABLE LAWS, UNDER NO 
CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL 
QUALCOMM, ITS AFFILIATES OR THEIR DIRECTORS, 
OFFICERS, EMPLOYEES OR AGENTS BE LIABLE FOR 
ANY INCIDENTAL, SPECIAL OR CONSEQUENTIAL 
DAMAGES (INCLUDING DAMAGES FOR LOSS OF 
BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION AND THE LIKE) 
ARISING OUT OF THE USE OR INABILITY TO USE THE 
SOFTWARE OR ITS DOCUMENTATION, EVEN IF 
QUALCOMM OR ITS AUTHORIZED REPRESENTATIVE 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. SOME JURISDICTIONS DO NOT ALLOW 
THE LIMITATION OR EXCLUSION OF LIABILITY FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE 
ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY. 
In no event shall QUALCOMM’s total liability to Licensee 
for all damages, losses, and causes of action (whether in 
contract, tort, including negligence, or otherwise) exceed 
the amount paid by Licensee for the Software and its 
documentation.

10. No Waiver or Assignment. No delay or failure to take 
action under this License will constitute a waiver unless 
expressly waived in writing, signed by a duly authorized 
representative of QUALCOMM, and no single waiver will 
constitute a continuing or subsequent waiver. This License 
may not be assigned, sublicensed or otherwise transferred 
by Licensee, by operation of law or otherwise, without 
QUALCOMM’s prior written consent, provided that 
Licensee may assign this License upon written notice to 
QUALCOMM in instances in which such assignment is to 
an entity which acquires all or substantially all of the 
business of Licensee, whether by merger, consolidation, 
or acquisition of assets.
11. Controlling Law and Severability. This License shall be 
governed by and construed in accordance with the laws of 
the United States and the State of California, as applied to 
agreements entered into and to be performed entirely 
within California between California residents. If for any 
reason a court of competent jurisdiction finds any 
provision of this License, or portion thereof, to be 
unenforceable, that provision of the License shall be 
enforced to the maximum extent permissible so as to 
effect the intent of the parties, and the remainder of this 
License shall continue in full force and effect.

12. Entire Agreement. This License constitutes the entire 
agreement between the parties with respect to the use of 
the Software and its documentation, and supersedes all 
prior or contemporaneous understandings or agreements, 
written or oral, regarding such subject matter. There shall 
be no contract for purchase or sale of the Software except 
upon the terms and conditions specified herein. Any 
additional or different terms or conditions proposed by 
Licensee or contained in any purchase order are hereby 
rejected and shall be of no force and effect unless 
expressly agreed to in writing by QUALCOMM. No 
amendment to or modification of this License will be 
binding unless in writing and signed by a duly authorized 
representative of QUALCOMM.
iv
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Introduction

What Is Eudora Planner?
Eudora Planner is a schedule and contact management tool for Windows 95 and 
Windows NT that provides flexible portability and simple data sharing in a package 
that is easy to learn and quick to use.

Flexible Portability
Eudora Planner's portability features were designed for today’s increasingly mobile 
manner of working, which includes paper and electronic organizers, laptops and 
digital phones. It balances the need for simple sharing in the office with the need for 
immediate access to contact and meeting information while away. 

Eudora Planner gives you many options for “going mobile:”

• Advanced, flexible printing with customizable templates for printing to popular 
paper-based organizers

• Automatic laptop synchronization that lets you disconnect from the network and 
take your Eudora Planner data with you, then automatically synchronizes your 
offline changes when you return

• Hand-held organizer synchronization through IntelliSync, a third-party tool that 
synchronizes your Eudora Planner data with either PalmPilot or Windows CE 
devices

• TCP/IP Internet access for sharing calendars and address books and 
scheduling group events from the road or offices in other cities

• Web-based, customized calendars and address books created automatically 
using Eudora Planner’s Web Publisher program.
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High-Speed Access to Your Data—Anytime, Anywhere
Eudora Planner’s exclusive QuickAccess pop-up tools put calendar and address 
book data at your fingertips at all times—even when Eudora Planner’s not running. 
You can quickly look up a contact record while writing an e-mail, view today's 
agenda while surfing the Internet, or receive reminders of upcoming meetings—all 
without launching Eudora Planner. 

Eudora Planner’s customizable tabs make it easy to filter and retrieve groups of 
contacts or events, and even add a unique background image to represent the 
contents of each tab. You can also create a special look, or style, for each category 
of events and contacts you use, making it easier still to quickly get information from 
Eudora Planner.

Eudora Planner’s integration with the Internet lets you find a street map or ZIP+4 
code with a single click from any contact record. In your address book, automatic 
hyperlinks for e-mail addresses and URLs provide the same one-click access to 
your Internet-enabled contacts.

Share Schedules and Contacts on the Network
If you’re part of a workgroup that uses Eudora Group Planner, you can selectively 
share calendars, contacts and to-do lists with others over your TCP/IP network. 
Group scheduling makes it easy to schedule people, rooms and resources while 
avoiding the scheduling conflicts that can so often occur. With support for required 
or optional attendance, Eudora Group Planner automatically displays a list of 
available meeting times and indicates potential schedule conflicts. It also 
automatically notifies invitees of new meetings and indicates which users have 
accepted or declined.

You can connect to Eudora Group Planner using a TCP/IP connection within the 
office or remotely with no difference in functionality. And for those on the Internet or 
an intranet, Eudora Planner’s Web Publisher feature lets anyone with a Web 
browser and access privileges view shared schedules and address books.

Conventions Used in the Book
This book calls attention to certain kinds of information with the following symbols:

Used as a note to provide additional information or to ensure that you avoid 
problems.

Used as a tip to describe a noteworthy feature.

Used to indicate that you can find more details on a topic in online Help.

Used to indicate that you can right-click an item to see a shortcut menu that 
contains commands you can use on the item.
xii Introduction
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Chapter 1

Getting Started
This chapter provides an overview of the key elements and concepts of Eudora 
Planner.

Eudora Planner Features
The following sections provide a brief description of Eudora Planner’s major 
features.

The Calendar
The Eudora Planner Calendar is a personal planner with which you can record and 
track the items that make up your schedule. These items—called Events in Eudora 
Planner—can be meetings with groups or individuals, to-dos or calls you need to 
complete, special dates, or long-term activities that span days or weeks, such as 
conventions or vacations. You can attach e-mail addresses, Web site addresses and 
graphics to Events, as well as the names and telephone numbers of Contacts in 
your Address Book. Eudora Planner’s Calendar also contains a To-Do List that lets 
you easily view, modify, and organize your tasks and calls.

The Address Book
Use the Eudora Planner Address Book to manage information about the individuals 
and companies you communicate with. The records in your Address Book—called 
Contacts in Eudora Planner—hold personal information such as names, company 
names, home and business addresses, telephone numbers, and e-mail addresses. 
Your Contacts can also contain notes, links to associated Web sites, and attached 
documents created in other applications. The Address Book is fully integrated with 
your Eudora Planner Calendar, so Contacts related to Events can be linked to those 
Events.
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Categories
You can organize your Eudora Planner information by assigning categories to like or 
related Calendar and Address Book items. You can assign one or more categories 
to individual Events or Contacts. For example, you could assign only one category 
called Family to the Contact for a relative, whereas you might assign both a 
Business and Personal category to the Contact for a business associate who is also 
a friend. If you then apply different text styles and colors to your categories, you can 
tell at a glance what category an Event or Contact belongs to.

If you’re using Eudora Group Planner, you have the ability to create categories that 
are either private or public. Private categories reside only in your database and are 
not available to other users; public categories reside on a workgroup server and can 
be shared with other Eudora Group Planner users connected to that server. You can 
add these public categories to your Calendar and Address Book when you connect 
to a workgroup server. For more details about sharing Eudora Planner information, 
see Chapter 7, “Using Eudora Group Planner,” on page 119.

Tabs
Just as related Events and Contacts can belong to categories, so too can related 
categories be grouped together in tabs. Eudora provides Calendar tabs and 
Address Book tabs that let you visually associate categories that contain the same 
kind of information. For example, you can create a Vacation tab in your Calendar 
that shows Events in your private Vacation category and also those in the public 
Holiday category on your company’s server. When you select the Vacation tab, you 
see all the vacation Events that apply to you. Similarly, you can create tabs in the 
Address Book for organizing separate categories of Contacts.

A tab can contain multiple categories, but one of those categories must be the 
default for that tab. The default category for a tab is that category automatically 
assigned to an Event or Contact created on that tab. You can choose a default 
category for each tab in your database.

You can also create a unique visual style for each of your tabs, so you always know 
at a glance which tab you are viewing.

Plugins
In Eudora Planner, the Calendar and Address Book are implemented as separate, 
distinct plugins. Plugins are small, specialized programs that work only within the 
larger applications for which they are designed. The Calendar and Address Book 
plugins let you work with the information stored in your Eudora Planner database. 
You can add other plugins to Eudora Planner as they become available. These 
might include applications that allow you to transfer Event and Contact data to and 
from a personal digital assistant, access your Eudora Planner database from a 
digital phone, or publish Events and Contacts on the World Wide Web or company 
intranet. Each plugin appears in the shortcuts bar, where you can access it with a 
single click.
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Shortcuts
Eudora Planner’s shortcuts let you access frequently-used applications, documents, 
and Web sites from inside the Eudora Planner window. These shortcuts let you keep 
your Calendar and Address Book close at hand, while you’re only one click from 
other important applications and files on your computer. 

QuickAccess
QuickAccess is a tool that provides easy access to your Calendar and Address 
Book information from the Windows taskbar. With QuickAccess, you can view your 
schedule with QuickDay, find names and phone numbers on the fly with 
QuickContact, and enter new Events and Contacts using QuickPad. QuickAccess 
also lets you launch Eudora Planner right from the taskbar.

Group Scheduling
In addition to being a personal planner, Eudora Group Planner lets you share 
scheduling and Contact information with other Eudora Group Planner users on a 
network, as well as coordinate meetings and the use of rooms and equipment with 
those users. For more details on how to use Eudora Group Planner, see Chapter 7, 
“Using Eudora Group Planner,” on page 119. 

Web Publisher
Eudora Planner’s Web Publisher plugin lets you publish Calendar and Address Book 
data for viewing on the World Wide Web or a company intranet. Other Eudora 
Planner users, whether part of your workgroup or not, can then drag those Events 
and Contacts from their web browser into their own Eudora Planner Calendar or 
Address Book. For information on using the Web Publisher, see Chapter 8, “Using 
Web Publisher,” on page 143.
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Installing Eudora Planner
The following sections describe the resources and tasks required to install, register, 
and uninstall Eudora Planner.

System Requirements
To install and use Eudora Planner, you need

• A personal computer with a 486 or higher processor (Pentium 90 
recommended).

• The Microsoft Windows 95® operating system or Windows NT® workstation 
operating system version 4.0 or later. For Windows NT 4.0 installations, Service 
Pack 3 for Microsoft Windows NT is also required.

• 16 MB of RAM for use on Windows 95 or Windows NT Workstation 4.0. 

• 18 MB of hard disk space.

• A CD-ROM drive.

• A VGA or higher-resolution video adapter (SVGA 256-color with 800x600 or 
higher resolution recommended).

• A Microsoft Mouse or compatible pointing device.

To take advantage of all of Eudora Planner’s features, you may also want to have

• A modem, for auto-dial, that is compliant with the Windows Telephony 
Application Programming Interface (TAPI)

• A Windows-compatible network using TCP/IP protocol for workgroup 
functionality

• A dial-up or full-time Internet connection

• An e-mail package compliant with Microsoft’s Messaging Application 
Programming Interface (MAPI) standard, such as QUALCOMM’s Eudora Pro

Running Setup
Eudora Planner’s installation program installs all components of Eudora Planner, 
including the Eudora Planner program, online documentation, and other related 
programs.

To install Eudora Planner:
1. Insert the CD-ROM. The Eudora Planner installation program appears.

2. Click the Install Eudora Planner 4.0 button. The installation begins. 

3. Follow the instructions provided by the installer to complete the installation.
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Registering Eudora Planner
Registering Eudora Planner involves entering two codes into the software:

• A serial number that uniquely identifies your copy of Eudora Planner

• An activation code that indicates you have registered your copy of Eudora 
Planner

Your serial number is provided on a serial number card included in your Eudora 
Planner package. To enter the serial number, choose Register from Eudora 
Planner’s File menu, then enter the serial number in the appropriate field on the 
resulting dialog box. Users of the trial version must purchase the Eudora Planner 
package to obtain a serial number.

A serial number is required for obtaining technical support for Eudora Planner.

The activation code is required to disable the registration reminder dialog box that 
Eudora Planner periodically displays. To obtain an activation code, choose Register 
from Eudora Planner’s File menu, then enter your personal or company information 
in the appropriate fields on the resulting dialog box. When you’ve finished entering 
your information, click the appropriate button to either fax the information to 
QUALCOMM or upload it via TCP/IP to the Eudora Web site. If you fax your 
registration, the activation number will be faxed back to you; if you upload it to the 
Eudora Web site, the activation number will be sent to you in an e-mail message.

Uninstalling Eudora Planner
To remove Eudora Planner from your computer, Select Add/Remove Programs from 
the Windows Control Panel.

To uninstall Eudora Planner:
1. From the Start menu, select Settings, then Control Panel.

The Windows Control Panel appears.

2. Double-click Add/Remove Programs.

The Add/Remove Programs Properties dialog box appears.

3. From the scrolling programs list on the Install/Uninstall tab, select Eudora 
Planner. Then, click the Add/Remove button.

A dialog box prompts you to verify your selection.

4. Click Yes to continue uninstalling.

Eudora Planner is removed from your computer.
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Getting Technical Support
To accommodate the varying needs of our customers, QUALCOMM offers a number 
of technical support options. Registered users can take advantage of free support 
options as well as limited telephone support. The following sections describe these 
options. For more information, contact us or refer to our Web site, 
http://www.qualcomm.com/eudora/planner.

To guarantee your access to technical support, be sure to register Eudora Planner 
as described in “Registering Eudora Planner” on page 5.

Over time, our technical support options may change. If you are not on an active 
support plan, you may want to consult our Web site or Fax Document Retrieval 
System, as described in the following section, for any changes to the options 
available.

Free, Unlimited Support
QUALCOMM currently offers the following free technical support options:

• For no charge, you can call our Fax Document Retrieval System at 800-730-
7860 or 503-274-6370. This system can fax you answers to common questions 
as well as troubleshooting guides compiled by our support technicians.

• Our World Wide Web site (http://www.qualcomm.com/eudora/planner) includes 
a large number of free technical support documents from our Document 
Retrieval System, viewable online.

Limited Technical Support (U.S. Only)
To determine what additional technical support may be available, registered users 
can either call 619-651-5450 or send e-mail that includes your serial number to one 
of the following addresses:

• mac-planner-support@qualcomm.com for Macintosh users
• win-planner-support@qualcomm.com for users on Windows 95 and 

Windows NT 4.0

Similarly, users of the demo version who want to know about the technical support 
options available can send e-mail to

• mac-planner-demo@qualcomm.com for Macintosh users
• win-planner-demo@qualcomm.com for users on Windows 95 and 

Windows NT 4.0

International Technical Support
Outside the United States, technical support is available through your local reseller.
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Back Up Your Data!
Some technical support situations can be avoided, especially those involving 
damaged Calendar or Address Book data, by backing up your Eudora Planner data. 
The backup process is easy, can save you time and money, and provides a relatively 
simple way to recover from mistakes and problems.

The Eudora Planner Database Management Tool lets you back up, restore, and get 
information about your local Eudora Planner database. You should make it a habit to 
use this program periodically, to make backup copies of your database in case 
anything unfortunate should happen to it in the course of everyday usage.

For running this program, a Backup shortcut is available in the Eudora Planner 
submenu of the Windows Start menu. If for some reason this shortcut has been 
deleted, you can start the program by running the file backup.exe that is installed in 
the same directory as Eudora Planner.

To back up your local database, first exit from Eudora Planner. Then, run the 
backup.exe program and click the Backup button. A directory dialog box appears 
which you can use to choose a file name and location for the backup database file. 
For maximum protection, you should place this file in a directory other than the one 
where the Eudora Planner program and your active database reside. A Backup 
directory is created at installation time under the Eudora Planner directory for this 
purpose.

Restoring a backed up database is done similarly to the backup. Run the backup 
program, then click the Restore button. A directory dialog box appears which you 
can use to choose the backup database file.

If Eudora Planner is running when you initiate the backup or restore process, then 
after you specify a name and location for the backup file and click OK, a dialog box 
informs you that Eudora Planner must be closed while the backup/restore proceeds. 
At this point, you can click Yes to close Eudora Planner and continue or No to 
cancel the process until you are prepared to close Eudora Planner.
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Starting Eudora Planner
You can start using Eudora Planner immediately after you’ve installed it.

To start Eudora Planner:
1. From the Start menu, select Programs, then select QUALCOMM from the 

submenu that appears.

2. From the QUALCOMM submenu, select Eudora Planner.

3. The Eudora Planner window appears, showing the last plugin application that 
was displayed when you last closed Eudora Planner.

The first time you start Eudora Planner, it displays the Calendar.

Toolbar

Navigation 
buttons

Click these 
buttons to 
switch 
Calendar 
Views

Shortcuts 
bar

Click a 
date to go 
to that 
date
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The Eudora Planner Window
The Eudora Planner plugins, toolbar and shortcuts bar are all components of the 
Eudora Planner application window. You can alter the appearance and arrangement 
of this window to suit the way you work.

Using the Toolbar
Eudora Planner’s Toolbar is conveniently located at the top of the Eudora Planner 
window and can perform the same operations as some of the most frequently-used 
menu commands, putting tasks like printing, finding, copying, pasting, and creating 
new Events and Contacts within easy reach.

Using Shortcuts
Click the icons in the shortcuts bar to move among the Calendar, Address Book and 
other Eudora Planner plugins. You can also use this area to add shortcuts to other 
applications, as well as add links to important documents and Web sites you view 
frequently. Click and drag the shortcuts bar to move it to another location in the 
Eudora Planner window. For information about shortcuts, see“Adding Shortcuts” on 
page 97. 

The toolbar 
gives you 
one-click 
access to 
common 
tasks

Shortcuts 
give you 
one-click 
switching to 
other 
plugins and 
applications
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Navigating in Eudora Planner
Eudora Planner provides four different ways to view your Calendar and two ways to 
view your Address Book.

Calendar Views
Eudora Planner can display your Event information in four different Calendar Views. 
Each View—Day, Multi-Day, Week, and Month—shows a different range of dates 
and level of detail. The following sections describe the Calendar Views and their 
important features.

Day View
The Day View displays a timeline of Events scheduled for a specific day. Events 
appear on a grid divided into specific time increments—five minutes to a half-hour, 
depending on your preferences. You can change the time increments by right-
clicking anywhere on the Calendar and selecting Time Increment from the pop-up 
menu that appears, then choosing a time increment from the Time Increment 
submenu. 

Click the left and right arrows to move backward and forward through the Calendar 
one day at a time. The light-shaded area indicates the range of time in which you’re 
available for meetings (such as your workday); the dark-shaded area indicates when 
you’re unavailable.

Indicates 
current time

Create an 
Event by 
clicking a time 
slot, then 
dragging

Click to return 
to today’s date

Double-click 
an Event to 
view its 
details
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Multi-Day View 
The Multi-Day View shows a daily timeline of Events scheduled for a one-week 
period. The cells in the Multi-Day grid can represent time increments from five 
minutes to one-half hour, depending on your preferences. You can change the time 
increments by right-clicking anywhere on the Calendar and selecting Time 
Increment from the pop-up menu that appears, then choosing from the Time 
Increment submenu. 

Meeting Events and Calls with a specific time appear right on the grid, whereas 
holidays and special all-day Events like birthdays and anniversaries appear above 
the grid; dated To-Dos and Calls appear in the boxes below the grid, underneath the 
date for which they are scheduled. Click the left and right arrows to move backward 
and forward one week at a time through the Calendar. To have the arrows move you 
through the Multi-Day View one day at a time, right-click anywhere on the view, then 
select Scrolling View from the shortcut menu that appears.
Use the 
navigation 
buttons to 
scroll through 
the Calendar

Banners, 
Special Events, 
and Holidays 
appear above 
grid

Indicates 
current time

Dated To-Dos 
and Calls 
appear 
beneath grid

Meetings and 
dated Calls 
appear in grid

Create an Event by 
clicking at the start 
time, then dragging 
to the end time
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Week View
The Week View lists the Events scheduled for each day of a particular week. A day 
cell in the Week View shows holidays, special all-day Events, meetings, and calls for 
which you’ve set a specific time. Meetings and calls appear with their times next to 
them. Click the left and right arrows to move backward and forward one week at a 
time through the Calendar.

To create 
a new 
Event, 
click in a 
day cell, 
then type

Banners 
appear at 
the bottom 
of a day 
cell

Selected date is 
outlined

Click the arrow to 
scroll through a 
day’s Events
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Month View 
The Month View shows Events scheduled for an entire month. To create an Event, 
click anywhere in a day’s block to select that day, then start typing. You can scroll 
down through a day’s Events to see that day’s schedule. Click the left and right 
arrows to move backward and forward one month at a time through the Calendar. 

Click arrow to 
scroll through a 
day’s Events

To create an 
Event, click in 
a day cell, 
then type

Double-click in the 
day cell to switch 
to the Day View
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To-Do List
The To-Do List appears to the right of the Calendar in all Calendar views and 
displays the status, priority, title, category, and completion date of your To-Dos and 
Calls, as well as the start and due dates, if applicable. Click a column header to sort 
the list by the information contained in that column. You can choose which To-Dos 
and Calls display in the To-Do List by right-clicking above the list or in any empty cell 
in the list, then selecting To-Do and Call Filter from the pop-up menu that appears. 
Use the To-Do List to view and organize your Calls and To-Dos and to check them 
off as you complete them.

Click a column header 
to sort by the data 
contained in that 
column

Click to check off 
completed To-Dos 
and Calls Click in the empty cell 

to create a new To-
Do

Right-click in this 
area to choose 
which To-Dos and 
Calls appear in the 
list

Double-click an 
Event to view its 
details
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Event Detail
Double-click an Event to open its Event Details dialog box, where you can set and 
change the Event’s properties.

Type a title here

Type comments here

Click to make a 
repeating Event

Select to have the 
Event remind you 
before its start time

Indicates that this 
Event is shared on a 
server

Click here to assign 
categories
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Address Book Views
Eudora Planner lets you see and manipulate your Contact information in two 
different Address Book views—the List View and Detail View. Both views are 
discussed in the following sections.

List View
This view shows multiple Contacts in an organized list that you can sort and 
compare according to your preferences. You can choose which fields display in the 
List View columns by changing settings for the tab (for details, see “Creating 
Address Book Tabs” on page 91). To reorder a column in the List View, click its 
heading and drag right or left to the desired location. You can type directly into the 
List View after clicking the cell where you want to enter information.

Click to create 
a new Contact

Click column 
header to sort 
by its 
contents

Indicates 
number of 
Contacts in 
tab and which 
Contact is 
selected

Double-click a 
Contact to 
view its 
details

Right-click a 
Contact to 
attach an 
Event to it
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Detail View
The Detail View shows a single Contact with all associated information and 
attachments. 

The arrow buttons under the Contact heading let you scroll through your Contacts 
one-by-one in the order in which they’re currently sorted in the List View. The box 
next to the arrow buttons indicates the number of Contacts appearing in the list and 
the numerical position of the opened Contact in that list.

Contact 
heading 
contains 
primary name 
and phone 
number

Click to 
send e-mail

Click to open 
section

Click to close 
section

Click to 
assign 
categories

Click to attach a Meeting
Click to attach a Call

Click to attach a To-Do Click to attach a document

Click to attach a note

Select to 
add this 
Contact to 
your list of 
Quick 
Contacts

Click to 
change 
Contact 
Detail 
preferences

Enter Contact 
information 
here

Click to 
open a Call 
for this 
Contact

Select to 
share this 
Contact 
with other 
users

Click to attach a shortcut

Click to attach a Contact

Click to access QuickNet 
Web-connectivity 
features
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The General Information, Custom Fields, Notes, and History sections expand and 
collapse, so you can conceal from view those sections you’re not using.

Type directly 
into custom 
field to enter 
data

Type here to 
create a note Click to a add 

note to the 
History listChoose which 

items display 
in the History 
list

Drag most 
frequently-
used custom 
fields from the 
lower area to 
the upper area

Yes/No custom 
field
18 Chapter 1



Chapter
 1

Setting Eudora Planner’s General Preferences
Eudora Planner stores your login and display settings in its General Preferences. To 
set or change these preferences, from the Tools menu, select General 
Preferences. The General Preferences dialog box appears.

The Login options determine whether Eudora Planner prompts you to log in each 
time you start the program or bypasses the login dialog box and automatically logs 
in to your Eudora Planner database using your Windows user name. You should set 
Eudora Planner to prompt you to log in if you want to protect your database with a 
password.

The Toolbar settings let you change the appearance of items on the Eudora Planner 
toolbar. You can determine the size of the toolbar icons, the appearance of labels on 
the icons, and whether or not the icons appear raised when you drag the pointer 
across them. You can also choose to display or hide the toolbar clock.

Use the Background Images options to display or hide the images appearing on 
the toolbar and shortcuts bar.

The Tabs option lets you hide the Calendar and Address Book tab headings, so they 
don’t appear in any view. If you do choose to hide your tabs with this option, you can 
still select each tab from the Tabs menu.
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Using the Calendar
The individual items you’ve scheduled in your calendar are called Events in Eudora 
Planner. The seven distinct types of Events available give you the flexibility to record 
any kind of commitment—whether it requires minutes or days of your time, whether 
it’s crucial, optional, or can wait until later.

In this chapter, you’ll learn how to create Events and add related information to 
them. Then, you’ll learn how to use your Calendar and To-Do List to manage your 
schedule.

Types of Events
Events are the building blocks of your Calendar. The seven types of Events available 
in Eudora Planner let you track all the activities and information that fill your week: 
meetings and appointments, telephone calls, checklist items, special days or blocks 
of days, notes and reminders.

By appropriately using the available Event types, you can maintain a schedule that 
is effective for you and understandable to others. The following table describes the 
different Events you can add to your Calendar.

Event Type Use for...

Meeting A meeting or appointment, with specific start and end times on the 
same day, that can involve Contacts from your Address Book or, in a 
workgroup setting, other Eudora Group Planner users. In the 
Calendar, Events that you are attending appear with a check mark.

To-Do A task you need to remember to do, and to which you can possibly 
assign a priority. 

Call A phone call you need to make. Calls are like To-Do Events in that 
you can assign a priority to them and track them on the To-Do List.
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Each of these Events can be viewed and modified in its own specific Details dialog 
box. Double-clicking a Holiday Event, for example, produces a Holiday Details dialog 
box in which you can view, modify or add information about the Event. These dialog 
boxes are generally referred to in this book as the Event Details dialog box.

Adding Events to the Calendar
Eudora Planner gives you many ways to add Events to your Calendar. For example, 
you can:

• Select an Event type from the Insert menu, then fill in the date, time, and any 
other information in the resulting Event Details dialog box or Meeting Wizard, 
which guides you through the process of creating a Meeting Event. 

• Click an icon in Eudora Planner’s toolbar to create a new To-Do, Call, or Meeting 
in either the Calendar or Address Book.

• Click an empty area of any day in any Calendar View. Eudora Planner creates a 
new, untitled Meeting Event with a blinking cursor in it to prompt you to type a 
title. After typing the title, you can double-click this new Event to modify it further.

There are several other ways to create Events. In the Day or Multi-Day View, you 
can drag the pointer from the Event’s starting time to its ending time. A new Meeting 
Event appears on the Calendar and the Meeting Details dialog box appears, so that 
you can add necessary information. 

For an activity that recurs irregularly throughout your schedule, you can create an 
Event based on a template you’ve configured to contain certain, minimum 
information, such as a title, start time, or a list of invitees. For information on Event 
templates, see “Using Event Templates” on page 48.

To create an Event in the To-Do List, click in the first empty cell below your list of To-
Dos and Calls. A cursor appears in the cell, allowing you to type in the title of a new 
To-Do, which you can double-click to open and modify further.

You can also create an Event from a Contact by selecting an Event type from the 
button bar. The Event you create is both saved to the Calendar and attached to the 
opened Contact. For details, see “Attaching New Events to Contacts” on page 61.

Special An Event that spans an entire day, rather than a range of time on 
that day. You can use Special Events for birthdays, anniversaries, 
journal entries or other Events on specific days.

Holiday A holiday such as New Year’s Day.

Sticky 
Note

A way to place attention-getting messages or reminders on the 
calendar with an electronic note.

Banner An Event that takes place over one or more days, like a vacation or 
convention.

Event Type Use for...
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Use any QuickAccess component to create an Event without having to open Eudora 
Planner. The Events are immediately saved to the Calendar. For more information 
on creating Events with QuickAccess, see “Creating Events in QuickDay” on page 
111, “Creating Events with QuickContact” on page 115, and “Using QuickPad” on 
page 115.

The information needed to create an Event varies according to the Event’s type. The 
following sections describe in detail how to create each type of Event. These 
sections discuss the different types of Events in three groups:

• Meetings
• Calls and To-Dos
• Other Events

Additionally, you can organize your Events by assigning them to Event categories. 
To learn more about organizing Events with categories, see “Assigning Categories 
to Contacts and Events” on page 85.

Using Meeting Events
Meeting Events are the default Event type in Eudora Planner—the type created 
whenever you click or drag in the Calendar to add a new Event.

Eudora Planner provides a Meeting Wizard to step you through the process of 
creating a Meeting Event. By default, this wizard appears when you choose the 
Meeting command from the Insert menu. If you don’t want to use the Wizard, you 
can create new meetings by dragging in the Day or Multi-Day View, which opens a 
Meeting Details dialog box in which you type meeting information. You can also 
disable the Meeting Wizard, so that the Meeting Details dialog box appears when 
you choose the Meeting command from the Insert menu. See “Setting Calendar 
Preferences” on page 52 for more information.

Using the Meeting Wizard
Eudora Planner provides a Meeting Wizard that walks you through each step of 
creating a Meeting for group scheduling. To open the Meeting Wizard, select 
Meeting from the Insert menu. Follow the Wizard as it guides you through the steps 
of creating a Meeting.

For the Meeting Wizard to appear when you select Meeting from the Insert menu, 
the Use Meeting Wizard check box in the Calendar Preferences dialog box must be 
selected.
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You cannot use the Meeting Wizard to modify an existing Meeting Event. To modify 
an existing Meeting, double-click it and use the Meeting Details dialog box.

Using the Meeting Details Dialog Box
You can view, add, and modify information about Meeting Events in the Meeting 
Details dialog box, which organizes information on its Meeting, Group Scheduling, 
and Attachments tabs. 

The following sections describe how to create and modify a Meeting by adding 
information to the Meeting, Group Scheduling, and Attachments tabs explained in 
the preceding chart.

Tab Meeting Details

Meeting Shows title of the meeting, time, duration, reminder settings, and 
comments. For setting up meetings outside your workgroup or 
appointments for yourself, this is the only information you’ll need 
to supply.

Group Scheduling Shows schedule information for people and resources needed at 
the meeting. Use this tab to schedule a meeting that fits in best 
with others’ schedules.

Attachments Shows attached files, e-mail addresses, URLs, graphics, etc. Use 
this tab to make Event-related information available to invitees.
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Scheduling a Meeting
In any Calendar view you can create new meetings with the Meeting Details dialog 
box.

To schedule a meeting using the Meeting Details dialog box:
1. Open the Meeting Details dialog box. You can do this in a variety of ways, 

depending on the Calendar View you’re using:

• To schedule a new meeting in the Day or Multi-Day View, drag the pointer to 
indicate a range of time for the meeting. 

• To schedule a meeting in the Week or Month View, click on the appropriate 
date to make the cursor appear in that day’s block, type a title, then double-
click on the meeting to open its Details dialog box.

• To schedule a meeting using QuickDay or QuickContact, click the New 
Meeting button. To schedule a meeting with QuickPad, select New Meeting 
from the pop-up menu.

• To reschedule an existing meeting, double-click the Meeting Event in any 
view.

The Meeting Details dialog box appears. The Event Type box indicates a 
Meeting Event.

You can create a Meeting by right-clicking the Calendar, then selecting 
New from the pop-up menu. From the submenu that appears, select 
Meeting.

2. Type or change the title for the Meeting in the Title box.

Select to block 
time in your 
schedule

Header contains 
title of Meeting 
and name of last 
person to modify it

Select a start time 
from the drop-
down list or type 
a time directly into 
the box

Type notes here

Select a start date 
from the drop-
down list or type a 
date directly into 
the box

Enter title here

Click to assign 
categories
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3. If necessary, change the date and the start time for the Meeting in the Start 
Date and Start Time boxes.

• To select a date, click the arrow in the Start Date box. A month-view calendar 
appears, from which you can select a date. If you need to select a different 
month, click the arrow buttons or type a date into the box. You can also type a 
date into the box using the mm/dd/yy format. 

• To select a time in half-hour increments, click the arrow in the Start Time box, 
then click a time in the list that appears. To choose any other time, select the 
time value in the box and type the time you want. You can also type a time into 
the box.

4. If necessary, change the duration of the meeting with the Duration boxes.

5. If necessary, assign additional categories to the meeting by clicking 
Categories.

The Assign Categories dialog box appears. 

In order for invitees to see your meeting on their Calendars, you must 
assign it to a public category that both you and the invitees subscribe to. 
If you’re creating the meeting on a tab for which the default category is 
private, you can assign a public category to the meeting by selecting the 
Shared option before clicking the Categories button. Invitees can also 
see meetings to which they’ve been invited by creating a Calendar tab 
that shows Events that occupy their time. For details, see “Creating 
Calendar Tabs” on page 89.

6. If you want to be reminded of this Meeting, set a reminder (see “Using 
Reminders” on page 38 for more information on reminders). If this is a recurring 
Meeting, you may want to set it up as a repeating Event (see “Setting Up 
Repeating Events” on page 37 for more information). If you are using Eudora 
Group Planner, select the Show Time as Busy option to have the meeting 
block time in your schedule (see “Using To-Dos and Calls” for more 
information).

If you’ve turned on the Remind me for all time commitments option in 
the Calendar Preferences dialog box, then you will automatically receive 
a reminder for this Event if you’ve selected Show Time as Busy. For 
information on Calendar Preferences, see “Setting Calendar 
Preferences” on page 52.

7. Click OK.

The Meeting appears in your Calendar as you specified.

If you are using Eudora Planner for group scheduling and want to invite users to this 
meeting, see “Using Group Scheduling” on page 129 for more information.
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Using To-Dos and Calls
To-Dos and Calls are similar Event types that indicate specific tasks you need to 
complete. You might create a To-Do to show that you need to prepare a budget 
report or pick up a package, or schedule a Call for when you need to telephone a 
business client or a friend. You can mark both To-Dos and Calls as complete or 
incomplete to indicate their status, and you can also prioritize them, so you can tell 
at a glance which are most important.

To-Dos and Calls can be either undated or dated, depending on the nature and 
urgency of the activity you’re scheduling. An undated To-Do Event does not have 
specific start and due dates. You could create an undated To-Do for a household 
project that doesn’t need to be started or completed by a particular date. Similarly, 
an undated Call Event has neither a specified time or date. You might create an 
undated Call to show that you need to telephone an old friend with whom you 
periodically keep in touch.

Dated To-Dos and Calls have specific start dates, and, in the case of Calls, may 
even have specific times. To-Dos related to projects at work would likely be dated, as 
would Calls scheduled for potential customers or clients.

Undated To-Dos and Calls automatically forward from day to day, until you mark 
them as Complete. Dated To-Dos and Calls also forward from day to day, but only 
during the range of days between their start and due dates. These dated Events do 
not forward beyond their due date, but can be viewed as overdue Events in the To-
Do List. For information on how to view overdue Events in the To-Do List, see 
“Viewing To-Dos and Calls” on page 31.
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Scheduling To-Dos
Schedule a To-Do Event to indicate a task you must complete, whether it’s an 
important project for your department or a routine chore like taking your bottles and 
cans to the recycler.

To schedule a To-Do:
1. From the Insert menu, select To-Do.

The To-Do Details dialog box appears. The Event Type box indicates a To-Do.

You can create a To-Do by right-clicking anywhere on the To-Do List, then 
selecting New To-Do from the shortcut menu.

2. In the Title box, type a name for the To-Do. 

3. If you want this to be a dated To-Do, select a due date and start date.

To do this, select the Due option, then click the arrow in the Due or Start box. A 
month-view calendar appears, from which you can select a date. If you need to 
select a different month, click the arrow buttons.

4. To set the To-Do’s priority, click the arrow in the Priority box, then select from 
the drop-down list. 

5. Click the Categories button to select the categories you want to associate with 
the To-Do.

6. Click OK.

The To-Do appears in the To-Do List.

Select to assign a 
due date to To-Do

Change status of To-Do 
here

Enter title here

Enter notes here

Select priority 
from drop-down 
list

Click to assign 
categories

Click to have the To-Do 
remind you by launching an 
application

Select to be 
reminded of this 
To-Do

Click to have the To-Do 
remind you with a sound
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Scheduling Calls
Use Call Events to schedule telephone calls, such as those to a client or potential 
sales prospect. You can link Call Events to Contacts in your Address Book, so that 
each time you telephone someone in your Address Book, Eudora Planner records a 
Call in that Contact’s history, giving you a running log of your communications with 
that person or organization.

To create a Call:
1. From the Insert menu, select Call.

The Call Details dialog box appears. The Event Type box indicates a Call.

You can create a Call by right-clicking anywhere on the To-Do List, then 
selecting New Call from the shortcut menu that appears.

2. If you want to attach a Contact to the Call, type a name in the Name box. If not, 
go to step 3.

Once you begin to type, Eudora Planner will search the Address Book and 
automatically fill the Name box with the Contact’s name. The Contact’s primary 
phone number will appear in the Phone box.

3. In the Title box, type a name for the Call.

If you’ve attached a Contact to this Call, then Eudora Planner automatically 
gives it a title that includes the Contact’s name and primary phone number.

4. Click the Schedule tab.

Click to search 
Address Book for 
Contact to attach to 
Call

Click to view 
details about 
Contact attached to 
Call

Title is 
automatically 
assigned with 
Contact’s name 
and phone number

Click to dial 
Contact’s phone 
number

Type notes about 
Call here

Select priority 
from this drop-
down list

Change status of 
Call here

Click to add 
categories
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5. If you want to change the date, time, or duration, or add a reminder for this Call, 
select Date. The Date, Time, Duration and Reminder boxes become available.

• To change the date of the Call, click the arrow in the Date box. A month-view 
calendar appears, from which you can select a date. If you need to select a 
different month, click the arrow buttons.

• To select a time for the call in half-hour increments, click the arrow in the Time 
box, then click a time in the drop-down list. To choose any other time, select 
the time value in the box and type the time you want.

• Change the length of the Call with the Duration boxes.

6. If you want to be reminded to make this Call, set a reminder. See “Using 
Reminders” on page 38 for more information on reminders. If you are using 
Eudora Group Planner and you want this Call to block your scheduled time, 
then select Show time as busy. 

7. Click OK.

The Call is appears in the To-Do List. If you’ve linked the Call to a Contact in 
your Address Book, then the Call will appear in that Contact’s History. 

Attached 
Call appears 
here
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Tracking To-Dos and Calls
Use the To-Do List to view, prioritize, and mark as complete your To-Dos and Calls. 

Viewing To-Dos and Calls
You can determine which Events are displayed in the To-Do List by right-clicking 
above the list, then selecting To-Do and Call Filter from the popup menu that 
appears. A submenu appears, containing the following options:

• Select Undated if you want to show your undated To-Dos and Calls.

• Choose from among the Today’s , Next 7 Days’ , All Dated , and Overdue 
options to determine which of your dated To-Dos and Calls display in the To-Do 
List. Select Today’s  if you want to show just those To-Dos and Calls assigned to 
today; likewise, select Next 7 Days’ if you want to display only items assigned to 
dates in the following week. If you select the All Dated  option, then all your 
dated To-Dos and Calls will appear in the To-Do List, regardless of assigned 
date. To see all dated To-Dos and Calls that you haven’t completed by their due 
date, select Overdue.

• Select Completed if you want to show all the To-Dos and Calls that you’ve 
already completed, no matter how long ago their completion dates.

The To-Do List appears in each Calendar view and gives you a convenient way to 
log and track your To-Dos and Calls.

Dated To-Dos and Calls also appear in the Multi-Day View’s To-Do area, underneath 
the date for which they are scheduled.

To-Dos 
and Calls 
appear 
here
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Tracking Priority and Completion of To-Dos and Calls
You can prioritize and sort your To-Dos and Calls by assigning them priority labels. 
Priority labels determine the order in which To-Dos and Calls appear in the To-Do 
List, quickly showing you which items are the most urgent. 

When you create To-Dos or Calls, they are by default labelled as incomplete. You 
can mark your To-Dos and Calls as complete once you’ve finished them. 

When you prioritize your To-Dos and Calls, you can use the labels supplied with 
Eudora Planner or create your own.

To create a Priority Label:
1. From the Tools menu, select Calendar Preferences.

2. In the Calendar Preferences dialog box, click Priority Labels.

The Define Priority Labels dialog box appears. You can create up to ten labels. 
The order in which you enter the labels here determine the order in which they 
sort in the To-Do List. 

3. Type label names in the fields, then click the Default option to assign a default 
priority label.

When you create a new Event, it uses the default label.

4. Click OK.

The labels you’ve created are now available for assigning priority to your 
Events.

Position in the list determines priority, regardless of label name
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You can prioritize Calls and To-Dos using Eudora Planner’s predefined priority 
labels, or you can assign labels you’ve created.

To assign priority to a To-Do or Call:
1. Double-click the Event to which you want to assign a priority label.

The Event Details dialog box appears.

You can open a To-Do or Call by right-clicking it, then selecting Details 
from the shortcut menu that appears.

2. On the To-Do or Call tab, click the Priority arrow to select a priority label.

3. Click OK.

The Priority level appears in the Priority column of the To-Do List. If you sort the 
To-Do List by priority, the Priority you assign here determines the Event’s 
position on the To-Do List.

To-Dos and Calls forward daily until you complete them. Once you’ve completed a 
To-Do or Call, you can indicate that it’s complete.

To mark a To-Do or Call as complete:
1. Double-click the Event that you want to mark as complete.

The Event Details dialog box appears.

2. To mark a To-Do as complete, on the To-Do tab, click the Status arrow, then 
select Complete; to mark a Call as complete, click the Status arrow on the Call 
tab to select Complete.

In the To-Do List, you can mark a To-Do or Call as complete by clicking 
once in the To-Do check box or on the Call phone icon appearing in the 
left-hand column of the list.

3. Click OK.

A check mark appears next to the Event in the To-Do List, indicating that Eudora 
Planner records it as complete. The Event will not appear on the To-Do List on 
subsequent days.

Using Other Types of Events
This section explains how to add Holidays, Special Events, Banners, and Sticky 
Notes to your Calendar.

Scheduling Holidays and Special Events
Schedule Holidays to indicate national, local, religious, or company holidays. Use 
Special Events for important occasions that span a whole day and don’t have a 
specific time, such as birthdays, anniversaries, conferences, or vacation days.
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To schedule a Holiday or Special Event:
1. From the Insert menu, select Other Event Types, then select Holiday or 

Special Event from the submenu that appears.

The Holiday or Special Details dialog box appears. The Event Type box 
indicates a Holiday or Special Event.

To add a new Holiday or Special Event to your Calendar, right-click in any 
View, then select New from the shortcut menu; from the submenu that 
appears, choose Holiday or Special Event.

2. In the Title box, type a name for the Event.

3. If necessary, change the date in the Start Date box.

To change the date, click the arrow in the Date box. A month-view calendar 
appears, from which you can select a date. If you need to select a different 
month, click the arrow buttons. You can also type a date into the box using the 
mm/dd/yy format.

4. If necessary, change the duration in the Days box.

5. If you want to be reminded of this Event, set a reminder. See “Using 
Reminders” on page 38 for more information on reminders.

6. Click OK.

The Event is saved and appears in your Calendar.

Enter title here

Select a start 
date from the 
drop-down list or 
type a date 
directly into the 
box

Select to have 
Event make you 
unavailable for a 
whole day

Click to assign 
categories
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Adding Banners
For Events that span multiple days, such as conventions or vacations, add a Banner 
to your Calendar. Banners appear in each Calendar view, including the Day View.

To add a Banner:
1. From the Insert menu, select Banner.

The Banner Details dialog box appears. The Event Type box indicates a 
Banner.

You can add a Banner by right-clicking in any Calendar View, then 
selecting New from the shortcut menu; from the submenu that appears, 
select Banner.

2. In the Title box, type a name for the Banner.

3. If necessary, change the start date of the Banner in the Start Date box.

You can type a date or click the arrow in the Date box. When you click the arrow, 
a month-view calendar appears, from which you can select a date. If you need 
to select a different month, click the arrow buttons.

4. If necessary, change the duration of the Banner in the Days box.

5. If you want to be reminded of this Event, set a reminder. See “Using Reminders” 
on page 38 for more information on reminders.

6. Click OK.

The Banner is added to your Calendar.

Enter title here

Select a start 
date from the 
drop-down list or 
type a date 
directly into the 
box

Click arrows to change 
length of Event

Select to make yourself 
unavailable for the 
duration of the Event

Click to assign 
categories
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Using Sticky Notes
Just as you might tape notes on your computer monitor to remind you of important 
tasks or events, you can use Sticky Notes to post attention-getting messages on 
your Calendar. A Sticky Note can be resized to better fit your Calendar view, and 
can be dragged from day to day until you no longer need to see the message it 
contains.

To add a Sticky Note:
1. From the Insert menu, select Other Event Types, then select Sticky Note 

from the submenu that appears.

The Sticky Note Details dialog box appears. The Event Type box indicates a 
Sticky Note.

Create a new Sticky Note by right-clicking in any Calendar View, then 
selecting New from the shortcut menu; from the shortcut menu that 
appears, select Sticky Note.

2. In the Title box, type a name for the Sticky Note.

3. Type your comments into the field below the Title box. 

4. Click OK.

The Sticky Note is saved and appears in your Calendar with the title you’ve 
given it.

5. In the Week or Month View, move or resize the Sticky Note as desired.

To move the Sticky Note, drag its top edge. To resize it, place the pointer over 
the bottom right corner (it turns into a double-headed arrow), then click and 
drag to the desired size.

Enter title here

Type comments 
here

Click to assign 
categories
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Setting Up Repeating Events
Your schedule might include Events that repeat on a regular basis, such as weekly 
staff meetings or regular appointments with an important client. With Eudora 
Planner, you can create an Event once and have it repeat on a regular basis for as 
long as is necessary. This is a good way to set up your regular, recurring meetings.

To set up a Repeating Event:
1. Double-click the Event to open the Event Details dialog box.

2. Click the Repeating Event Options button.

The Repeating Event dialog box appears.

3. Select an option in the Common Repeating Sequences box or Custom 
Repeating Sequences box.

4. Choose an option in the Repeat Sequence Ending box. Select End after to 
specify the exact number of times you want the Event to repeat, or select End 
by to pick a specific day on which the repeat sequence terminates.

5. Click OK.

The Event now repeats throughout the Calendar at the interval you set.
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Using Reminders
Eudora Planner can remind you of an upcoming Event—minutes, hours, or days 
before it occurs—by displaying a dialog box, playing a sound file, or launching 
another application. Eudora Planner’s reminders appear even when Eudora Planner 
isn’t running. The following sections describe how to set up and respond to 
reminders.

Setting Up Reminders
You can specify when and how a Eudora Planner reminder should alert you to an 
impending Event.

To set up a Reminder:
1. Double-click the Event to open the Event Details dialog box.

2. If the Event is a Call, select the Schedule tab. Otherwise, select the tab with the 
same name as the Event (that is, if the Event is a Meeting, select the Meeting 
tab). 

3. Select Reminder.

The Reminder options become available.

You must assign a date to a To-Do or Call Event before you can 
designate a reminder.

4. Click the Reminder arrow to select the amount of time prior to the Event you 
want to be reminded.

5. If you want a sound to accompany the Reminder, click Sound to open the 
Reminder Sound dialog box, then select the Play sound on reminder option. 
To select a sound that you have used for previous reminders, click in the drop-
down list; to find and select a new sound, click Browse. Once you’ve made your 
selection, click OK.

6. To have Eudora Planner remind you by launching another application, click 
Application to open the Reminder Application dialog box, then select the Run 
on Reminder option. For example, if the reminder is for a To-Do entitled 
“Prepare Budget,” you might have Eudora Planner launch your spreadsheet 
application. To select an application that you’ve used previously, click in the 
drop-down list; to find and select a new application, click Browse. Once you’ve 
made your selection, click OK to return to the Event Details dialog box.

7. Click OK to close the Event Details dialog box.

The Event is set to remind you at the time you’ve chosen, in the manner you’ve 
specified.
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Responding to Reminders
To respond to a Reminder dialog box, click the Dismiss button to acknowledge it 
and not be reminded again. Or, select a Snooze option in the Reminder dialog box 
to have the Reminder appear again after an interval of time you’ve specified.

If you set a Repeating Event to remind you, the Reminder occurs for each time the 
Repeating Event appears on your Calendar. When you dismiss the Reminder, you 
dismiss only the Reminder for the current day’s Event.

Attaching Items to Events
Your Calendar Events can contain notes and documents created in other 
applications. You can also embed Object Linking and Embedding (OLE) objects 
from OLE-compatible programs and attach e-mail addresses and web pages on the 
Internet.

Attaching Files to Events
You can attach files to Eudora Planner Events in two ways: by inserting the file or by 
creating a shortcut to it from within the Event. When you insert a file into an Event, 
the file is copied into your Eudora Planner database, where it is stored until either 
the inserted file or Event is deleted. When you add a shortcut to a file, only a 
reference to the file is stored in your Eudora Planner database, saving you from 
reducing space on your hard drive.

Click to dismiss reminder

Click to have the reminder snooze for length of time you 
determine
Click to open details dialog box for Event

Select length of snooze from drop-down list
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Both inserted files and shortcuts appear in the Event’s Attachments list. You can 
double-click on the name of the inserted file or shortcut to open that file in the 
application that created it.

Inserting files into your database will increase its size. If you need to keep your 
database small, then create shortcuts to the files instead of inserting them. 
However, if you move your database file to another computer and open it with 
Eudora Planner, the files inserted into the Event remain available, whereas 
shortcuts to files will no longer work, as the files themselves are no longer available.

To insert a file into an Event:
1. In the Event Details dialog box, click the Attachments tab.

2. Click Insert File.

An Open dialog box appears.

3. Locate and select the file you want to insert into your Event, then click Open.

The file name appears in the Attachments list and the file is copied into your 
database. When you double-click the file’s name, the application that created 
the file opens it.
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To link a file to an Event with a shortcut:
1. In the Event Details dialog box, click the Attachments tab.

2. Click Shortcut.

An Open dialog box appears.

3. Use the Open dialog box to locate and select the file you want to add to your 
Event, then click Open.

The file name and a shortcut icon appear in the Attachments list as a 
reference to the file. When you double-click the filename, the application that 
created the file opens it.

To remove an inserted file or shortcut from an Event:
1. In the Event Details dialog box, click the Attachments tab.

2. Click the file or shortcut in the Attachments list box.

The name is highlighted and the Remove button becomes available.

3. Click Remove.

The file or shortcut is removed from the Event.

When you remove an inserted file from an Event, the file is deleted only from the 
Eudora Planner database. Any other copies of the file residing on your system are 
not affected. Removing a shortcut deletes only the reference to the external file, and 
does not change the file in any way.

Attaching Web Sites and E-mail Addresses to Events
You can attach e-mail addresses and Web sites to Events. When you click on an 
attached e-mail address, your preferred e-mail program launches and creates a pre-
addressed message. When you click on an attached URL, your preferred Web 
browser launches, searches for the Web site, and, if successful, loads the Web page 
in the browser window.

To attach a Web site to an Event:
1. In the Event Details dialog box, click the Attachments tab.

2. Click Internet Shortcut.

The Web Address dialog box appears.

3. Type in the name for the Web site in the Name box.

Enter name for Web site here

Enter Web site’s URL here
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4. Type the URL of the Web site in the Address box.

5. Click OK.

The web site is added to the Attachments list. Clicking the icon next to this site 
launches your browser and loads the Web site.

To attach an e-mail address to an Event:
1. In the Event Details dialog box, click the Attachments tab.

2. Click E-mail Address.

The E-mail Address dialog box appears.

3. In the Name box, type the name of the person or company you want to 
associate with the e-mail address.

4. Type the e-mail address in the Address box. 

5. Click OK.

The name associated with the e-mail address appears in the Attachments list. 
Clicking the mail icon next to the address activates your e-mail program and 
creates a new message.

Attaching OLE Objects
Eudora Planner supports Object Linking and Embedding (OLE), which lets you 
attach objects from other OLE-compliant Windows applications—like spreadsheets, 
charts or documents—to Events in your calendar.

To insert an existing OLE object:
1. In the Event Details dialog box, click the Attachments tab.

2. Click Insert OLE Object.

The Insert Object dialog box appears.

3. Select the Create from File option.

4. Click the Browse button to locate the file you want to link, or type the pathname 
of the file if you know it.

5. Click OK.

The object appears in the Attachments list. The OLE-compliant program starts, 
then opens the object for editing.

Enter name here

Enter e-mail address here
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To insert a new OLE object:
1. In the Event Details dialog box, click the Attachments tab.

2. Click Insert OLE Object.

The Insert Object dialog box appears.

3. Select the Create New option.

4. In the Object Type list, select the type of OLE object you want to create.

5. Click OK.

The OLE-compliant application starts, allowing you to create an object of the 
type you selected. The object appears in the Attachments list.

To paste an OLE object:
1. In the Event Details dialog box, click the Attachments tab.

2. In your OLE-compliant program, copy the OLE object to the Clipboard.

3. In Eudora Planner, click Paste OLE Object.

The OLE object appears in the Attachments list.

To remove an OLE object:
1. In the Event Details dialog box, click the Attachments tab.

2. Click the name of the object in the Attachments list.

3. Click Remove.

Eudora Planner removes the OLE object from the list.

Attaching Contacts to Events
You can attach Contacts from your Address Book to Events that you create in your 
Calendar. For example, if you schedule a conference call with three different people 
that are Contacts in your Address Book, you can attach their Contacts to the Call 
Event. The names of the Contacts will appear in the Attachments area of the Call, 
and the Call will be recorded in the History section of each Contact’s Details View.

To add a Contact to an Event:
1. Double-click the Event to open the Event Details dialog box, then click the 

Attachments tab.

2. Click the Contacts button.
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The Attach Contacts dialog box appears.

3. In the Find Method box, choose whether you want to search among specific 
Contacts, QuickContacts, or all Contacts to find the ones you want to attach.

• Use the Find Contact option to search for specific Contacts using the Find 
What box.

• Choose Quick Contacts or All Contacts to populate the Matching Contacts list 
with every Contact, or every Quick Contact, in your Address Book. Skip to 
step 5 if you choose one of these methods.

4. In the Find What box, begin typing the name of the Contact you want to attach 
to this Event. 

As you type, Eudora Planner searches your Address Book for names matching 
the text you’re typing. Matching names appear in the Matching Contacts list.

5. In the Matching Contacts list, select the Contacts you want to attach to the 
Event, then click Attach.

The selected Contacts move to the Attached Contacts list.

6. Click OK.

The Contact is attached to the Event and appears in the Event’s Attachments 
area. Also, the Event is added to the History area in the Contact’s Details dialog 
box.
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Getting More Out of the Calendar
The following sections describe some advanced features of the Eudora Planner 
Calendar, including:

• Cutting, copying, pasting, and moving Events

• Using Eudora Planner’s search feature to find specific Events

• Changing the appearance of Events so that you can visually organize your 
Calendar

• Using Event templates to save time when creating new Events

Editing Events in Any Calendar View
You can modify the time and date of an Event, without opening its Event Details, by 
moving or pasting it to a new position on the Calendar.

Cutting, Copying and Pasting Events
From the Edit menu, you can Cut and Copy Events. Click the Event to select it, then 
select Cut or Copy. To paste an Event, click to set the insertion point on the 
Calendar, then select Paste. Other than the date of the Event, all information 
remains the same.

In any Calendar View, you can cut, copy, and paste an Event by right-clicking it, then 
selecting Cut, Copy, or Paste from the shortcut menu that appears. 

Moving Events
After you create an Event, you may want to move it to another time and date on the 
Calendar. You can do this by simply dragging the Event from one time and date to 
another. You don’t need to open the Event Details dialog box. Use the appropriate 
view—Day, Week, or Month—depending on how far you want to move the Event.

You can also drag Events into your Eudora Planner Calendar from Internet web sites 
created with the Eudora Planner Web Publisher.
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Finding Events
If you need to find an Event, you can search for it by name. 

To find an Event:
1. From the Event menu, select Find. 

The Find Events dialog box appears.

You can initiate a search by right-clicking anywhere on the Calendar and 
selecting Find from the shortcut menu that appears.

2. Type the name of the Event in the box. 

3. Click Previous to search the Calendar prior to the date you have presently 
opened or selected in the Calendar View. Click Next to search dates after and 
including the date showing in the Calendar View.

If the Event is found, Eudora Planner brings you to the date the Event and 
outlines it. If the Event is not found, a dialog box appears giving you the option 
to try another search.

Changing the Appearance of Events
Eudora Planner gives you control over the “look” of your Calendar. After you create 
an Event, you can change its text style and color. You can also attach pictures to 
Events. The changes you make here override the style assigned to the Event by the 
category.

Changing Event Text and Color
You can give your Events distinctive appearances in order to more easily 
differentiate them from each other.

To change an Event’s style:
1. Click to select the Event in any view.

2. From the Format menu, select Font.
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The Font dialog box appears.

You can also change the font by right-clicking the Event, then selecting 
Font from the shortcut menu that appears.

3. Click to select settings for Font, Font Style, and Size. Select Color and 
Effects options as well, if you like. Click OK.

Your font preferences are applied immediately.

4. From the Format menu, select Background Color.

The Color dialog box appears.

5. Select a background color for the Event, then click OK.

The Event appears according to your settings you’ve selected.

Adding Pictures to Events
You can give your Calendar more visual appeal by attaching picture to your Events.

To add a picture to an Event:
1. Double-click the Event to open the Event Details dialog box, then click the 

Attachments tab.

2. In Graphics box, click Attach.

An Open dialog box appears.

3. Select a picture file, then click OK.

The picture appears in the Graphic box.

4. Click OK.

In any view, the picture appears as an icon next to the title of the Event.
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Using Event Templates
You may find that you often create Events that contain mostly the same information 
and attachments as existing Events in your Calendar, such as Meetings that always 
include the same group of invitees or To-Dos to which you regularly assign the same 
categories. You can use Event templates to simplify the creation of Events like 
these. Once you’ve created a template, you can select it from the menu anytime to 
create a new Event containing that information.

Creating Event Templates
You create an Event template using the same basic steps as for creating a new 
Event. After you create the template, it appears in the Event from Template 
submenu of the Insert menu.

To create a new Event template:
1. From the Insert menu, select Event from Template, then select Define Event 

Templates from the sub-menu.

The Event Template dialog box appears.

Create a new Event template by right-clicking on any Calendar View, 
selecting New from the shortcut menu, then selecting Event from 
Template. From the submenu that appears, select Define Event 
Templates.

2. Click New.

The Create a New Template dialog box appears.

3. In the Create a New Template box, type a name for the template. Click OK.

The Event details dialog box appears with a heading that indicates that it is a 
template.

4. Type information and select options for the template as you would to create a 
new Event.

Click to create a new Event template

Select a template from the list, then click here to modify it

Click to duplicate an existing template

Click to rename a template

Click to delete a template
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See “Adding Events to the Calendar” on page 22 for more information. You can 
also add Contacts, attachments, e-mail addresses and links to web sites. To 
learn more about these options, see “Scheduling Users, Rooms, and 
Resources for Meetings” on page 130. Click OK.

The template is saved and becomes available from the Insert menu. 

Creating Events from Templates
After you create an Event template, you can use it to create new Events that contain 
similar information and attachments. You can add or modify the information and 
attachments in the new Event as needed.

To create Events from Templates:
1. From the Insert menu, select the Event from Template sub-menu, then the 

name of the template.

The Event Details dialog box appears. All information and attachments in the 
template appear in the new Event.

You can open an Event Template by right-clicking anywhere in any 
Calendar View, selecting New from the shortcuts menu, then selecting 
Event from Template. From the submenu that appears, select the 
template you want to use for this Event.

2. Select options, as appropriate, for the Event.

You can add or modify any information in the Event.

3. Click OK.

The new Event appears on your calendar.

Handling Meeting Invitations
If you are using Eudora Group Planner, other users can invite you to meetings. 
When they do, Eudora Group Planner notifies you immediately by placing an icon in 
the task bar.

Responding to Meeting Invitations
When another user invites you to a Meeting, Eudora Planner puts a Meeting Notices 
icon in your Taskbar. Click this icon to open the Meeting Notices dialog box, where 
you can view the title, date, and time of the Meeting, the name of the Meeting’s 
creator, and whether your attendance is required or optional. You can then choose 
to accept or decline the Meeting invitation. 

You can also respond to Meeting invitations from the View menu, which is explained 
below.
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To respond to Meeting invitations:
1. From the View menu, select Meeting Invitations. 

The Meeting Invitations dialog box appears, containing a list of invitations to 
Meetings.

2. For each invitation in the list, click to select it, then click the Attend or Decline 
button.

If you choose Attend, the meeting will block time in your schedule. If you choose 
Decline, the meeting will be deleted from your Calendar.

3. When you’ve responded to all invitations, click OK. 

Your responses will appear in the Details dialog box for each Meeting. The user 
who created the Event will be able to see whether you’ve accepted or declined 
the invitation.

Setting Your Availability for Meetings
Other Eudora Planner users in your workgroup can invite you to meetings. Eudora 
Planner lets you define the range of time you’re available for these meetings. Of 
course, Events that you’re already committed to also block your available time; other 
users can invite you to a meeting, but are able to see that you are already busy.

To set your availability for Meetings:
1. From the Tools menu, select Calendar Preferences. 

The Calendar Preferences dialog box appears.

2. Click Availability.
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The Meeting Availability dialog box appears with your name at the top.

3. Select the days of the week that you are available.

As you select each day, default times appear in the From and To boxes for that 
day and the first time is highlighted.

4. In the first From box, type your available time. Then, press the Tab key to move 
to the To box and type the time when you are no longer available. Specify your 
availability for the rest of the week in this way.

5. Select the Unavailable During Lunch box, if appropriate, and type in your 
regular lunch time if different from the default of 12-1 PM.

6. Click OK.

Your availability settings are immediately saved by the public server. Other 
users who schedule you for meetings can see the times you are available.

If you change your availability while you are not connected to the Public Server, your 
changes won’t be visible to other users until the next time you connect.
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Setting Calendar Preferences
Eudora Planner’s Calendar preferences let you change the appearance of your 
Calendar to accommodate your normal work schedule, set defaults for the creation 
of Events, and create custom priority labels to assign to To-Dos and Calls. To set 
your Calendar preferences, from the Tools menu, select Calendar Preferences. 
The Calendar Preferences dialog box appears.

To change the first day of your week, select a day from the Start Week on list. The 
weeks shown in the Calendar Month View begin with the day you select.

To change the start and end times of your work day, select hours on the Work day 
start and Work day end lists. Your availability for Meetings and the unshaded hours 
in the Day and Multi-Day Calendar Views will be limited to the hours you select.

You can select the duration for new Events from the New meeting duration list. All 
new Events you create will have a default duration of the time you set here.

Similarly, changing the New meeting start time affects the default time of new 
Meeting Events created using the Insert Meeting command. You can choose to 
have new Meetings start at the current time or at the start of the nearest half hour or 
full hour.

The Auto-Pick interval setting determines the increments of available time that the 
Auto-Pick feature will consider when scheduling meetings between selected invitees 
on the Group Scheduling tab of the Meeting Details dialog box. You can choose an 
increment of 15, 30, or 60 minutes.

The Auto-attend new meetings I create check box, when selected, causes Eudora 
Planner to automatically schedule you as an attending invitee of meetings that you 
create.

The Meeting Wizard is enabled and disabled by the Use Meeting Wizard check 
box. This option is enabled by default. Clearing this check box disables the Meeting 
Wizard so that when you create a new Meeting using the Insert Meeting command, 
the Meeting Details dialog box appears instead of the wizard.
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To free yourself from having to set reminders, you can have Eudora Planner remind 
you of all Events by selecting the Remind me for all time commitments option. 
When this check box is selected, every Event that makes you unavailable will remind 
you five minutes prior to its start time.

To have the Event Details dialog box appear automatically when you create a new 
Meeting, select the Open the Event Details dialog when drag-creating new 
Meetings option.

From this dialog box you can also set up your availability for meetings and priority 
labels for Calls and To-Dos. For more information, see “Setting Your Availability for 
Meetings” on page 50 or “Tracking To-Dos and Calls” on page 31.
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Using the Address Book
Eudora Planner’s Address Book lets you manage important information about the 
people and companies you interact with throughout the day. The individual records 
of people and organizations in the Address Book are called Contacts in Eudora 
Planner. Your Contacts store basic data such as names and addresses, and also 
provide a way to organize and access more dynamic information, including links to 
external documents and the Internet. You can track your interactions with these 
people and companies through links to the Eudora Planner Calendar.

In this chapter, you will learn how to add Contacts to your Address Book, as well as 
how to locate specific Contact information, track your telephone calls and e-mail, 
and find additional Contact information on the Internet.

Creating Contacts
Contacts are the people and organizations in your Address Book. A Contact’s 
information can include a name, company name, home and work addresses and 
telephone numbers, as well as a history of meetings, telephone calls, letters, and 
notes associated with the Contact.
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To create a new Contact:
1. From the Insert menu, select Contact.

The Contact Details dialog box appears.

2. Type personal and company information into the Name, Company, 
Department, and Title fields. 

Press Tab to move to the next field or Shift+Tab to return to the previous field.

3. If you want the Contact to appear in the QuickContact menu, click the Quick 
Contact checkbox.

4. Enter a home address, work address, or both. Select the type of address you 
want to enter by clicking either the Work or Home button above the address 
boxes.

5. To add telephone numbers, e-mail addresses, and URLs, select an item from 
one of the five Connection field drop-down lists. In the box next to the item 
you’ve chosen, type a telephone number, URL, or e-mail address, whichever is 
appropriate.

If you need to store more than five telephone numbers or Internet addresses, 
you can create custom fields. See “Using Custom Fields” on page 30 for more 
information.

6. Click OK.

Eudora Planner adds the Contact to the Address Book. 
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primary name 
and phone 
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send e-mail

Click to open 
section

Click to close 
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You might find that you often create Contacts that contain much of the same 
information as other Contacts in your Address Book, such as those you create for 
people who work for the same company. For Contacts like these, you can create 
templates that already contain common information, saving you from unnecessarily 
re-entering data. For details about creating Contacts based on your custom 
templates, see “Using Contact Templates” on page 35.

Adding Information to Contacts
Eudora Planner’s Address Book gives you the ability to track more information about 
your Contacts than just names, addresses, and phone numbers.

You can create custom fields to store important data that can’t be placed in standard 
fields such as Name, Company, and Address.

You can attach Calendar Events, other Contacts, and free-form notes to each 
Contact’s History list. The History list can also store shortcuts to other files or 
applications, as well as links to related documents, whether they reside on your 
computer, on your network, or on the Internet.

Using Custom Fields
You can create custom fields to hold information not included in the general Contact 
information fields.

When you create a custom field, you give it a unique name, then specify the type of 
data it can contain, such as a number, a date, or text. 

For example, you could create a custom field named Birthday to keep track of the 
birthdays of your friends and business associates. You would assign such a field a 
type of date, so it can contain only dates. You might also make a Birthday Card field, 
with a type of Yes/No, to indicate whether or not a particular Contact should receive 
a birthday card. 

Because a custom field is defined to contain a certain type of data, the information in 
that field is in a consistent format throughout your Address Book, assuring accuracy 
when you do searches and sorts based on that information. 
Using the Address Book 57



Creating Custom Fields
When you create a new custom field, you name the field, then specify the type of 
information you want the field to contain. You can choose from ten field types:

Once you’ve assigned a field type to a custom field, the field can only contain 
information designated for that type.

To create a Custom Field:
1. From the Tools menu, select Custom Fields.

The Custom Fields dialog box appears.

2. Click the Server arrow to display a list of available servers. Select a server from 
the list.

A default server is already selected for you. If you’re using Eudora Group 
Planner, you can select a workgroup server from the Server list, thereby 
making the custom field available to other users connected to that server.

3. Click New.

Field Type Contains...

Yes/No A simple yes or no option

Date and Time The date and time (timestamp)

Date and Time Range Starting and ending dates and times

Date Only A single date

E-mail An e-mail address

Number Any positive or negative number

Phone A telephone number

Text Plain text information

Time Only A single time

Web Page A URL

Select a server on which the custom field resides

Click to change the name of the selected custom field

Click to create a new custom field
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The Custom Field Properties dialog box appears.

4. Type a name for the field in the Name box. 

5. Select a field type. Your options are described in the preceding table.

6. Click OK.

Eudora Planner adds the field to your database. Any custom fields saved to a 
workgroup server are available to other users on the network.

Organizing the Custom Fields Section
The custom fields you create in your database appear in the Contact Details dialog 
box for each Contact in your Address Book. If you’re using Eudora Group Planner, 
your Contacts also contain any public custom fields stored on the servers to which 
you’re connected. 

To help you better organize your custom fields, and so that you can quickly find 
those fields most vital to you, the Address Book’s Custom Fields section is divided 
into two areas. The lower area contains those custom fields installed with Eudora 
Planner, as well as the custom fields you yourself have created and any fields 
residing on workgroup servers you’ve connected to. The upper area is, by default, 
empty, but can accommodate any of the custom fields you choose to move from the 
lower area; it is here that you place those custom fields that are important to you. 
You can still enter and change data, as your access privileges allow, in custom fields 
that remain in the lower area.
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To organize the Custom Fields section:
1. Open any Contact in your Address Book.

The Contact Details dialog box appears.

2. In the Contact Details dialog box, click the plus sign next to Custom Fields.

The Custom Fields pane appears.

3. In the lower area of the Custom Fields section, click the name of a custom field.

The custom field becomes outlined.

4. Drag the custom field into the upper area of the Custom Fields section.

5. Click OK. 

The field appears in the upper area of the Custom Fields section in every 
Contact in your Address Book. If you decide to change the location of the field, 
you can drag it back to the lower area at any time.

Changing Custom Field Names
Eudora Planner allows you to change the name of the custom fields you create.

To change the name of a Custom Field:
1. From the Tools menu, select Custom Fields.

The Custom Fields dialog box appears.

2. In the list of custom fields, click the name of the field you want to change.

The custom field name becomes highlighted.

3. Click Modify.

The Custom Fields Properties dialog box appears.
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4. Type the new name into the Name box.

5. Click OK to close the Custom Field Properties dialog box, then click OK to close 
the Custom Fields dialog box. 

The custom field name is changed for all Contacts in your Address Book.

Although you can change the name of a custom field, you cannot change its type.

Deleting Custom Fields
You can delete from your Address Book any custom fields that you no longer need.

To delete a Custom Field:
1. From the Tools menu, select Custom Fields.

2. In the list of Custom Fields, click the name of the field you want to delete.

The Custom Field name is highlighted.

3. Click Delete.

4. Click OK.

The custom field is deleted from any Contacts in your Address Book.

You cannot delete a custom field if any Contact in your Address Book still contains 
data for that custom field.

Attaching Other Information to Contacts
In addition to containing personal and business information, your Contacts can also 
contain links to attached Calendar Events, notes, and documents. These 
attachments appear in the Contact’s History, where you can view them by double-
clicking them.

Attaching New Events to Contacts
You can attach related Events to a Contact. Attached Events appear in the Contact’s 
History, where you can view them by double-clicking them.

Existing Events must be attached to Contacts from within the Calendar. For details, 
see “Adding Contacts to Events” on page 24.

To attach an Event to a Contact:
1. Double-click the Contact in the Address Book.

The Contact Details dialog box appears.

2. Click either the Attach Meeting, Attach Call, or Attach To-Do button in the 
Contact Details dialog box.

The Event Details dialog box appears.

3. Fill in the details for the Event. For more explanation, see “Adding Events to the 
Calendar” on page 16.

4. Click OK.
Using the Address Book 61



The Event appears in the History list.

You can also attach an Event to a Contact by right-clicking the Contact in the List 
View, then selecting an Event type from the options displayed in the shortcut menu 
that appears, which opens an Event Details dialog box. Once you’ve finished 
entering information for the Event, click OK. The Event is attached to the Contact.

To remove an attached Event from a Contact:
1. Double-click the Contact to open its Details dialog box.

2. Open the History section.

3. Select the Event you want to delete, then press the Delete key.

The Event is removed from the Contact’s History list, but is not deleted from the 
Calendar.

You can remove an Event from a Contact by right-clicking it in the History list, then 
selecting Delete from the shortcut menu that appears.

Adding Notes to Contacts
You can attach your own notes to Contacts in the Contact Details dialog box.

To add a note to a Contact:
1. Double-click the Contact to which you want to add the note.

The Contact Details dialog box appears.

2. In the Notes box, type your note, then click Add to History.

The Note dialog box appears.

3. In the Title box, type a title for the note.

4. Click OK.

The title of the note appears in the History list, along with the date and time you 
created it. To view or edit the note, double-click it in the History list.

To delete a note from a Contact:
1. Double-click the Contact that contains the note.

The Contact Details dialog box appears.

2. Open the History section.

3. In the History list, select the note you want to delete, then press the Delete key.
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The note is deleted from the Contact and no longer appears in its History list.

You can delete a note by right-clicking it in the History list, then selecting Delete 
from the shortcut menu that appears.

Attaching Documents to Contacts
You can attach an external document to a Contact so that it displays in the Contact’s 
History list. When you double-click the document name, Eudora Planner opens it in 
the application that created it. Because the document is only aliased in the Contact 
and not inserted into the database, you can accumulate additional information 
related to your Contact without significantly increasing the size of the database. 

To attach a document to a Contact:
1. Double-click the Contact to which you want to attach the document.

The Contact Details dialog box appears.

2. Click the Attach Document button.

The Select dialog box appears. Use this dialog box to navigate to find the 
document.

3. Click OK.

The name of the document appears in the History list of the Contact. You can 
view or edit the document by double-clicking it, which launches the application 
that created it.

You can also attach a document to a Contact by dragging and dropping into that 
Contact’s record in the List View. The document will appear in the Contact’s History 
list.

To delete a document attached to a Contact:
1. Double-click the Contact from which you want to remove the attached 

document.

The Contact Details dialog box appears.

2. Open the History section.

3. In the History list, select the document you want to delete, then press the 
Delete key.

The alias to the Contact is removed, but the original document is not deleted or 
altered in any way.

You can delete an attached document by right-clicking that document in the History 
list, then selecting Delete from the shortcut menu that appears.

Attaching a Contact to Another Contact
You can attach Contacts to each other to show a relationship more specific or 
narrow than that demonstrated by category affiliation, such as the relationship 
between a manager and an assistant, or that between law partners. 
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To attach a Contact to another Contact:
1. Double-click the Contact to which you want to attach another Contact.

The Contact Details dialog box appears.

2. Click the Attach Contacts button.

The Attach Contacts dialog box appears.

3. In the Find Method box, choose whether you want to search among specific 
Contacts, Quick Contacts, or all Contacts to find the ones you want to attach.

• Use the Find Contact option to search for specific Contacts using the Find 
What box.

• Choose Quick Contacts or All Contacts to populate the Matching Contacts 
list with every Contact, or every Quick Contact, in your Address Book. Skip to 
step 5 if you choose one of these methods.

4. In the Find What box, begin typing the name of a Contact you want to attach to 
this Contact.

As you type, Eudora Planner searches your Address Book for names matching 
the text you’re typing. Matching names appear in the Matching Contacts list.

5. In the Matching Contacts list, select the Contacts you want to attach to the 
Contact, then click Attach.

The selected Contacts move to the Attached Contacts list.

6. Click OK.

The selected Contact is attached to the opened Contact and appears in the 
opened Contact’s History. You can open the attached Contact’s Details dialog 
box by double-clicking it in the History list.
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Selecting Primary Fields
Your Address Book can contain Contact records for a wide variety of people you 
interact with, including business associates, friends, and relatives. For some of 
these people, like your business associates, the most vital Contact information is 
that which is work-related, such as company addresses and work phone numbers. 
For your friends and relatives, however, personal data, such as home address and 
phone number, is more important. Because the most important information varies 
for different types of Contacts, Eudora Planner lets you select primary fields for each 
individual Contact.

For each Contact, you can select a primary listing (either Name or Company), a 
primary phone number (Work, Home, Fax, or Mobile), and a primary address (Work 
or Home). When you’ve selected a field as primary, you can display, print and sort 
based on the information contained in that field. For example, you can configure a 
List View that displays the primary address column, that shows for each Contact the 
address field you’ve designated as primary, whether it be the Work or Home 
address.

Primary fields function in the following areas:

• The listing and phone fields you select as primary determine what information 
appears in the name and number listing at the top of the Contact Details dialog 
box.

• The address you select as primary determines which address displays when 
you open a particular Contact.

• Three columns that you can choose to display in the List View are affected by 
your primary field settings. What displays in the Listing Header depends on 
whether you select Name or Company as primary; the Primary Address field 
displays the address you select; and the Primary Phone field displays the 
telephone number you select.

• The phone field you select as primary determines which phone number appears 
for a Contact displayed in QuickContact.

You can select primary fields by clicking field names in the Contact Details dialog 
box. The names of the primary fields appear underlined.

To select primary listing and address fields:
1. Open the Contact for which you want to select primary fields.

The Contact Details dialog box appears.

2. Click the title of the Listing field you want to select (either Name or Company).
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The field you select is underlined, indicating that it is now the primary. Also, the 
listing at the top of the Contact Details dialog box changes to reflect your 
selection.

3. In the Address Area, click on either Work or Home, depending on which 
address field you intend to make the primary.

4. Click the title of the field you’ve selected.

The field name becomes underlined, indicating it is the primary field.

5. Click OK.

The field you’ve selected becomes the primary field for this particular Contact.

Primary 
name 
appears in 
the Contact 
heading

Primary 
name 
appears 
underlined

Primary 
address is 
underlined
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To select a primary Connection field:
1. Open the Contact for which you want to select the primary Connection field.

The Contact Details dialog box appears.

2. Click the arrow in the uppermost Connection field.

A drop-down list containing each type of Connection field appears.

3. From the drop-down list, select the Connection field you want to designate as 
primary.

4. Click OK.

The phone number you’ve selected to appear in the uppermost Connection field 
appears in the Contact heading, indicating that it is the primary.

Assigning Categories to Contacts
You can organize and show relationships between Contacts by assigning them to 
categories. To learn more about organizing Contacts with categories, see “Assigning 
Categories to Contacts and Events” on page 85.

Using Contact Templates
You may find that you often create Contacts that contain much of the same 
information and attachments as others already in your Address Book, such as those 
for different people who work for the same company. You can avoid having to re-
enter and attach the same information every time you add a new Contact by creating 
Contacts based on Contact Templates. 

A Contact Template can contain information in any field, attached documents, notes 
and Events, and any categories you specify. Each time you create a Contact based 
on that template, Eudora Planner inserts all the specified information into your new 
Contact, which you can then modify as needed.

Primary phone 
number is always 
located in uppermost 
box

Primary phone 
number appears in 
Contact heading
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Creating Contact Templates
After you create a Contact template, Eudora Planner adds the template to your 
database and makes it easily accessible from the Insert menu.

To create a new Contact template: 
1. From the Insert menu, select Contact from Template. Then, select Define 

Contact Template from the submenu that appears.

The Template dialog box appears.

2. Click New.

The Create a New Template dialog box appears. 

3. Type a name for the template and click OK.

The Contact Details dialog box appears.

4. Enter information into the Template, just as you would a Contact. You can also 
add notes and attach documents and Events.

For more information, see “Creating Contacts” on page 29.

5. Click OK.

The template is saved to your database and appears in a submenu when you 
select the Contact from Template command from the Insert menu.

Creating Contacts from Templates
When you create a Contact based on a Template, the new Contact contains all the 
field and attachment information you’ve specified for that Template, including 
primary field settings. Any information in the new Contact can be modified, whether 
it’s from the Template or not.

To create Contacts based on Templates:
1. From the Insert menu, select Contact from Template, then select the template 

name.

The Contact Details dialog box appears. The new Contact contains all the 
information and attachments in the template.

2. Add new information to the Contact or modify the information from the template, 
if necessary.

3. Click OK.

The new Contact appears in your Address Book.
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Finding Contacts
Eudora Planner’s search features let you use a variety of criteria to find Contact 
information in your Address Book. 

The Find feature searches your Address Book for field data that you specify, then 
generates a list of Contacts containing that data. You can search all fields in your 
database at once—including all custom fields—or narrow the search by specifying 
that Eudora Planner search only selected fields.

The QuickFind feature lets you search for and generate a list of Contacts associated 
with a specific category or group of categories. The QuickFind button, which is a 
component of QuickFind located on the Eudora Planner toolbar, lets you do a one-
click search for the contents of a single category.

The following sections describe Eudora Planner’s search features.

Using the Find Feature
When you want to find a Contact in your Address Book, type a word for Eudora 
Planner to search for. Eudora Planner returns a list of all Contacts that contain the 
search word.

To search for Contact information using the Find feature:
1. From the Edit menu, select Find.

The Find Contact dialog box appears.

2. In the Find box, type the information you want to search for.

3. Select a Search option.

Select Current Tab to search only the tab that is presently forward. Select All 
Tabs to search all tabs in your Address Book. 

To start the search, go to Step 7. To change the search parameters, go to 
Step 4.

4. Click Advanced. 
Using the Address Book 69



The Find Contact dialog box expands to show more options.

5. In the Fields to search area, select the fields you want to search.

6. Select one of the following Comparison options:

• Select Contains to search for Contacts that have fields with contents that 
contain the data you’ve entered into the Find box. For example, if you do a 
search for all Contacts containing the name “Rob,” Eudora Planner will turn up 
records with the names “Robert” and “Robin,” as well as those containing 
“Rob.”

• Select Equals to search for Contacts that have fields with contents exactly 
matching the data you’ve entered into the Find box. So, if you do a search for 
Contacts with the name “Rob,” Eudora Planner will only find those with exactly 
that name.

• Select Starts with to search for Contacts that have fields with a data string 
that starts with the text or number string you’ve entered into the Find box.

7. Click OK.

The Search Results tab appears, listing all the Contacts containing the data you 
searched for. See “Saving Your Search Results” on page 71 for information on 
how to save your search results.
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Using QuickFind
Eudora Planner’s QuickFind feature lets you find all the Contacts associated with a 
particular category or group of categories.

To use QuickFind:
1. From the Edit menu, choose QuickFind.

The QuickFind dialog box appears.

Clicking the QuickFind button on the Toolbar returns search results for a 
single category you select. If you want to search for multiple categories, 
you must initiate the search from the Edit menu.

2. In the Select Categories to look for list, click each category that you want to 
find.

3. Click OK.

The Search Results tab appears, containing the Contacts in the categories you 
selected. See “Saving Your Search Results” for information on how to save your 
search results.

You can use QuickFind to search for any Contacts that you’ve added to 
QuickContact, which means that you can quickly scan your Quick Contacts to 
remove obsolete names and organizations.

Saving Your Search Results
If you want to refer later to the results of a search, you can save the Search Results 
tab as a new Address Book tab. 

To save your search results as a new tab:
1. Click the Search Results tab to bring it forward.

2. Click the Save Search Results button in the bottom right corner of the Address 
Book window.

The Save Search Results dialog box appears.

3. Type a name for the tab in the Tab Name box.

4. To assign a category to all Contacts in the Search Results tab, click the 
Category for search results arrow, then select a category from the drop-down 
list. If you don’t want to assign any of your existing categories, click New 
Category to create a new one.

Because tabs are based on groupings of categories, you must assign a 
common category to the Contacts in your search results. The category 
you assign here will also become the default category for the new tab. For 
more information about tabs, see “Using Tabs” on page 89.
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5. Click OK.

The tab appears in your Address Book, showing any Contacts associated with 
the category you selected in step 4. You can modify this tab as you would any 
other Eudora Planner tab. For information on modifying tabs, see “Assigning 
Categories to Tabs” on page 96.

Finding, Viewing, and Deleting Duplicate Contacts
Eudora Planner helps you reduce clutter in your Address Book by letting you search 
for and delete redundant Contacts. 

To search for duplicates throughout your Address Book, create a tab that contains 
and displays all categories.

To find, view, and delete duplicate Contacts:
1. From the Tools menu, select Show Duplicates.

The Duplicate Contacts dialog box appears, displaying the names of all 
Contacts that appear more than once in the current tab.

If the Show Duplicates command appears dimmed in the Tools menu, 
then there are no duplicates in the current tab.

2. Click the plus sign next to the name of the duplicate Contact.

A hierarchical list appears below the name, showing each instance of the 
Contact and the date and time it was last modified. 

3. To examine a duplicate Contact, select it in the hierarchical list, then click View. 

The Contact Detail dialog box appears. You can modify any of the Contact’s 
information.

4. If you want to delete a duplicate Contact, select it in the hierarchical list, then 
click Delete.

The Contact is deleted from your Address Book.

The Delete option is not available to you if you select a shared Contact for 
which you do not have Delete permission. Consult your systems 
administrator to determine your permissions for items residing on a 
workgroup server.

5. Click Close to close the Duplicate Contacts dialog box.
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Getting More Out of the Address Book
The following sections explain some of the advanced features of the Address Book.

Editing Contacts in the List View
You can modify or add to Contact information when it is displayed in the List View. 
Click to select the Contact field you want to modify, then directly type new 
information in the field. Eudora Planner saves your changes to the database when 
you click outside the field.

Duplicating Contacts
If you need to create a new Contact for someone whose personal information is 
nearly identical to that of an existing Contact in your Address Book, you can 
duplicate the existing Contact, then make the necessary changes to the duplicate. 

To duplicate a Contact, select it in the List View, and then choose Copy from the 
Edit menu. Click anywhere in the list and select Paste from the Edit menu. The 
duplicate Contact will appear in the List View directly beneath the original.

Deleting Contacts
To delete a Contact, select it in the List View, then select Delete from the Edit menu. 
If you’re using Eudora Group Planner, you cannot delete public Contacts for which 
you don’t have delete permission.

Sorting Contacts in the List View
The Address Book List View displays your Contact information in columns that each 
contain a Contact field. You can assign each column a sort level. Your sorting 
operation applies only to the active tab.

To sort Contacts:
1. Click any column heading to select a column.

The number one (1) appears in the column heading to indicate that it is the first 
sort field. The Address Book sorts by this first column in descending order.

2. If you want to sort in ascending order, click the column heading again.

The column sort reverses, and the sorting icon changes.

3. To define other sort columns, hold down the Shift key and click the column 
headings.

Numbers appear in their column headings, indicating their level in the sort. After 
each click, the columns are resorted.
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Moving and Resizing Columns in the List View
To reposition a column, click its heading and drag it to a position to the immediate 
right of the column you want it to follow. You can resize a column by dragging its 
borders.

Dialing Contacts
If your computer is connected to a telephone line by a modem, you can use Eudora 
Planner to dial the phone numbers of Contacts in your Address Book.

To communicate with your modem, Eudora Planner uses Telephony Application 
Programming Interface (TAPI). Any TAPI-compliant modem or device will work.

To dial a Contact:
1. In any Address Book view, find the Contact you want to call, then click the 

phone icon next to the number you want to dial.

The Call Details dialog box appears, containing phone information for this 
Contact. For details on how to add information to a Call, see “Scheduling Calls” 
on page 29.

2. In the Call Details dialog box, click Dial Phone.

Your modem dials the number you’ve selected, and the Call Status dialog box 
appears.

3. Pick up your phone’s receiver, click Talk, and wait for the party you’ve dialed to 
answer.

If, before you pick up the receiver, you decide not to complete the call, click 
Hang Up to clear your modem and terminate the call.

The call appears as a Call Event in your calendar and in the History list of the 
Contact.

Faxing Contacts
Eudora Planner lets you fax attachments or Microsoft Fax-compatible files to 
Contacts in your Address Book. You can fax multiple documents to a single Contact, 
or you can send a fax to a number of Contacts in your Address Book.

To send a fax to a Contact:
1. In the List View, select the Contact to which you want to send the fax.

If you want to send a fax to more than one Contact, select the various Contacts 
by clicking them while pressing the Control key. Or, drag along the List View to 
select a contiguous group of Contacts.

2. From the Tools menu, select Send Fax.
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The Send Fax dialog box appears. If you selected more than one Contact in the 
List View, all Contacts appear in a list.

3. To have a subject and note appear on the first page of the fax, type a subject in 
the Subject box and a note in the Note box. If you want Eudora Planner to add 
to the Contact’s History list a note indicating that you sent the fax, select the 
Add fax event to Contact option.

4. If you want to add files to your fax, click Browse, then select the files you want 
to fax. If you want Eudora Planner to attach the files you’ve selected, select the 
Attach files to Contact (if not already attached) option. If you want to add 
files already attached to a Contact, click Contact’s Files , then select the files 
you want to fax.

The names of the files you select appear in the Files to fax  list.

E-mailing Contacts
If you use a Messaging Application Programming Interface (MAPI) compliant e-mail 
program, Eudora Planner can launch a new message that is pre-addressed to a 
Contact.

To e-mail a Contact:
1. Double-click the Contact.

The Contact Details dialog box appears.

2. Locate the Contact’s e-mail address in a Connection field, then click the mail 
button next to it.

Your e-mail application opens with a new, pre-addressed message addressed 
to your Contact.
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3. Complete the body of your message, then send the message.

If you have selected the Log e-mail sent to Contacts check box in the Address 
Book Preferences (described in “Miscellaneous Preferences” on page 82), a 
dialog box appears that prompts you to type the title and text of a Note entry for 
the message to be logged in the Contact’s History list, recording the time, date, 
and title of the e-mail message.

Using Mail/Fax Merge
Eudora Planner’s Mail/Fax Merge feature lets you quickly and easily merge Address 
Book data with existing merge templates or document files created in Microsoft 
Word. Using Mail/Fax Merge, you can merge your Contact data into a new Word 
document that you can also attach to an e-mail message and send using your 
preferred e-mail program. Eudora Planner automates most of the merge process, so 
once you’ve created and saved a merge document, you need only to select the 
Contacts you want to merge and choose a merge destination. This feature supports 
Word versions 7 and 97. 

To use the Mail/Fax Merge feature, you must have a template document with which 
to merge. You can use one of the merge templates provided for you in Eudora 
Planner’s Templates folder, or create your own, as described in the next section. To 
use the Mail/Fax Merge feature with an existing merge template, see “Merging 
Address Book Data with a Merge Template” on page 77.

Creating a Merge Template
Creating your own merge template involves using Microsoft Word to save a Word 
template document that incorporates merge data from your Address Book.

To create a Word 7 or 97 merge template to use with the Mail/Fax Merge feature:
1. In Word, create or open the document you want to use as a merge template. If 

you’re creating a new document, type in its entire text and save it before 
proceeding to step 2.

2. Select Mail Merge from Word’s Tools menu and, on the Mail Merge Helper 
dialog box that appears, click the Create button and select the type of 
document you want to create.

Word displays another dialog box.
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3. Click the Active Window button to specify that the open document will be used 
to make your template. Then, click Close. Save the Word document and close 
it.

4. In Eudora Planner, select Mail/Fax Merge from the Tools menu.

The Mail/Fax Merge dialog box appears.

5. Click Browse to use the Open dialog box to look for the merge template you’ve 
created in Word. Once you’ve located it, click OK.

You are returned to the Mail/Fax Merge dialog box. The template’s pathname 
appears in the Template box.

6. Make sure the Automatically send data to merge destination option is not 
selected. Then, click OK.

The merge template is opened containing Eudora Planner’s merge fields.

7. Insert merge fields into the template by placing the cursor where you want a 
field to be, clicking the Insert Merge Field button on the Mail Merge toolbar, 
and dragging in the drop-down list that appears to select a merge field. When 
you’ve inserted all the merge fields you need, save the document. 

Your document is ready to be used as a mail merge template with Eudora 
Planner, as described in the following section.

Merging Address Book Data with a Merge Template
Once you’ve created a merge template, you can use it to merge your Address Book 
data to a selected destination.

To merge Address Book data with a merge template:
1. In the List View, select the Contacts you want to merge with the merge 

template. You don’t need to select any Contacts if you intend to merge all those 
appearing in the List View.

2. From the Tools menu, select Mail/Fax Merge.

The Mail/Fax Merge dialog box appears.

3. Click the Browse button to use the Open dialog box to find the template with 
which you want to merge. Once you’ve located it, click Open.

You are returned to the Mail/Fax Merge dialog box. The pathname of the 
template you selected appears in the Template box.

4. In the Export section, select the All Contacts option if you want merge all the 
Contacts on the current tab. Select the Selected Contacts option if you want to 
merge only those Contacts that you’ve selected on the current tab.
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5. In the Merge Destination box, click the arrow to select how and where you want 
the merge to occur:

• Select the New Document option if you want to create a new Word document 
containing the merged data. You can view, edit, save, and print this document.

• Select the Printer option if you want to print a hard copy document containing 
the merged data, but don’t want to view or save it as a new document in Word.

• Select the Electronic Mail option if you want to e-mail the merge document 
as an attachment to an e-mail message. The document will be attached 
automatically to the message.

6. Select the Automatically send data to merge destination option. If you want 
a note of the merge to be logged into each Contact’s History list, select the Add 
a note about the merge to the Contact option.

7. Click OK.

The data from the Contacts you’ve selected is merged with the template at the 
destination you’ve specified in step 5.

• If you selected the New Document option, the data will be merged into a new 
Word document.

• If you selected the Printer option, the data will be merged into printed 
documents.

• If you selected the Electronic Mail option, the data is merged into a document 
that is attached to an e-mail message, which is in turn sent automatically by 
your e-mail program. The e-mail message appears with the attachment in 
your e-mail program’s log of sent messages.

Viewing Web Sites Linked to Contacts
Eudora Planner can open a web page linked to a Contact using your favorite Web 
browser.

To view Contact Web sites:
1. Double-click the Contact.

The Contact Details dialog box appears.

2. Locate the Contact’s Web site name in a Connection field, then click the button 
next to it.

Eudora Planner launches your preferred Web browser, which searches for and 
loads the Web page.
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Using QuickNet
Eudora Planner’s QuickNet feature uses the search capabilities of the World Wide 
Web to help you locate information about Contacts in your Address Book. QuickNet 
can help you find a Contact’s Zip+4, e-mail address, or white pages listing—even a 
map to a street address. When you select a QuickNet option, Eudora Planner 
launches your Web browser and initiates a search based on existing data in a 
Contact’s record.

To access the QuickNet menu, click the QuickNet icon in the Contact Details dialog 
box and select an option from the menu that appears.

Setting Address Book Preferences
The Address Book preferences let you activate Eudora Planner’s various data entry 
aids, choose your preferred software for faxing, and configure the contents of the 
Full Name field in the List View. You can change your Address Book settings by 
choosing Address Book Preferences from the Tools menu or by clicking the 
Preferences button in the Contact Details dialog box. Your changes take effect after 
you click OK.

The Address Book Preferences dialog box has tabs for data entry, phone formats full 
name styles and miscellaneous preferences, each of which are described in the 
following sections.
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Data Entry Preferences
Data entry preferences determine the way Eudora Planner behaves when you enter 
Contact data into either the List View or Details dialog box. 

Activate the Auto-Complete feature to have Eudora Planner automatically finish 
what you type into List View fields. When Auto-Complete is active, Eudora Planner 
searches your Address Book for existing data that matches the text you’re typing, 
then completes the typing for you. The Auto-Complete feature functions in the 
Name, Company, and City fields.

The Auto-Capitalization preferences determine whether Eudora Planner 
automatically capitalizes the first letter of each word entered into a Contact Detail 
field. This feature is available for the Name, Company, City, State, Country, and 
Salutation fields.

Immediately after you enter the company name for a new Contact, Eudora Planner’s 
Auto-Fill address feature searches your Address Book for an existing Contact with 
that company name, and then fills in the new Contact’s Work Address field with the 
contents of the existing Contact’s Work Address field. Select the Auto-Fill address 
check box to enable this feature.

When the Warn of duplicates check box is selected, Eudora Planner will alert you 
when you try to save a new Contact that contains the same first name, last name, 
and company name as an existing one.

To have Eudora Planner alert you when you save a Contact that another user has 
modified simultaneously, select the Warn of conflicts check box.
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Phone Formats Preferences
The Local and International Phone Format options let you choose whether and 
how domestic and international phone numbers will be automatically formatted 
when you enter them. If you don’t want to use any of the standard options provided 
by Eudora Planner, you can select Custom to create a format to suit your needs.

Full Name Style Preferences
The Full Name Style preferences determine how a Contact’s name appears in the 
Full Name column of the List View.

Select a Name Ordering option to determine the format and order of the Full Name 
field, as well as if the middle name appears in the full name.

The Display in the Full Name preferences affect whether salutations and titles 
appear in the Full Name column. Select the Salutations check box if you want the 
salutation field's value (such as Mr., Ms., Dr.) to appear in the Full Name column. 
Select the End Title check box if you want a title such as Jr., Esquire, M.D., etc. to 
appear in the Full Name column at the end of the name.
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Miscellaneous Preferences
You can set preferences that affect key scrolling, faxing, the behavior of the Contact 
Details dialog box, and the logging of e-mail to Contacts.

Two Key Scrolling options determine how you can locate Contacts in the Address 
Book by typing their names. Selecting Match case makes the results of your typing 
case-sensitive. To have the letters you type match only the beginnings of words, and 
not strings of letters within a word, select Match beginnings of words only.

The Faxing Software preference determines which type of faxing software Eudora 
Planner uses when you send a fax to a Contact. The software you choose must be 
MAPI-compliant.

In the Contact Detail Dialog preferences area, select Confirm on save, Confirm 
on delete, and Confirm on cancel if you want Eudora Planner to prompt you to 
confirm your changes every time you save, delete, or cancel after adding or deleting 
information in the Contact Details dialog box.

To have Eudora Planner prompt you to create a log entry to be added to a Contact’s 
History list each time you send them e-mail, select the Log e-mail sent to 
Contacts check box.
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Organizing Eudora Planner
Eudora Planner adds flexibility and structure to your Calendar and Address Book by 
letting you associate related Events and Contacts using categories and tabs.

About Categories and Tabs
By assigning a group of related Events or Contacts to the same category, you can 
create a relationship between them and give them a common visual style, so that 
you can view and manage them as a distinct group. A single Event or Contact can 
belong to as many categories as you need.

For example, a single Event could belong to a general Business category, a more 
specialized Client category, and an even more specific Project category, allowing 
you to view it in either a broader or more narrow context. Similarly, a single Contact 
could belong to a Business category, a Client category, a category for a specific 
Project team and one for Golf Partners, so that you can list it with other Contacts 
that fit the same category.

As categories help you view and manage related Events and Contacts, Tabs provide 
a similar way to handle related categories. You can control which categories are 
displayed together by creating tabs for certain, individual categories or groups of 
categories.

For example, to view only your work-related Events and Contacts, you could create 
a tab called “Work” that displays categories such as: 

• A “Business” category, containing work-related Meetings, To-Dos and Contacts 
within your company

• A “Travel” category, containing your travel schedule and itinerary and Contacts 
like travel agents, hotels and airlines

• A “Financial” category, containing paydays, billing deadlines, and Contacts like 
banks, accountants, and creditors
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By default, Eudora Planner contains a number of categories and tabs in both the 
Calendar and Address Book. If you have no need to divide or compartmentalize 
your Events and Contacts, you may find a single category and tab to be sufficient. 
Using categories and tabs is completely optional. As you find yourself using Eudora 
Planner to manage increasing amounts of Events and Contacts, however, you will 
find these organizational tools to be very helpful.

The following sections describe these concepts in more detail. The section 
immediately below describes how to use categories. tabs are discussed further in 
“Using Tabs” on page 89.

Using Categories
Over time, as your Eudora Planner database grows, you may find it easier to 
manage your information by grouping your Events and Contacts into common 
categories. You can choose from the categories that were installed with Eudora 
Planner, create your own categories, or, if you’re using Eudora Group Planner, 
select categories on a workgroup server.

When you create a new Contact or Event, it already belongs to a default category, 
its primary category. Although an Event or Contact can belong to any number of 
categories, it can have only one primary category, which determines how it appears 
in your Calendar and Address Book—the colors and fonts used to display it.

The following sections describe how to create categories, assign Events and 
Contacts to them, determine the primary category for Events and Contacts, and 
how to modify and delete categories.

Creating Categories
You can create your own categories for Events and Contacts if those installed with 
Eudora Planner or available on public servers aren’t suitable for your purposes. 

To create a category:
1. From the Tools menu, select Categories.

The Categories dialog box appears. Available categories appear in a list.

2. Click the Server arrow to select the server to which you want to add the 
category.

3. Click New.
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The Category Properties dialog box appears.

4. In the Name box, type a name for the category. 

5. To give the category a distinctive appearance, click the Font button to open the 
Font dialog box. Specify Font, Font style, Size and Effects options. When you 
finish, click OK. The settings you select here will only affect Events having this 
category as their primary category (see “Changing the Primary Category” on 
page 87 for information about primary categories).

6. In the Background Color list, select a background color for the category. The 
color you select here will provide the background for Events and Contacts for 
which this is the primary category.

7. Click OK.

Eudora Planner adds the category to the Categories list.

Assigning Categories to Contacts and Events
You can organize and show relationships between Events and Contacts by 
assigning categories to them.

To assign categories to Events and Contacts:
1. Double-click the Event or Contact.

The Event Details or Contact Details dialog box appears.

2. Click Categories.

The Assign Categories dialog box appears.

Click to select the font, font size, and style assigned to items for 
which category is the primary category

Click to select the background assigned to items for which this is 
primary category

Select the 
categories 
you want to 
assign to 
the item

Select a primary category for the item from the drop-
down list

Click to change a category’s properties
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If you are connected to a workgroup server, then the server’s name will appear 
in parentheses next to categories stored on that server.

3. In the Categories list, click the categories you want to assign.

A check appears next to each category you click. The first category you select 
becomes the primary category for the Event or Contact. You can change the 
primary category by clicking the Primary Category arrow and selecting a 
different category from the drop-down list.

4. Click OK.

The categories appear in the Categories box of the Event or Contact.

To remove a category from an Event or Contact:
1. Double-click the Event or Contact.

The Event Details or Contact Details dialog box appears.

2. Click Categories.

The Assign Categories dialog box appears. The categories assigned to the 
Event or Contact are checked.

3. In the Categories list, click the categories you want to remove.

The categories become unchecked.

4. Click OK.

The category is removed from the Event or Contact and no longer appears in 
the Categories box.

Eudora Planner’s Address Book lets you assign a category or group of categories to 
multiple Contacts at one time. You can likewise remove categories.

To assign a category to multiple Contacts:
1. In the List View, select the Contacts to which you want to assign the category.

• To select all Contacts on the tab, from the Edit menu, choose Select All.

• To select a list of contiguous Contacts on the tab, click to the left of the name 
at the beginning of the selection, hold down the Shift key, then click to the left 
of the name at the end of the selection.

• To select a group of non-contiguous Contacts on the tab, click to the left of 
each name while holding down the Control key.

2. From the Edit menu, select Change Categories. 
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The Change Categories dialog box appears.

3. Click the plus sign next to the server containing the category you want to assign 
to the Contacts, then click the check box next to the category name.

4. Click OK.

The categories you selected are assigned to the Contacts you selected and 
appear in each Contact’s Details dialog box.

To remove a category from multiple Contacts:
1. In the List View, select the Contacts to which you want to assign the category.

2. From the Edit menu, select Change Categories. 

The Change Categories dialog box appears.

3. Click the plus sign next to the server containing the category you want to assign 
to the Contacts, then click the check box next to the category you want to 
remove.

The check is removed from the category’s check box.

4. Click OK.

The categories are removed from the Contacts you selected and no longer 
appear in each Contact’s Details dialog box.

Changing the Primary Category
Although you can assign multiple categories to an Event or Contact, only one of 
those categories can be the primary category for that item. The primary category 
determines the font and background color of an Event or Contact. When you create 
an Event or Contact, the default category of the tab on which it was created 
automatically becomes its primary category. You can later change the primary 
category.

Click plus sign 
next to server 
name to view 
categories on that 
server

Check off 
categories you 
want to assign to 
the Contacts
Organizing Eudora Planner 87



To change a primary category:
1. Double-click the Event or Contact.

The Event Details or Contact Details dialog box appears.

2. Click Categories.

The Assign Categories dialog box appears.

3. Scroll through Primary Category list until you find the category you want to 
use.

4. Click OK.

The category appears in the Categories box of the Event or Contact. The 
appearance of the Event or Contact changes to reflect the new primary 
category.

Editing and Deleting Categories
You can modify or delete the categories in your Calendar and Address Book, 
whether they’re the categories installed with Eudora Planner or the ones you’ve 
created. When you rename a category, all references to that category will reflect 
your change.

To edit categories:
1. From the Tools menu, select Categories. 

The Categories dialog box appears. 

2. Click a category in the list, then click Modify.

The Category Properties dialog box appears, allowing you to modify the 
category as desired. If you want to change the font for this category, click the 
Font button and select new options in the Font dialog box. Click OK.

3. Click OK.

Events and Contacts in the category change to reflect your selections.

To delete categories:
1. From the Tools menu, select Categories. 

The Categories dialog box appears. 

2. Click a category in the list, then click Delete.

A warning dialog box appears.

3. Click Yes to delete the category.

The category is deleted from your Eudora Planner database and is no longer 
available.

You cannot delete a category from your database if it is still assigned to any of your 
Events or Contacts. 
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Using Tabs
Once you’ve added enough categories to your Eudora Planner database to 
accommodate the different kinds of Events and Contacts you create, you may find 
that you need to further organize your Calendar and Address Book by grouping 
together related or similar categories. Using tabs, you can visually group related 
categories for quick reference and to reduce clutter in your Calendar and Address 
Book views.

You can create Calendar tabs that display only those Contacts contained in a single 
category or those contained in any combination of categories. For example, you 
could make one tab called Home to display your personal Events, which are all 
contained in a single category called Personal. Another tab called Work could show 
all your work-based Events, which are contained in three categories called 
Marketing, Sales, and Engineering. A third, master tab could display all Events in 
your Calendar.

Similarly, in your Address Book you might create a tab for only those categories 
containing personal Contacts, another for categories containing your business 
associates, and yet another to show all the Contacts in your database.

This section discusses how to create tabs, how to modify their appearance, and how 
to assign categories to them.

When you select a style for a tab, you give it a distinctive appearance. See “Creating 
Tab Styles” on page 92 for more information.

Creating Tabs
Create a tab when you want to visually group Events and Contacts in specific, 
related categories. 

Creating Calendar Tabs
As you fill your Calendar with Events, you may want to better organize your 
information by creating Calendar tabs that contain selected groups of categories. 
You can also create a Calendar tab that shows only Events that take up time in your 
schedule, so you can quickly see those important activities to which you’re 
obligated.
Organizing Eudora Planner 89



To create a Calendar tab:
1. In the Calendar, from the Tabs menu, select Add New Tab.

The Calendar Tab Settings dialog box appears.

You can create a new Calendar Tab by right-clicking an existing tab, then 
selecting Add New Tab from the shortcut menu that appears.

2. In the Name box, type a name for the tab. 

3. From the Style Name list, select a style, or create and assign a new style, if 
desired.

For more information on creating styles for tabs, see “Creating Tab Styles” on 
page 92.

4. In the Category list, select the Event categories you want to appear on the tab. 
To have this tab display all categories, click Select All.

5. Select an Event category from the Category for new Events list.

Click the arrow to select from the categories appearing in the drop-down list. 
The category you select here determines the default category for all Events you 
create in this tab.

6. Click OK.

The new tab appears in the Calendar.

To create a Calendar tab that shows only your busy time:
1. In the Calendar, from the Tabs menu, select Add New Tab.

2. In the Name box, type a name for the tab.

Enter a name 
here

Select a style 
from the drop-
down list

Select a default category for new Events 
created on this tab

Select to create 
a tab that 
contains all 
Events that 
block time in 
your schedule

Select to show hidden events on this tab

Click to edit existing category styles or to 
create a new one

Check off 
categories you 
want to appear 
in the tab Click to create a new category

Click to modify an existing category
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3. From the Style Name list, select a style, or create and assign a new style, if 
desired.

For more information on creating styles for tabs, see “Creating Tab Styles” on 
page 92.

4. Check the All events that block time box.

5. Click OK.

The new tab appears in the Calendar and contains only those Events which 
occupy your time.

Creating Address Book Tabs
You can organize your Contact information by creating Address Book tabs that show 
only selected groups of categories. When you configure an Address Book tab, you 
can also determine which Contact fields appear in the List View, and how those 
fields are sorted.

To create an Address Book tab:
1. In the Address Book, from the Tabs menu, select Add New Tab.

The Address Book Tab Settings dialog box appears.

You can create a new Address Book tab by right-clicking an existing tab, 
then selecting Add New Tab from the shortcut menu that appears.

2. In the Tab Name box, type a name for the tab. 

3. In the Categories list, select the categories you want to appear on the tab.

4. In the Category for new Contacts list, select a category.

The category you select here determines the initial default category for all new 
Contacts you create in this tab.

Enter a title 
here

Select the 
tab’s default 
category from 
the drop-down 
list

Select the 
Address Book 
fields you want 
to appear in the
List View

Click here to 
determine the 
sort order of 
the Address 
Book fields on 
the tab

Select a tab 
style from the 
drop-down list

Click to modify 
an existing tab 
style or create a 
new one

Check off the 
categories you 
want to appear 
in the tab
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5. From the Style Name list, select a style, or create and assign a new style, if 
desired.

For more information on creating styles for tabs, see “Creating Tab Styles” on 
page 92.

6. Optionally, select the columns and sort order to display on this tab.

• Click the Columns tab, then select the fields you want to appear in the List 
View of the Address Book tab. 

• Click the Sorting tab, then specify the default sort order of fields in the tab’s 
List View. Choose three sorting fields, then choose either ascending or 
descending order for each one by clicking the Up or Down option.

These fields appear in the List View, sorted according to your selections on the 
Sorting tab.

7. Click OK.

The tab appears in your Address Book.

Creating Tab Styles
You can apply different styles to your Calendar and Address Book tabs in order to 
give each tab a distinct appearance. The tab style determines attributes such as 
fonts, colors, and the locations of items appearing on the tab.

To learn how to assign tab styles to Calendar and Address Book tabs, see the 
following sections.

Creating Calendar Tab Styles
A Calendar tab style defines the appearance of each View on the tab—Day, Multi-
Day, Month and Year—and also determines what types of Events appear on a 
Calendar tab and how they are displayed. 
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To create a new Calendar tab style:
1. In the Calendar, from the Tabs menu, select Tab Settings.

The Calendar Tab Settings dialog box appears.

You can open the Calendar Tab Settings dialog box by right-clicking any 
existing tab, the selecting Tab Settings from the shortcut menu that 
appears.

2. Click Edit Styles. Then, in the Calendar Styles dialog box, click New. Type a 
name for the new style in the New Style box and click OK.

Click to edit existing category styles or to create a new one

Click to select all the categories on a server

Click to unselect all the categories on a server

Click to create a new category

Click to modify an existing category

Click to delete an existing category
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You return to the Calendar Styles dialog box.

3. From the View Name list, select a Calendar View. From the Area list, select a 
section of the current View for which to specify style information.

To the right, options appear for each area of the current View.

4. Select style options as appropriate. 

5. Repeat steps 3 and 4 until you have specified all styles.

6. Click Close.

Your new Calendar tab style appears in the Style Name list on the Calendar 
Styles dialog box. You can assign the style to your tabs as you prefer.

Creating Address Book Tab Styles
You can apply tab styles to Address Book tabs so that each tab has a distinct 
appearance. Address Book tab styles are templates that contain appearance and 
formatting preferences, such as which fields appear in the List View and how those 
fields are initially sorted. 

Choose the 
style you 
want to 
modify

Select the 
Calendar 
View you 
want to 
modify

Click to 
create a new 
tab style

Displays the 
layout of the 
Calendar 
View you’re 
modifying

Select the 
area of the 
Calendar 
View you 
want to 
modify

Change these 
settings to 
modify the 
appearance 
of Events on 
the tab

Change 
these 
settings to 
modify the 
background 
of the areas 
on the tab
94 Chapter 4



Chapter 4

To create an Address Book tab style:
1. Open the Address Book. From the Tabs menu, select Tab Settings.

The Address Book Tab Settings dialog box appears.

You can open the Address Book Setting dialog box by right-clicking any 
existing tab, then selecting Tab Settings from the shortcut menu that 
appears.

2. Click Edit Styles. Then, on the Address Book Styles dialog box, click New. 
Type a name for the new style in the New Style box and click OK.

You are returned to the Address Book Styles dialog box.

3. In the Horizontal and Vertical boxes, select the style of the lines appearing in 
the List View. 

4. In the Display options, click Heading Font and Field Font to select font types 
and font styles for the headings and field text in the List View.

Select a 
style from 
the drop-
down list

Change the 
appearance 
of the grid 
lines in the 
List View

Choose how 
Contacts 
appear on 
the tab

Click to create a new Address Book tab style
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5. Click OK to finish selecting font information, then click OK on the Address Book 
Styles dialog box.

See the following section for details on how to assign styles to Address Book tabs.

Assigning Tab Styles
If you want to change the appearance of a Calendar or Address Book tab, then 
assign it a different tab style.

To assign styles to tabs:
1. Click the label of the tab to bring it to the front.

2. From the Tabs menu, select Tab Settings.

The Calendar Tab Settings or Address Book Tab Settings dialog box appears.

3. From the Style Name list, select a new style.

4. Click OK.

The tab’s appearance changes to reflect the new style.

Assigning Categories to Tabs
You can determine which categories appear on Calendar and Address Book tabs.

To assign a category to a tab:
1. Click the label of the tab to bring it forward. Then, from the Tabs menu, select 

Tab Settings.

The Calendar Tab Settings or Address Book Tab Settings dialog box appears. A 
check appears next to each category displayed on the tab.

2. In the Categories box, click the plus sign next to the server containing the 
category you want to assign to the tab. 

Categories 
appearing on 
this tab are 
checked
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3. Click the box next to the category you want to include on the tab. 

A check appears next to the category you selected.

4. Click OK.

The items associated with the category you select appear on the tab.

Adding Shortcuts
Shortcuts give you quick, one-click access to Eudora Planner plugins and other 
applications on your computer. The shortcuts appear in the movable shortcuts bar in 
the Eudora Planner window.

You can add a shortcut to any Windows program or file.

To add a shortcut:
1. From the View menu, select Add Shortcut.

The New Shortcut dialog box appears.

2. If you’re creating a shortcut to a Web site, type the site’s URL. If you’re creating 
a shortcut to a file, type the file’s path name or click Browse to open the Open 
dialog box.

If you clicked Browse, go to Step 3; otherwise, go to Step 4.

3. In the Open dialog box, navigate to the file for which you want to create the 
shortcut, then click Open.

4. Click OK.

The shortcut is saved and appears in Eudora Planner.

Enter the 
name of 
shortcut here

Click to browse for an application or document 
for which you want to create a shortcut
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To rename a shortcut:
1. From the View menu, select Organize Shortcuts. 

The Organize Shortcuts dialog box appears.

2. Right-click the shortcut you want to rename, then select Rename from the 
menu that appears.

3. Type a new name for the shortcut.

4. Click Close. 

The new name appears in the shortcuts bar.

To delete a shortcut:
1. From the View menu, select Organize Shortcuts.

The Organize Shortcuts dialog box appears.

2. Select the shortcut you want to delete, then press the Delete key.

The shortcut is deleted from Eudora Planner.
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Printing in Eudora Planner
Eudora Planner lets you print your Calendar and Address Book information to a 
variety of formats, including organizers, mailing labels, and envelopes. Maintaining 
an appointment book or personal directory is as simple as printing pages from 
Eudora Planner.

This chapter describes how to print your Eudora Planner information in a variety of 
formats, how to create printouts from your Event and Contact information, and how 
to save time and ensure a consistent style and format by storing and reusing your 
print settings.

Selecting Print Settings
Eudora Planner lets you choose and save printing options specific to both the 
Calendar and Address Book. When you select the Print command from the File 
menu or toolbar, Eudora Planner displays a Print dialog box specific to either the 
Calendar or Address Book—depending on whichever is currently active. There, you 
can choose the format to which you want to print, as well as the contents of the print 
job.

If your printer supports it, you can print Eudora Planner information on both sides of 
the page. Or, you can print two pages of information on a single page, then fold it in 
half to include in an address, telephone or appointment book. Eudora Planner can 
print some appointment book formats as Folding pages.

After you select your printing settings, you can name and save them for reuse when 
you print again. To learn how to save your printing settings, see “Saving Print 
Templates” on page 106.
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Printing from the Eudora Planner Calendar
Whether you need to print pages for a personal appointment book or a simple 
calendar to be posted on a bulletin board, Eudora Planner provides many ways to 
print the information contained in your Calendar. You can print any of the Calendar 
views, including the To-Do List. You can print your Calendar, To-Do lists, and other 
Event information on standard-sized paper or pages that fit into many popular 
appointment books. Eudora Planner provides many different formats.

The following table describes the general options available in the Print dialog box 
when you print Calendar information:

Use this option To...

Style/Paper Select the layout of the calendar and the type paper to be used. You 
can choose a Paper option that allows you to print directly to 
formatted sheets that are inserted into a personal organizer.

Header/Footer Add a custom header and footer to the printout and select a color for 
each.

Options Select options to have additional Event information, such as notes, 
appear in your printouts. The settings available here vary according 
to the Calendar view and style you’ve selected.

Range Select the range of Events to print. You can select a general time 
interval from the General drop-down list, or use the Custom option to 
select Events ranging between any two specific dates.

Other options are available depending on the calendar view you have chosen. To 
learn what each option does, consult the online Help.
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To print a calendar:
1. From the File menu, select Print to open the Print dialog box. Then, in the Type 

area, select Day, Week, or Month, depending on the Calendar view you want to 
print.

2. Click Style/Paper to open the Style and Paper Selector dialog box. From the 
Style drop-down list, select the layout of the printout. From the Paper drop-
down list, select the type of paper to which you are printing.

3. If you want to add a header or footer to each page of the printout, click Header/
Footer to open the Header/Footer Information dialog box. Enter a header and 
footer into the appropriate boxes and, if necessary, select colors for each. Then, 
click OK.

4. Click Options, then select the appropriate settings in the Style Options dialog 
box.

5. If necessary, choose from among the following printing options:

• Select Selection Only to print only those Events you’ve selected on the 
current Tab.

• Select Leave room for holes to have the printout contain margins in which 
you can punch holes.

• Select Print empty pages to print calendar pages for months, weeks, or days 
containing no Events.

6. Use the Range options to select the range of Events you want to print.

If you want to use the settings you’ve chosen in steps 1 through 5 for 
future printouts, you can save them as print template. For more 
information on print templates, see “Using Print Templates” on page 105.

7. Click Print.

Your Event information is printed according to the print settings you’ve 
specified.
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Printing Contact Information
You can specify how Eudora Planner prints your Contact information by entering 
your preferences on the Print dialog box. 

After you select the type of printout you want—Address Book/Phone Book, 
Envelopes, or Labels/Cards—you can specify the following settings:

Use this option To...

Style/Paper Select the style of address book, telephone book, envelope, label, or 
cards to print as well as a paper, envelope, or label size.

Range Select the range of Contacts to print. You can select all Contacts or 
select Contacts under a single letter of the alphabet from the 
General list. From the Custom list, you can select Contacts within the 
range of any two letters of the alphabet.

Header/Footer Add a custom header and footer to the printout and choose a color 
for each.

Font Select the font, font style, and font size that will appear on the 
printout.

Options Select options for printing lines in listings, envelopes, you can enter a 
return address. Through Styles Options, specify color and style 
options for printed Contact lists.

Other options are available depending on whether you are printing listings, 
envelopes or labels from the Address Book. To learn what each option does, 
consult the online Help.
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To print an address book:
1. From the File menu, select Print to open the Print dialog box. Then, in the Type 

area, select Address/Phone Books.

2. Click Style/Paper to open the Style and Paper Selector dialog box. From the 
Style drop-down list, select the layout of the address book printout. From the 
Paper drop-down list, select the type of paper to which you want to print. Then, 
click OK. 

3. If you want to add a header or footer to each page of the printout, click Header/
Footer to open the Header/Footer Information dialog box. Enter a header and 
footer into the appropriate boxes and, if necessary, select colors for each. Then, 
click OK.

4. Click Options, then select the appropriate settings in the Style Options dialog 
box.

5. If necessary, choose from among the following printing options:

• Select Selection Only to print only those Contacts you’ve selected in the 
current Tab.

• Select Leave room for holes to have the printout contain margins in which 
you can punch holes.

• Select Print empty pages to print empty address book pages for letters of the 
alphabet that have no Contacts associated with them.

• Select Fill page with Contacts to fit as many Contacts as possible onto a 
page, rather than separating them alphabetically by page.

6. Use the Range options to select the range of Contacts you want to print.

If you want to use the settings you’ve chosen in steps 1 through 5 for 
future printouts, you can save them as a print template. For more 
information on print templates, see “Using Print Templates” on page 105.

7. Click Print.

Your Contact information is printed in the address book format you’ve chosen 
according to the settings you’ve specified.

Printing Envelopes
Eudora Planner lets you print the work address of the Contacts you select, unless 
you specify in the Style Options dialog box that it print the home address.

To print an envelope:
1. From the File menu, select Print to open the Print dialog box. Then, in the Type 

area, select Envelopes. 

2. Click Style/Paper to open the Style and Paper Selector dialog box. From the 
Style drop-down list, select the layout of the envelope printout. From the Paper 
drop-down list, select the type of envelope you will be inserting into the printer. 
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Then, click OK.

3. Click Options, then select the appropriate settings in Style Options dialog box.

4. Select Selection only if you want to print only those Contacts you’ve selected 
on the current Tab.

5. Use the Range options to select the range of Contacts you want to print.

If you want to use the settings you’ve chosen in steps 1 through 5 for 
future printouts, you can save them as print template. For more 
information on print templates, see “Using Print Templates” on page 105.

6. Click Print.

Your Contact information is printed to envelopes according to the print settings 
you’ve specified.

Printing Labels
Eudora Planner lets you print your Contact information to a variety of label formats. 

To print a set of mailing labels:
1. From the File menu, select Print to open the Print dialog box. Then, in the Type 

area, select Labels.

2. Click Style/Paper to open the Style and Paper Selector dialog box. From the 
Style drop-down list, select how you want the information to be laid out on each 
label. From the Paper drop-down list, select the label format to which you are 
printing. Then, click OK.

3. Click Options, then select the appropriate settings in Style Options dialog box.

4. Select Selection Only to print only those Contacts you’ve selected on the 
current Tab.

5. To determine how many copies of labels you want to print, enter a value into 
Copies of each label box. To determine where on the label sheet the first label 
should print, enter the appropriate values into the Column and Row boxes.

6. Use the Range options to select the range of Contacts you want to print.

If you want to use the settings you’ve chosen in steps 1 through 5 for 
future printouts, you can save them as print template. For more 
information on print templates, see “Using Print Templates” on page 105.

7. Click Print.

Your Contact information is printed to labels according to the print settings 
you’ve specified.
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Previewing Your Printouts
After you select the kind of output you want, Eudora Planner lets you preview your 
work. If you are happy with the appearance of your printed information, you can 
proceed to print using your default printer.

To preview a printout:
1. In the view you want to print, from the File menu, choose Print.

The Print dialog box appears.

2. If you are printing Event information, click Day View, Week View or Month 
View. If your are printing Contact information, click Address/Phone Book, 
Envelopes or Labels.

3. Select new print settings, or select your previously saved settings.

If you want to restore saved printing settings, see “Printing from a Print 
Template” on page 106.

4. To see how the your printout will appear, click Preview. If further changes are 
required, click Close, then make further changes on the Print dialog box, and 
preview again if desired.

5. Click Print.

Eudora Planner prints your previewed pages using the default printer.

Using Print Templates
If you want to maintain a consistent appearance for your Eudora Planner printouts, 
or save time when you print new versions of your Event and Contact information, 
you can name and store print templates in your Eudora Planner database.

When you choose a saved print template, Eudora Planner displays all of its style and 
formatting information on the Print dialog box.
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Saving Print Templates
If you want to reuse your printing settings, you can save them as a named template. 
After you save the template, you can have Eudora Planner reuse it when you want 
to print other Event and Contact information.

To save a print template:
1. On the Print dialog box, after you specify your desired print options, click Save 

As.

The Save Template dialog box appears. 

2. Type a name for the setting in the box.

3. Click OK.

Eudora Planner saves the template in your database. To learn how to restore 
your saved settings, see the next section.

Printing from a Print Template
If you saved printing settings, you can restore them to the Print dialog box by 
selecting them from a list.

To restore calendar printing settings:
1. From the File menu, choose Print.

The Print dialog box appears.

2. Click Restore Settings.

The Restore Settings dialog box appears.

3. In the Choose Name of Setting to Restore list, select the name of the setting 
you want to use. Click Restore Settings.

Eudora Planner restores your settings on the Print dialog box.
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Sample Printouts
The following samples are provided to give you a sense of the kind of paper 
calendars and address books you can create with Eudora Planner. All of the 
samples here can be created using a standard laser printer and 8.5x11” paper.

Month View Calendar

Week View Calendar
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Day View Calendar

Address Book
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QuickAccess
Now Eudora Planner’s QuickAccess features give you the ability to quickly and 
easily view, enter, and edit Calendar and Address Book information without starting 
Eudora Planner. This chapter explains how to:

• Check your day’s schedule and create or modify Events using QuickDay
• View, dial, e-mail, and create Contacts using QuickContact
• Create Events using QuickPad

Starting QuickAccess
The three components of QuickAccess—QuickDay, QuickContact, and QuickPad—
appear as icons on the Windows taskbar. If, during Eudora Planner setup, you 
chose not to have QuickAccess load at startup, you can start it anytime.

To start QuickAccess:
1. On the Windows taskbar, select Start.

2. From the Start menu, select Programs, then select QUALCOMM from the 
submenu that appears.

3. From the QUALCOMM submenu, select Eudora Planner QuickAccess.

The QuickAccess icons appear on the taskbar. You can activate QuickDay, 
QuickContact and QuickPad by clicking their respective icons.

Click to bring up QuickDay

Click to bring up QuickContact

Click to bring up QuickPad
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Using QuickDay
You don’t need to start Eudora Planner in order to see your day’s schedule. 
QuickDay gives you the convenience of viewing today’s—or any day’s—activities 
without having to open your Calendar. Each of your Calendar Events appear in 
QuickDay and can be opened simply by double-clicking. You can also use QuickDay 
to create new Events, attach reminders, documents, or Contacts to Events, and 
modify any attributes of an existing Event. Any changes or additions you make in 
QuickDay are saved in your Eudora Planner Calendar as well.

Viewing Events in QuickDay
You can use QuickDay to see any day’s schedule in your Eudora Planner Calendar.

To view Events in QuickDay:
1. Click the QuickDay icon on the taskbar.

The QuickDay window appears, listing the current day’s Events.

2. Double-click an Event in the list to see its details.

The Event Details dialog box appears.

You can open in Event in QuickDay by right-clicking it, then select Details 
from the shortcut menu that appears.

3. Click OK to return to the QuickDay dialog box.

4. Use the navigation buttons to move through your Calendar. Click the right arrow 
to view future Events; Click the left arrow to view past Events.

QuickDay moves forward or backward a day at a time, depending on which 
arrow you click. 

Click here to 
create a new 
To-Do

Click here to create a 
new Call

Click here to create a new Meeting
Click here to create a new Contact

Select to have 
QuickDay 
always appear 
on top of active 
windows

Use navigation 
buttons to move 
forward and 
backward 
through your 
Calendar
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5. Click the Pick a date button if you want to view Events for a particular date.

A month-view calendar appears, from which you can select a date. If you need 
to select a different month, click the arrows. When you click a specific date, the 
month-view calendar closes and QuickDay displays the Events for the date 
you’ve chosen.

6. Click the Close button when you finish viewing your Events.

Creating Events in QuickDay
Any Events you create in QuickDay are saved immediately to Eudora Planner, and 
will appear in your Calendar the next time you open it.

To create an Event in QuickDay:
1. Click the QuickDay icon in the taskbar.

The QuickDay window appears.

2. At the top of the QuickDay window, click the button for the Event type you want 
to create.

An Event Details dialog box appears.

3. Add the appropriate information to this Event. For details on creating Events, 
see “Adding Events to the Calendar” on page 22.

4. Click OK.

You’re returned to the QuickDay window. The Event is saved to your Calendar 
and shows in QuickDay on the appropriate day.

Modifying an Event in QuickDay
You can use QuickDay to modify an existing Event in your Calendar.

To modify an existing Event in QuickDay:
1. In the QuickDay window, double-click the Event you want to modify.

The Event Details dialog box for that Event appears.

2. Make any changes you want to the Event.

For example, you may want to change the starting time of a Meeting, attach a 
document to a Call, or mark a To-Do as “Complete.”

3. Click OK.

You’re returned to the QuickDay window. The changes you’ve made are saved 
to your Calendar and also appear in QuickDay.
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Creating Contacts in QuickDay
You can even use QuickDay to create Contacts for your Address Book.

To create a Contact in QuickDay:
1. In the QuickDay window, click the New Contact button.

The Contact Details dialog box appears.

2. In the Contact Details dialog box, enter any information appropriate for the 
Contact.

For details on creating Contacts, see “Creating Contacts” on page 55.

3. Click OK.

You’re returned to the QuickDay window. The new Contact is saved to your 
Address Book. 

Using QuickContact
You don’t need to have Eudora Planner open to have complete access to the 
Contacts in your Address Book. QuickContact lets you quickly see a list of all your 
Contacts, find and view those Contacts that are most important to you, dial and e-
mail the people and organizations in your Address Book, and create new 
Contacts—all without starting Eudora Planner.

Viewing Contacts with QuickContact
QuickContact lets you see a list of all the Contacts in your Address Book, regardless 
of which server they reside on or the Categories assigned to them. To display a list 
of your Contacts, select the All Contacts option in the QuickContact dialog box. A 
list of all the people and organizations in your Address Book appears alphabetically 
by the first name in the primary field you’ve selected for each Contact (for details on 
setting primary fields, see “Selecting Primary Fields” on page 65). You can double-
click a Contact in the list to open its details dialog box.

Click to call the selected Contact

Click to create a new To-Do

Click to create a new Call Event

Click to create a new Meeting

Click to create a new Contact

Click to e-mail the selected Contact

Click to have QuickContact always 
appear on top of any active 
window
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You can also create a select list of Quick Contacts for those Contacts you 
communicate with most frequently. When you select Quick Contacts in the 
QuickContact dialog box, only these Contacts appear, letting you quickly locate the 
Contact you need.

Making a Contact a Quick Contact
You can specify which Contacts are Quick Contacts by making a simple selection in 
the Contact Details dialog box.

To make a Contact a Quick Contact:
1. In the Address Book, double-click the Contact you want to add to QuickContact.

The Contact Details dialog box appears.

2. In the Contact Details dialog box, select the QuickContact check box.

3. Click OK to close the Contact.

You’re returned to the QuickContact dialog box. The Contact is added to 
QuickContact.

Creating Contacts with QuickContact
With QuickContact, you can create new Contacts on the fly, without having to open 
your Address Book.

To create a Contact with QuickContact:
1. Click the Create a new Contact button in the QuickContact window.

The Contact Details dialog box appears.

2. In the Contact Details dialog box, enter any information appropriate for the 
Contact. 

For information on creating Contacts, see “Creating Contacts” on page 55.

3. Click OK.

You’re returned to the QuickContact window. Your Contact is saved to the 
Address Book. 

Finding Contacts with QuickContact
You can use QuickContact to search for Contacts in your Address Book. Once 
QuickContact has found a Contact, you can perform any operation on it, including 
dialing, sending e-mail, or opening its Details dialog box. Any changes you make to 
the Contact will be saved to your Address Book.

To find a Contact using QuickContact:
1. In the QuickContact dialog box, select Search.

2. In the Search box, start typing the name or company name of the Contact you 
are looking for. 
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As you type, QuickContact searches the Address Book for names and company 
names that match the text you are typing. Matching names appear in the 
QuickContact list.

3. From the list of found Contacts, select the one you searched for. 

You can dial or e-mail the Contact, or open it’s Details dialog box to make 
modifications.

Dialing Contacts in QuickContact
QuickContact lets you dial Contacts in your Address Book without having to open 
Eudora Planner.

To dial a Contact from QuickContact:
1. Select a Contact in the QuickContact window.

The telephone number that appears is the primary phone number you set in the 
Contact Details dialog box. See “Selecting Primary Fields” on page 65, for more 
details.

You can initiate a phone call to a Contact in QuickContact by right-clicking 
that Contact, then selecting Dial Phone from the shortcut menu that 
appears.

2. Click Dial.

The Call Details dialog box appears containing phone information for the 
Contact you want to dial.

3. Click Dial Phone.

Your modem dials the number, and a Call Status dialog box appears.

4. Pick up your phone’s receiver, then click Talk and wait for the party you’ve 
dialed to answer.

If, before you pick up the receiver, you decide not to complete the call, click 
Hang Up to clear your modem and terminate the call.

E-mailing Contacts in QuickContact
With QuickContact, you can send e-mail to any Contact without opening your 
Address Book.

To e-mail a Contact from QuickContact:
1. In the QuickContact window, select the Contact you want to e-mail.

You can send an e-mail to a Contact in QuickContact by right-clicking that 
Contact, then selecting Send E-mail from the shortcut menu that 
appears.

2. Click the Send e-mail to selected Contacts button.
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Creating Events with QuickContact
QuickContact lets you create Meetings, To-Dos, and Calls without having to open 
your Calendar. With a simple right-click, you can also create Events that attach 
automatically to your Contacts.

To create Events with QuickContact:
1. At the top of the QuickContact window, click the button for the Event type you 

want to create.

An Event Details dialog box appears.

2. Add the appropriate information to this Event. 

For details on creating Events, see “Adding Events to the Calendar” on page 
22.

3. Click OK.

You’re returned to the QuickContact window and the Event is saved to your 
Calendar.

To create an Event that attaches automatically to a Contact:
1. Right-click the Contact to which you want to attach the Event.

A shortcut menu appears.

2. From the shortcut menu, select the type of Event you want to attach to the 
Contact.

An Event Details dialog box for the type of Event you’ve selected appears.

3. Enter the appropriate information for the Event. For details on how to create 
Events, see “Adding Events to the Calendar” on page 22. 

4. Once you’ve entered the information, click OK.

The Event is saved to your Calendar, and also appears in the Contact’s History 
list.

Using QuickPad
QuickPad is a convenient taskbar menu that lets you create To-Dos, Calls, Meetings, 
and Contacts on the fly.

To create an Event or Contact using QuickPad:
1. Click the QuickPad icon on the taskbar.

A pop-up menu appears.

2. From the pop-up menu, select the Event type you want to create or select New 
Contact. 
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An Event or Contact Details dialog box appears, or, if you selected Meeting 
Wizard from the pop-up menu, then the Meeting Wizard appears.

3. In the Event or Contact Details dialog box, add any appropriate information.

For information on creating Events, see “Adding Events to the Calendar” on 
page 22. For information on creating Contacts, see “Creating Contacts” on 
page 55.

4. Click OK to close the Event or Contact.

The item is saved to your Eudora Planner Calendar or Address Book.

Setting QuickAccess Preferences
Eudora Planner lets you choose which of the three QuickAccess icons appear on 
the Windows taskbar. You can also select the default Categories for any Contacts 
and Events you create with a QuickAccess component.

To display or hide a QuickAccess icon:
1. Right-click one of the QuickAccess icons on the taskbar.

A pop-up menu appears.

2. From the pop-up menu, select Preferences.

The QuickAccess Preferences dialog box appears.

3. Check the QuickAccess components that you want to appear on the taskbar. 
Uncheck those you don’t want to appear.

4. Click OK. 

Your preferences settings are saved. Only those QuickAccess components 
you’ve selected appear in the taskbar.
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To select default Categories for Contacts you create with QuickAccess:
1. Right-click one of the QuickAccess components on the taskbar.

A pop-up menu appears.

2. From the pop-up menu, select Preferences.

The QuickAccess Preferences dialog box appears.

3. To select a default Category for Contacts, click the arrow in the Default Contact 
Category box, then choose a Category from the drop-down list that appears. 

4. To select a default Category for Events, click the arrow in the Default Event 
Category box, then choose a Category from the drop-down list that appears.

5. Click OK.

The Categories you’ve selected are the defaults for Contacts and Events you 
create with any QuickAccess component.

Starting Eudora Planner from QuickAccess
With one click, you can use QuickAccess to start Eudora Planner from the taskbar. 
Right-click any of the QuickAccess icons on the taskbar, then select Start Eudora 
Planner from the shortcut menu that appears.

Closing QuickAccess
It’s easy to close QuickAccess if you no longer want it to appear on your taskbar.

To close QuickAccess:
1. On the taskbar, right-click one of the QuickAccess icons.

A pop-up menu appears.

2. From the pop-up menu, select Close QuickAccess.

The QuickAccess icons disappear from the taskbar, indicating that 
QuickAccess is no longer running.

Click to select a default Contact Category from the drop-down list

Click to select a default Event Category from the drop-down list
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Using Eudora Group Planner
Eudora Group Planner is a workgroup version of Eudora Planner that lets you share 
Calendar and Address Book information, coordinate meetings and office resources 
with co-workers, and view the schedules of other users. This chapter describes 
Eudora Group Planner, including how to

• Log in to a Eudora Group Planner server and select a server to track your 
available time for group scheduling

• View and create Events and Contacts that are shared among users in your 
workgroup

• Schedule meetings with your co-workers

• Understand your permissions for a workgroup server and protect your shared 
Events and Contacts using Eudora Group Planner’s security features

Using Eudora Planner in a Workgroup
Before you can begin to share Calendar and Address Book information and 
schedule meetings with other Eudora Planner users, you must first connect to a 
workgroup server. Your Eudora Planner administrator creates the workgroup server 
and determines the level of access granted to you and other users. There can be 
one or more workgroup servers available on your network, each containing such 
information as

• User names, passwords, and information about users’ access permissions

• Information necessary for scheduling meetings, such as conference rooms, 
meeting resources, and a running log of other users’ availability

• Public categories for use in sharing Events and Contacts

When you connect to a workgroup server, you can subscribe to categories of Events 
and Contacts that reside on that server. Categories residing on a workgroup server 
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are referred to in Eudora Planner as public categories. You can create new public 
categories on a workgroup server if you have been given permission to do so. Other 
users connected to the same server and granted the proper permissions can view 
and add information to the public categories you create.

The Eudora Group Planner Administrator
In your workgroup, there should be an individual who serves as the Eudora Planner 
administrator. This person should be familiar enough with your organization’s 
structure, computers, and network to effectively install and maintain the Eudora 
Planner servers, as well as to set up each Eudora Planner user, or group of users, 
with access permissions that are appropriate to their role in your organization.

The Eudora Planner administrator can more easily manage the access permissions 
of similar individual users by putting those users into groups. As a Eudora Planner 
user, you should be aware of any groups to which you are assigned, because 
access permissions assigned to those groups affect your individual security profile. 
See “Knowing Your Security Permissions for a Workgroup Server” on page 135 for 
more information.

The steps involved in setting up a Eudora Group Planner installation are discussed 
in the Eudora Group Planner Administrator’s Guide, which is included with the 
Eudora Group Planner software package. This book also describes the issues 
related to administering a group of Eudora Group Planner users.

See your Eudora Planner administrator for information on which workgroup servers 
you can access and the permissions you will have for data on those servers.

Logging in to a Workgroup Server
The first step in sharing Events and Contacts with other Eudora Planner users is to 
log in to a workgroup server. Eudora Planner’s Server Wizard makes it easy to log in 
to a workgroup server by guiding you through the connection process.

To log in to a workgroup server, you must know either the server’s IP address, fully-
qualified domain name, or Windows computer name. You must also know your own 
user name and password (if any) for that server. Contact your Eudora Planner 
administrator if you are unsure how to identify a workgroup server or if you don’t 
know your user information.
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To log in to a workgroup server:
1. From the Tools menu, select Servers.

The Servers dialog box appears.

2. In the Servers dialog box, double-click Add Server.

The Server Wizard appears.

3. Follow the Wizard’s instructions to connect to a server.

When finished, you are logged in to the Eudora Planner workgroup server and 
can view and create Events, Contacts, categories and custom fields for this 
server, if the Eudora Planner administrator has granted you permissions to do 
so. If you’ve chosen to make this server your home server, it now tracks the 
times you’re available or unavailable for group scheduling.

Selecting a Home Server
To use Eudora Planner for group scheduling, you must select a home server from 
the workgroup servers available on your network. The home server tracks your busy 
time—the time in your schedule already occupied by Events—and displays that 
information to other Eudora Planner users when they invite you to meetings. For 
more information about busy time, see “Showing Your Time as Busy” on page 132.

Double-clicking 
this activates the 
Server Wizard

This icon indicates 
that a server is 
the home server
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If there is only one Eudora Planner server on your network, you must still designate 
it as your home server. However, if there are multiple Eudora Planner servers 
available, you should consult your Eudora Planner administrator before selecting 
one as a home server.

Eudora Planner’s Server Wizard prompts you to select a workgroup server as your 
home server when you initially log in to that server, but you can always change your 
home server.

To change your home server:
1. From the Tools menu, select Servers.

The Servers dialog box appears, displaying a list of servers to which you are 
connected.

2. Double-click the server you want to be your home server.

The Server Properties dialog box appears.

3. In the General tab, select Home Server. 

4. Click OK. 

The server you select becomes your home server and records your meeting 
availability.

In the Servers dialog box, you can right-click the server you want to make the home 
server, then select Home Server from the shortcut menu that appears.

Setting Server Update Preferences
Eudora Planner lets you specify how often your database receives updated 
information from a workgroup server. You can also force your database to receive an 
immediate update from a workgroup server at any time.

To set the server update frequency:
1. From the Tools menu, select Servers.

The Servers dialog box appears, listing all the servers to which you are 
connected.

When selected, 
indicates this is 
your home 
server
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2. Double-click the server for which you wish to change the update frequency.

The Server Properties dialog box appears.

You can right-click the icon for the server, then select Properties from the 
shortcut menu that appears.

3. Click the Update tab.

4. In the Update Frequency box, type the time interval between updates from the 
server.

5. Click OK.

Your Eudora Planner database will receive updates from the workgroup server 
at the interval you’ve specified.

To force an immediate update from the server:
1. From the Tools menu, select Servers.

The Servers dialog box appears, listing all the servers to which you are 
connected.

2. Double-click the server from which you want an update.

The Server Properties dialog box appears.

3. Click Update Now.

The server immediately updates your Eudora Planner database with any 
changes or additions that other users have made since your last update.

You can force an update from a server by right-clicking the server’s icon in the 
Servers dialog box, then selecting Update Now from the shortcut menu that 
appears.

Sharing Eudora Planner Information with Others
Whether your workgroup consists of your whole company, one department, or just 
you and your assistant, the ability to distribute accurate scheduling and contact 
information may be vital to the efficiency of your organization. Eudora Group 
Planner lets you and your co-workers keep each other informed about events, 
personal and departmental calendars, and data concerning important customers 
and clients.

This section describes how to view other users’ shared Events and Contacts and 
how to share the items you create. It also explains how to create public categories 
and custom fields.
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Viewing and Creating Shared Events and Contacts
To view the Events and Contacts that other users add to a Eudora Group Planner 
server, you must create a tab that subscribes to public categories residing on that 
server. Also, if you configure the tab to have one of those public categories as its 
default category, then you can also use the tab to conveniently create your own 
shared Events and Contacts. Any Event or Contact created on such a tab 
automatically acquires that public category as its primary category, and is therefore 
shared with other users connected to the server containing that category.

To add Events and Contacts to a workgroup server, you must have Create 
permission for that server. Consult your Eudora Planner administrator to determine 
if you have this permission for Events and Contacts.

To create a tab on which you can view and create shared Events and Contacts:
1. In either the Calendar or Address Book, select Add New Tab from the Tabs 

menu.

The Tab Settings dialog box appears. Although the pictures below are specific 
to creating Calendar tabs, you can use this procedure to add public categories 
to an Address Book tab as well. For more details on configuring tabs, see 
“Creating Calendar Tabs” on page 89 and “Creating Address Book Tabs” on 
page 91. 

2. In the Tab Name field, enter a name for the tab.
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3. In the Categories area, select a workgroup server. Then, select the public 
categories you want to appear on the tab. If necessary, select a default category 
from the Category for new Events or Category for new Contacts drop-down 
list. The default should be a public category if you plan to use this tab to create 
shared Events or Contacts.

4. Select a default category from the Category for new Events or Category for 
new Contacts drop-down list.

5. Click OK.

The tab appears in your Calendar or Address Book view and displays items in 
the public categories you selected. 

Any Event or Contact you create on this tab acquires the tab’s default category as its 
primary category. For information on how to change the primary category of an 
Event or Contact, see “Changing the Primary Category” on page 87.

Select a workgroup 
server

Public categories 
appearing on the tab 
are selected

From the drop-down list, you can select a public 
category to be the default category for items 
created on this tab

Tab containing public 
categories appears in view

Shared items appear in tab
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Sharing Existing Events and Contacts
Even if an existing Event or Contact is presently residing on a tab that contains no 
public categories, you can still share it with your workgroup. 

To share an existing Event or Contact:
1. Double-click the Event or Contact to open its Details dialog box.

2. Select the Shared check box.

3. Click the Categories button.

The Assign Categories dialog box appears. In this dialog box, public category 
names are followed by names of the servers they reside on, which appear in 
parentheses.

4. Select the public categories you want to assign to this Event or Contact. If 
necessary, select a primary category for the item.

5. Click OK.

The Event or Contact is assigned the public category and becomes available to 
other users subscribing to that category.

To share multiple Contacts or move multiple shared Contacts from one server to another:
1. In the List View, select the Contacts you want to share.

2. From the Edit menu, select Sharing.

The Contact Sharing dialog box appears.

3. Click the arrow to select the server to which you want to move the Contacts.

The Contacts are moved to the server you’ve selected and become available to 
other users logged in to that server. If you’re moving personal Contacts to a 
server, then the primary categories of those Contacts will be created on the 
server to which you’re moving the Contacts. 
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Creating Categories for a Workgroup Server
A Eudora Group Planner server usually contains a number of categories installed 
with the program, plus any categories created by the Eudora Planner administrator 
and other users. If you find that none of these categories suit your needs, you can 
create your own public categories to reside on that server. These categories can be 
used by any Eudora Planner users with permissions to create Events and Contacts 
on that server.

To create a category for a workgroup server, you must have Create permission for 
that server. Consult your Eudora Planner administrator to determine if you have this 
permission for categories.

To create a category for a workgroup server:
1. From the Tools menu, select Categories.

The Categories dialog box appears.

2. Click the arrow in the Server box.

A drop-down list of available servers appears.

3. From the drop-down list, select the server to which you want to add the 
category.

4. Click the New button.

The Category Properties dialog box appears.

5. Type a name for the category in the Name box.

6. Change the font and background color, if necessary.

7. Click OK.
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The category is added to the workgroup server and appears in the Categories 
dialog box when you select that server from the Server drop-down list. 

The category also appears in the Assign Categories dialog box, which appears 
when you click the Categories button in the Event or Contact Details dialog 
box.

In order for public categories to appear in the Assign Categories dialog box, you 
must select the Shared option in the Event or Contact Details dialog box before you 
click the Categories button, as described in the previous section, “Sharing Existing 
Events and Contacts” on page 126.

Creating Custom Fields for a Workgroup Server
You can make a custom field available to other Eudora Planner users by placing it 
on a workgroup server. The custom field appears in any Contacts that have been 
assigned categories that reside on that server.

To create a custom field for a workgroup server:
1. From the Tools menu, select Custom Fields.
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The Custom Fields dialog box appears.

2. Click the arrow in the Server box.

A drop-down list of available servers appears.

3. From the drop-down list, select the server to which you want to add the custom 
field.

In order to create a custom field for a server, you must have Create 
permission for that server. Consult your server administrator to determine 
if you have this permission.

4. Click New.

The Custom Field Properties dialog box appears.

5. Type a name for the custom field in the Name box.

6. Select a field type for the custom field. For more information about field types, 
see “Using Custom Fields” on page 57.

7. Click OK to close the Custom Field Properties dialog box, then click OK to close 
the Custom Fields dialog box.

The custom field is saved to the workgroup server and appears in any Contact 
stored on that server.

Using Group Scheduling
Most meetings require coordinating people’s schedules with the availability of 
meeting rooms and office equipment. Eudora Planner’s group scheduling feature 
can track this information for you, making it easy to determine the best time for your 
meeting. Then, when you invite other users to attend, Eudora Planner notifies them, 
allowing them to confirm or decline your invitation.

The first step in group scheduling is to create a Meeting Event. For details, see 
“Using Meeting Events” on page 23. Once you’ve created a Meeting, continue with 
the following section to add group scheduling information to that Event. 
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Scheduling Users, Rooms, and Resources for Meetings
Eudora Planner’s group scheduling feature lets you use Meeting Events to 
determine the availability of users and resources, send a network invitation to 
meeting invitees, and reserve a conference room.

To schedule users, rooms, and resources for a Meeting:
1. Double-click the Meeting Event to open the Meeting Details dialog box. Then, 

click the Group Scheduling tab.

You can open a Meeting by right-clicking it in any Calendar View, then 
selecting Details from the shortcut menu that appears.

2. Click the Invite Others button. 

Your name 
automatically 
appears in the 
invitee list 
when you create 
a Meeting

Thick bar indicates 
range of time for 
which Meeting is 
scheduled

Thin bar indicates 
your blocked time
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The Invitation List dialog box appears.

3. If you need to invite a someone other than a user or resource defined in Eudora 
planner, click the Find Method arrow. You can have it display all Eudora 
Planner users and resources, all Contacts or Quick Contacts in your Address 
Book, or specific Contacts you search for.

If you select Users, Rooms, etc., all Eudora Planner users and resource that 
are available to you are listed in the Matches list 

If you select the Find Contacts option, type the name of the Contact you are 
searching for into the Find What box. As you type, search results appear in the 
Matches list.

If you select Quick Contacts or All Contacts, all Contacts or Quick Contacts in 
your Address Book are listed in the Matches list.

4. To invite a user to the Meeting, select his or her name in the Matches list. Click 
the Required button if he or she is required to attend the Meeting; click the 
Optional button if his or her attendance is optional. 

5. Click Close to return to the Group Scheduling tab. 

The invitees appear in the invitation list along with time grids representing their 
schedules. Empty cells in the time grid indicate periods when a user is 
available. A yellow bar in the grid indicates a user’s busy time. The vertical bar 
spanning all invitees’ time grids shows the time range of the Meeting you’re 
scheduling.

If a user’s time grid indicates that another Event conflicts with the 
meeting you’re scheduling, you can view the conflicting Event by right-
clicking the yellow bar in the time grid, then selecting the Event name 
from the pop-up menu. The Details dialog box for the Event appears.

Drop-down list lets you 
choose invitees from 
users and resources 
available on the 
network or from 
Contacts in your 
Address Book

Typing here lets you 
locate invitees of the 
type you’ve selected 
above
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6. Check the invitation list to see if any of your invitees have Events scheduled that 
conflict with this meeting. If necessary, you can drag the time range for the 
Meeting (in green) to a time when more people or resources are available. Or, 
to have Eudora Planner find a better time for you, click Auto-Pick; Eudora 
Planner attempts to find the first block of time that is free for all the people and 
resources in the invitation list, using the duration selected in the Duration list.

7. On the Meeting tab, change the duration of the meeting in the Duration box, if 
necessary.

8. Click OK.

The Meeting is immediately sent to the workgroup server so that the invitees 
receive their Meeting invitations.

Showing Your Time as Busy
When you use Eudora Planner for group scheduling, you can make particular 
Events show your time as busy, so other users can know when you’re unavailable for 
meetings. When you accept a meeting invitation, Eudora Planner shows your time 
as busy during the time for which the meeting is scheduled. 

You can have any type of Event show your time as busy. To have an Event occupy 
your time, double-click the Event to open its Details dialog box, then click the Show 
Time as Busy checkbox. Then, click OK. When another user tries to invite you to a 
Meeting that runs concurrently with the Event, the user will see that you are 
unavailable at that time.

You can see the Events that occupy your time by creating a tab that shows only your 
busy time. For details, see “Creating Calendar Tabs” on page 89.

Using the Proxy Feature
Eudora Planner’s proxy feature lets you designate other user as your proxy. When 
you designate another user as your proxy, that user can answer meeting invitations 
on your behalf. The proxy feature is especially useful for a secretary or 
administrative assistant who is responsible for maintaining a manager’s schedule. 

To make another user your proxy:
1. From the Tools menu, select Users and Groups.

The Users and Groups dialog box appears.

2. Use the Server drop-down list to select the server for which you want to set a 
proxy.

3. In the Users and Groups list, select the entry for yourself, then click the 
Details button.

The User Properties dialog box appears.

4. Click the Proxies tab.
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5. In the All users list, click the user that you want to add as your proxy, then click 
the Add button to place that user in the Proxy users list. Repeat this step as 
necessary if you want to add additional proxies.

6. Click OK to close the User Properties dialog box.

7. Click OK again to close the Users and Groups dialog box.

The users you selected can now function as your proxy on the server you 
selected.

If you have administrative privileges, you can assign proxies for other users in this 
way. Just select the user you want to assign a proxy for in step 3.

To proxy for another user:
1. From the File menu, select Login.

The Eudora Planner Login dialog box appears.

2. Select the Act as someone else check box.

3. Use the Act as drop-down list to select the user for whom you are to act as a 
proxy.

4. Click OK.

The name of the user for whom you are proxying appears in the user name box 
in the bottom right corner of the Eudora Planner window. You can now create 
Events and answer meeting invitations on behalf of this user. When you’re 
finished, return to the Login dialog box as described in step 1 to log in as 
yourself again.

Understanding Eudora Planner’s Workgroup Security Features
Eudora Planner’s workgroup security features are designed to operate on three 
levels: that of the server, the user, and a particular Event or Contact. 

The permissions assigned at the server level are referred to in Eudora Planner as 
security permissions. Security permissions are granted to you by your Eudora 
Planner administrator and determine your general level of access to items on a 
workgroup server. The security permissions assigned to groups to which you belong 
also affect your access to a workgroup server. For more information on security 
permissions, see “Knowing Your Security Permissions for a Workgroup Server” on 
page 135.

Permissions assigned at the user level are referred to as privacy permissions. 
Privacy permissions are those permissions you grant to other users for your shared 
Events and Contacts. For information on privacy permissions, see “Setting Privacy 
Permissions” on page 138. 

Permissions assigned at the Event or Contact level are referred to as object 
permissions. Object permissions are those permissions you assign to other users 
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for a specific shared Event or Contact that you’ve created. For information on object 
permissions, see “Setting Object Permissions” on page 140. 

The three types of permissions affect you both as an individual user and as a 
member of a group. The following section explains how.

Users and Groups in Eudora Planner
Before you can log in to a particular workgroup server, your Eudora Planner 
administrator must create a user account for you on that server. This user account 
consists of your user name and login password, the groups to which you belong, 
and your security profile—that is, the permissions you have for accessing, altering, 
and creating information and resources on the server. The Server Wizard prompts 
you to enter your user name and password when you first log in to a Eudora Group 
Planner server, so you should obtain this information from your administrator before 
you attempt to connect. Once you’ve connected, you can view other information 
about your user account.

In addition to setting up users, your Eudora Planner administrator may also set up 
groups on the server in order to more easily manage users’ permissions. A group 
consists of a number of individual users on a server—usually a cluster of individuals 
who work in the same department or share the same level of managerial 
responsibility. Just as for a user, the Eudora Planner administrator also sets up a 
security profile for a group, granting it specific permissions for the server while 
denying it other permissions. The permissions for a group become part of the 
security profile of a user in that group, and in most cases take precedence over the 
individual user’s profile. For information on how a group membership affects a user’s 
security profile, see “Knowing Your Security Permissions for a Workgroup Server” 
on page 135.

To view the groups you belong to:
1. From the Tools menu, select Users and Groups.

The Users and Groups dialog box appears.
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2. Click the Server arrow to display a list of servers to which you are connected, 
then select the server containing your user information.

3. In the Users and Groups area, click the plus sign next to Users.

A list of the users contained on the server appears.

4. Select your name, then click Details.

The User Properties dialog box appears.

5. Click Groups.

The User Groups dialog box appears with your name in the User ID box. The 
Groups area shows you those groups on the server to which you belong.

You cannot add yourself to or remove yourself from any groups on a workgroup 
server, unless the Eudora Planner administrator has granted you Manage Users and 
Groups permission. Consult your Eudora Planner administrator if you want to 
change your group memberships.

Knowing Your Security Permissions for a Workgroup Server
The security permissions granted to you by the Eudora Planner administrator 
determine your level of access to information stored on a workgroup server. These 
permissions govern your ability to do routine tasks, like creating, deleting, and 
modifying Events and Contacts, or more complex operations, like administering 
some aspects of the workgroup server’s user and groups configuration. The Eudora 
Planner administrator can grant or deny you any or all of seven different types of 
security permissions.

Permission Type When granted, lets the user...

Create/Modify 
Contacts and Events

Add, change or delete information contained in an item stored on 
the server. For example, a user with Modify permission can add 
a note to a public Contact or change the title of a public Event. 
However, Modify permission does not allow a user to delete an 
item.

This box lists all the groups on 
the server of which you are a 
member

This box lists all the groups 
the Eudora Planner 
administrator has created 
for this server
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Security permissions created on a Eudora Planner server affect only those Events, 
Contacts, categories, and custom fields residing on that server. If you are connected 
to multiple workgroup servers in your organization, your access permissions may 
differ for each server. 

The Eudora Planner administrator can assign unique sets of security permissions to 
both users and groups, so there may be instances when permissions granted to you 
as a user seem to contradict those permissions denied to a group of which you are 
a member, or vice versa. In such instances, the explicit denial of a permission 
always overrides the granting of that permission elsewhere.

For example, imagine that you are assigned to a group called Sales. Because you 
are the manager of the sales department, you are granted all possible security 
permissions at the individual user level. However, because other users in the Sales 
group are not at your level, they are as a group denied permission to delete Events 
and Contacts from the server. In this case, because you belong to a group for which 
this permission has been explicitly denied, you do not have permission to delete 
Events and Contacts on that server, even though you’ve been granted that 
permission as an individual user.

Conversely, if the Sales group has been granted permission to delete Events and 
Contacts, but you as an individual user have been denied that permission, then you 
do not have the ability to delete Events and Contacts on that server.

Delete Contacts and 
Events

Delete Contacts and Events on the server.

Modify access for 
Contacts and Events

Change the access permissions of this user’s Events and 
Contacts in regard to other users.

Create/Modify 
categories and 
custom fields

Add or change categories and custom fields stored on the 
server.

Delete categories 
and custom fields

Delete categories and custom fields on the server.

Manage servers Connect to and disconnect from Eudora Planner workgroup 
servers.

Manage users and 
groups

Add users and groups to the server, as well as alter the attributes 
of existing users and groups, including their server permissions. 

Take ownership of 
Contacts and Events

Gain ownership of another user’s public Contacts and Events, so 
that Eudora Planner recognizes that the items belong to the new 
owner and not to the original owner. When a user takes 
ownership of public Contacts and Events, he or she has full 
permissions for them. Normally, only the Eudora Planner 
administrator has Take Ownership permission.

Permission Type When granted, lets the user...
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Only the Eudora Planner administrator can change your security permissions for a 
workgroup server, but you can see which permissions have been granted to you. 
Consult your Eudora Planner administrator about any changes to your permissions.

To view your security permissions:
1. From the Tools menu, select Users and Groups.

The Users and Groups dialog box appears.

2. Click the Server arrow to display a drop-down list of servers to which you are 
connected, then select the server for which you want to see your permissions.

3. In the Users and Groups area, select your name, then click Details.

The User Properties dialog box appears.

4. Select the Advanced tab, then click the Security button.

The Security dialog box appears, displaying your permissions with regards to 
creating and modifying Contacts, Events, categories, and custom fields on this 
server. This dialog box also indicates which Administration rights, if any, you 
have for this server.

5. Click OK to close the Security dialog box.
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Setting Privacy Permissions
Just as your Eudora Planner administrator determines your permissions for viewing 
or modifying information on a workgroup server, you too can administer other users 
permissions for the shared Events and Contacts that your create. By granting or 
denying another user privacy permissions, you can determine the level of access 
that user has for your shared items. For example, you may want to give your 
manager and your assistant the ability to read, modify, and delete your Events and 
Contacts, whereas you give co-workers permission only to read those items.

Even if you’ve given a user particular privacy permissions for the Events and 
Contacts you create, you can deny that user those permissions for particular shared 
items. For information, see “Setting Object Permissions” on page 140.

Although Eudora Planner gives you the flexibility to grant a particular user a specific 
set of permissions for your shared Events and Contacts, you cannot grant any 
permissions that the Eudora Planner administrator has explicitly denied to that user 
for the server. So, if the administrator has denied Howard Greene delete permission 
for Events and Contacts on the server, you cannot grant Howard Greene delete 
permission for your own shared Events and Contacts.

You cannot change other users’ permissions for your shared Events and Contacts if 
your Eudora Planner administrator has not granted you Change Privacy permission. 
See “Knowing Your Security Permissions for a Workgroup Server” on page 135 for 
instructions on how to tell whether you have Change Privacy permission.

You can grant other Eudora Planner users five different types of privacy permissions 
for shared Events and Contacts you create. 

To set privacy permissions for your Events and Contacts:
1. From the Tools menu, select Users and Groups.

The Users and Groups dialog box appears.

2. From the drop-down Server list, select the workgroup server on which you want 
to change permissions.

Permission Type When granted, lets other users...

Delete Delete this Event or Contact.

Modify Add, change or delete information—such as titles, notes, and 
attachments—contained in this Event or Contact.

Modify access Change the permissions for this Event or Contact. For example, if 
you assigned someone else Modify Access permission for this 
Event or Contact, they could in turn change the access permissions 
of this Event or Contact in regard to other users.

Read View this Event or Contact (the default).

Take ownership Take possession of this Event or Contact, if necessary.
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3. In the Users and groups area, click the plus sign next to Users. Select your 
user name, then click Details.

The User Properties dialog box appears.

4. Click the Privacy tab. Make sure the Available to other users option is 
selected, then click Custom Privacy.

The Access Control List dialog box appears.

5. Click Add to open the Permissions dialog box. From the drop-down User or 
Group list, select the user or group for which you want to change permissions. 
In the Permissions area, choose the permissions you want to grant the user or 
group. Select On to grant a permission or Off to deny it. If you leave the option 
at Not Set for a user, then the user will retain the default permissions set by the 
server administrator for items on that server.

6. Click Apply to apply the permission changes you made. Then, click Close to 
close the Permissions dialog box.
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The permissions you’ve granted to the user are reflected in the Access Control 
List dialog box. 

7. Click OK.

The changes you’ve made are sent to the workgroup server during the next 
update. The user or group now has the permissions you’ve specified and can 
work accordingly with your public Events and Contacts.

These new privacy permissions apply only to Events and Contacts you create after 
changing these settings. Events and Contacts you created before changing these 
settings retain the privacy permissions that were in effect when you created them. 
To change the privacy permissions for existing Events and Contacts, you must do so 
individually as described in the following section.

Setting Object Permissions
You may occasionally create Events and Contacts that you need to restrict to all but 
one or a few users. For such items, Eudora Planner lets you set object 
permissions—a set of user permissions specific to one Event or Contact. The 
permissions you give a user for a particular Event or Contact override the privacy 
permissions you’ve given to that user. For example, you may have granted your co-
worker, Wendy Chin, every available privacy permission for your shared Events and 
Contacts. However, since you don’t want her to know about the surprise birthday 
party the office has planned for her, you deny her read permission for the particular 
Event denoting that occasion. 

To set permissions for an individual Event or Contact:
1. For an Event, in one of the Calendar Views, select the Event for which you want 

to set permissions. For a Contact, in the List View, select the appropriate 
Contact.

2. From the Edit menu, select Security. 
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The Security Settings dialog box appears.

3. Click Add to give another user permissions for this Event or Contact.

The Permissions dialog box appears.

4. In the Permissions area, choose the permissions you want to grant the user or 
group. Select On to grant a permission or Off to deny it. If you leave the option 
at Not Set for a user, then the user will have the permissions.

5. Click Apply to apply the permission changes you made. Then, click Close to 
close the Permissions dialog box.

The permissions you’ve granted to the user for this Event or Contact are 
reflected in the Security Settings dialog box.

6. Click OK.

The changes you’ve made are sent to the workgroup server during the next 
update. The user or group now has the permissions you’ve specified and can 
work accordingly with the Event or Contact.
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Using Web Publisher
Eudora Planner’s Web Publisher plugin lets you publish your Event and Contact 
information to ready-made World Wide Web pages that can be incorporated into any 
Internet or intranet site. With Web Publisher, you don’t have to know HTML 
(Hypertext Markup Language) to create Web pages that have the refined look and 
feel of the Eudora Planner Calendar and Address Book, because Web Publisher 
automatically generates all the necessary files for you. So, whether you need to 
create an employee directory for your company’s intranet site or a calendar of events 
for your community association’s World Wide Web site, Web Publisher can save you 
the time and effort of designing and updating your Web pages.

This chapter explains how to use Web Publisher, including:

• A Web Publisher overview, which describes how this feature can enhance the 
appearance of your Web site

• Instructions for creating basic Web pages

• An explanation of Web Publisher’s advanced options, so you can customize 
your Calendar and Contact pages

A Web Publisher Overview
This section describes how Web Publisher can help you improve the look of your 
Web pages. 

Improve the Look of Your Web Page
If your organization uses an Internet or intranet site to broadcast schedules of 
events, then Eudora Planner’s Web Publisher may be just the tool for making those 
schedules more appealing to visitors to your site. 
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When you use Web Publisher, the calendar on your Web site can look like this:

The layout is as familiar as a wall calendar, so visitors to your site can easily 
navigate to specific dates. Depending on your needs and preferences, you can 
publish Week, Day, and Detail views that resemble those in Eudora Planner, with 
each view accessible by the click of a button in the button bar.
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If you do choose to publish the Detail View, visitors can see specific details about an 
Event just by clicking it in any view.

In the Detail View, a visitor can see the title, date, and time of an Event, as well as 
any information you’ve entered into the Event’s Description field.
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And Web Publisher isn’t only for publishing Events. You can likewise publish your 
Contacts in a format that’s just as easy to navigate:

A person browsing this page can click a letter button to view only Contacts sorted by 
that letter or click the All button to see the complete listing of Contacts. 
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The Detail View for a particular Contact can be opened by clicking the hypertext 
(underlined text) in that Contact’s Last Name field:

The Detail View displays more specific information about a Contact. In fact, you can 
use Web Publisher’s advanced options to specify exactly which Contact fields 
appear in the Detail View. For more information, see “Customizing Calendar and 
Contact List Pages” on page 153.

Drag and Drop from a Calendar or Contact List Page
When you use Web Publisher to create Calendars and Contact Lists for your Web 
site, Eudora Planner users browsing your site have the ability to drag your published 
Event and Contact information directly into their own Calendars and Address Books. 
That’s because Web Publisher employs Versit card (or vCard) technology, which 
enables users to drag objects (in this case, Events and Contacts) from a Web page 
to a desktop application. A Web Publisher vCard can contain all the details for a 
particular Event or Contact, or even whole categories of Events or Contacts. A 
Eudora Planner user need only have Eudora Planner open when visiting your site. 
When the user drags an Event or Contact vCard into the Calendar or Address Book, 
all the information for the item is placed in Eudora Planner file, just as if the user had 
manually entered it. What’s more, the vCard inserts a live link to your Web site into 
the Event and Contact, so that the user need only click the link to launch a browser 
and revisit your site for updates or new information.
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The Web Publisher View
To open Web Publisher, select Publisher from the View menu.

The Web Publisher plugin organizes the pages you publish in a hierarchy displayed 
in the top left pane of the window. When you select a page, the properties of that 
page are listed in the right pane. At the bottom of the window, status messages 
report the results of a publishing operation.

Basic Web Publishing
This section explains how to use Web Publisher to publish basic Event and Contact 
Web pages, including: 

• Creating a main page
• Adding Calendar or Contact List pages to the main page
• Publishing a set of Web pages

The pages you create by following these steps are “basic” only in that they retain 
most of Web Publisher’s default settings. To alter your Web Publisher pages to 
accommodate your needs or those of your organization, follow the steps in this 
section, then go to “Customizing the Appearance of a Main Web Page” on page 152 
and “Customizing Calendar and Contact List Pages” on page 153. 

The Pages pane lists the 
hierarchy of all home pages, 
calendars, and listings 
currently defined. Click an 
entry to see its properties in 
the Details pane

The Details pane lists the 
properties of the page 
selected in the Web Pages 
pane. Double-click on a 
Detail name to change its 
value in the Web Page 
Properties, Calendar 
Properties or Listing 
Properties dialog box

The Status pane lists 
messages generated during 
the creation of published 
pages, calendars and 
listings. Right-click in this 
area to select reporting 
options or clear existing 
messages
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Creating a Main Page
The first step in publishing your Eudora Planner information to the World Wide Web 
is to create a main page. The main page acts as a foreword for any of the various 
Event and Contact pages you publish, since it lists and provides a link to those 
pages. You can add multiple Calendar and Contact List pages to a single main page, 
or create a separate main page for each Calendar or Contact List you publish.

To create a main Web page:
1. From the Insert menu, select New Web Page.

The Web Pages dialog box appears.

2. Enter a name for the Web page in the Name box. Optionally, you can type a 
brief description of this page in the Description box.

3. Click OK.

A main Web page, with the name you assigned it, is added to the list in the Web 
Pages pane. 

Choosing Export Options
Once you’ve created the main Web page, you need to determine where, and how 
frequently, you want to export that page’s HTML files. 

To determine export settings for a Web page:
1. Select the Web page in the Web Pages pane. Then, from the Edit menu, select 

Details.

The Web page you’ve 
created is listed here
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The Web Page Properties dialog box appears, displaying the General tab. The 
Name box shows the name of the Web page you’ve selected.

2. Click the Export tab.

3. Select the directory to which you want to export this page’s HTML files. 

4. Select Organize files in subdirectories to have related files export to 
subdirectories within the directory you specified in step 3; or, select Place all 
files in one directory to have all files reside in the main directory.

5. Drag the Interval pointer to select the time interval between exports:

• Select Manual Only if you want Web Publisher to export the files when you 
prompt it.

• Select from among the Every 30 Minutes, Every Hour, and Every 4 Hours 
options to have the files export at one of those intervals.

• Select Every Day to have the files export once a day. Click the Every Day at 
drop-down list to specify the time at which you want the daily export to occur.

6. Click OK. 

Web Publisher is configured to export the page to the directory you’ve chosen 
at the time interval you’ve specified. You can now add Event or Contact 
information to the page as described in “Adding Calendar and Contact List 
Pages to the Main Web Page” on page 151.

Web Publisher provides additional control over the look of your main pages, and lets 
you add additional content and processing to the pages you create. For information 
on these advanced publishing options, see “Using Pre- and Post-Processing 
Scripts” on page 160.

The pathname of the 
export directory you 
select appears here

The pointer indicates 
how frequently the 
pages are exported

When you select the Every Day export option, 
the time of the export appears here
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Adding Calendar and Contact List Pages to the Main Web Page
The next step is to add Event or Contact information to the Web page, which you do 
by creating pages that contain this information. Pages containing Event information 
are called Calendar pages in Web Publisher; pages containing Contact information 
are called Contact List pages. You can create multiple Calendar and Contact List 
pages to be associated with a main Web page.

To create a Calendar or Contact List page:
1. From the Insert menu, select New Calendar/Contact List.

The Select Web Page dialog box appears.

2. Select the Web page to which you want add a Calendar or Contact List page, 
then click OK to open the Add a Calendar or Contact List dialog box. Specify 
the following information:

• In the Name box, enter a name for the calendar or listing.

• Of the Publishing Format options, select either Calendar or Contact List.

• Optionally, type a description of the Calendar or Contact List page in the 
Description box.

3. Click OK.

The Calendar or Contact List page you’ve created appears in the Web Pages 
pane under the main Web page to which you’ve added it.

4. In the Web Pages pane, select the Calendar or Contact List page you want to 
configure. Then, from the Edit menu, select Details.

The Calendar or 
Contact List page 
appears under the 
main Web page
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The Calendar or Contact List Properties dialog box appears, displaying the 
General tab.

5. If you are configuring a Calendar page, use the Date Range options to select 
the range of Events you want to publish. If you are configuring a Contact List 
page, go to step 6.

6. Click the Categories tab. Then, select the categories that you want to publish.

7. Click OK.

The Calendar or Contact List page is configured to publish the information 
you’ve selected. The page retains most of Web Publisher’s default settings.

Publishing Your Web Page Set
Once you’ve configured a set of Web pages, you can publish them to create the 
HTML files to be incorporated into your Web site.

To generate HTML files:
1. From the Tools menu, select Publish.

The Select Web Page dialog box appears.

2. Select the main Web page that you want to publish, then click OK.

Eudora Planner begins generating the Web page set you selected. Messages 
appear in the Status pane, indicating the progress of the Web page publishing. 
When the operation is complete, the message “Web Page Published” appears.

You can further refine the appearance of the main Web page using the Web Page 
Properties dialog box. For information on these advanced options, see “Advanced 
Web Publishing” on page 152. For information on how to refine Calendar and 
Contact List pages, see “Calendar Page Options” on page 154 and “Contact List 
Page Options” on page 156. 

Advanced Web Publishing
You can customize the appearance of the pages you create with Web Publisher in 
order to display a company logo or eye-catching graphics. 

Customizing the Appearance of a Main Web Page
The main Web page acts as a directory for and link to your Calendar and Contact 
List pages, so it’s the first page a person will see when trying to access those pages. 
You can alter the appearance of this page to suit your needs.

To customize the appearance of a main Web page:
1. In the Web Pages pane, select the Web page you want to customize. Then, 

from the Edit menu, select Details.

The Web Page Properties dialog box appears, displaying the General tab.
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2. If you want the name or description of the Web page to appear on the page, 
select the Display name on Web Page or Display description on Web Page 
options. Otherwise, go to step 3. 

3. Click the Customize tab to view the custom options.

4. To replace the standard header and footer of the Web page with a custom 
header and footer, click the buttons next to the Header and Footer boxes to 
browse to find and select the files containing those custom items.

The pathname of the files will appear in the Header and Footer boxes.

5. Choose one of the options in the Display area:

• Select HTML View to publish Calendars and Contact Lists viewable by any 
browser.

• Select Plug-in View to publish Calendars and Contact Lists viewable only by 
browsers enhanced by the AboutTime and AboutPeople plug-ins.

• Select Both to publish both the HTML and Plug-in views.

For more information about the Plug-in view, see “Using the AboutTime and 
AboutPeople Plugins” on page 161.

6. In the Customize HTML Output section, select Drag and Drop Handles for 
Versit Cards if you want handles to appear next to items that can be dragged 
from a Calendar or Contact List page to a Eudora Planner Calendar or Address 
Book.

7. Click OK.

The next time you export to HTML, the appearance of your Web pages will 
reflect the changes you’ve specified.

Customizing Calendar and Contact List Pages
Just as you can reconfigure the properties of the main Web page to alter its 
appearance, so too can you customize each Calendar and Contact List page 
associated with the main page. 

To configure a Calendar or Contact List page:
1. In the Web Pages pane, select the Calendar or Contact List page you want to 

configure. Then, from the Edit menu, select Details.

The Calendar Properties or Contact List Properties dialog box appears, 
displaying the General tab. The Name and Description boxes contain the 
information you entered when you created the page.

2. Go through each tab in the dialog box and change any settings to reflect your 
preferences. The options in the Calendar Properties dialog box are described in 
“Calendar Page Options” on page 154. The option in the Listing Properties 
dialog box are described in “Contact List Page Options” on page 156.

3. After you’ve chosen the appropriate options, click OK.
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Calendar Page Options
Each tab on the Calendar Properties dialog box contains options that affect the 
contents and appearance of your Calendar pages. This section describes, in order, 
the options on each tab.

General Tab
Use this tab to enter general information about the Calendar page and to determine 
the range of Events appearing on the page.

Enter a name and description for the Calendar page in the Name and Description 
boxes. Select the Display description on Web page option if you want the 
description to appear on the page.

Use the Date Range options to determine the range of Events you want to publish: 

• Select Relative Range if you want to publish Events within a range of time 
always relative to the current month. For example, if you select a Start date of -
2 months and an End date of +3 months, Web Publisher will publish a Calendar 
that shows Events for the two months previous to this month, the present 
month, and three months into the future. 

• Select Absolute Range if you want to publish Events that fall within two specific 
dates.

Enter a name for the 
Calendar page here

Type a description of 
the Calendar page here

Select this option to 
display the description 
on the Calendar page

These options determine the date range of Events 
to be published
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Categories Tab
Use this tab to select the categories you want to appear on the Calendar page.

Select the Event categories that you want to appear on the page. You can select 
categories from both your local server and any workgroup server to which you’re 
connected.

Customize Tab
Use the options on this tab to customize the appearance of your Calendar pages.

The Header/Footer options let you place a custom header and footer on each 
Calendar page, so, for example, you can populate the pages with your organization’s 
logo. In the Header and Footer boxes, enter the pathnames of the HTML files 

Select the Event 
categories that you 
want to appear on the 
Calendar page

Click these buttons to select or unselect all the 
listed categories

You can enter the 
pathnames of your 
custom header and 
footer files into these 
boxes

If you don’t know the pathnames of your custom 
header and footer files, you can click these 
buttons to browse for them

This setting determines the maximum number of 
Events displayed in a day cell of the Month View

This setting determines the maximum number of 
characters in an Event title
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containing the custom header and footer. If you don’t know the pathnames of the 
files, click the button adjacent to each box to browse for those files.

Select the Drag and Drop Handles for Versit Cards option if you want drag 
handles to appear next to Event items that can be dragged from you Web page to a 
Eudora Planner Calendar.

The settings in the Customize Month View area let you change how Event 
information appears in the Calendar page’s Month View. The Relative font size for 
Event title setting determines the font size of Event titles relative to their 
accompanying description text. The Length of Event title in characters setting 
determines the maximum length of Event titles in the Month View. The Max number 
of Events displayed in day cell setting determines the maximum number of 
Events that will appear in the day cell of the Month View. 

Calendar Views Tab
Use this tab to select which Calendar views are published by Web Publisher and, of 
those views, which is the first seen by a visitor to your Calendar page.

Web Publisher always publishes the Month View. You can choose to additionally 
publish the Day View, Week View, and Detail View by selecting the appropriate 
check boxes. 

To determine which Calendar view visitors see when they first access the Calendar 
page, select a Default View from the drop-down menu.

Contact List Page Options
The options in the Contact List properties dialog box determine the content, 
appearance, and overall framework of your Contact List pages. This section 
describes the options available on each tab.

The Calendar views 
you select here are 
included with your 
published pages

The Calendar view you choose here is first one 
users see when they access this Calendar page
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General Tab
Use this tab to enter general information about the Contact List page.

Enter a name and description for the Contact List page in the Name and 
Description boxes. Select the Display description on Web page option if you 
want the description to appear on the page.

Categories Tab
Use this tab to determine which categories appear on the Contact List page.

Select the Address Book categories that you want to appear on the page. You can 
select categories from both your local server and any workgroup server to which 
you’re connected.

Enter a name for the 
Contact List page here

Enter a description for 
the Contact List page 
here

Click here to have the 
description display on 
the Contact List page

Select the Address Book 
categories you want to 
appear on this page

Click these buttons to select or unselect all the 
listed categories
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Customize Tab
Use this tab to customize the appearance of your Contact List page.

Use the options in the Header/Footer area to place a custom header and footer on 
each Listing page. In the Header and Footer boxes, enter the pathnames of the 
HTML files containing the custom header and footer. If you don’t know the 
pathnames of the files, click the button next to each box to browse for those files.

Select the Drag and Drop Handles for Versit Cards option if you want handles to 
appear next Contact items that can be dragged to the Eudora Planner Address 
Book from the Web page. Select the Support Web Browsers which cannot view 
frames option if you want the Listing page to be available to browsers that cannot 
view HTML frames. 

Use the Default View option to determine whether a person initially accessing the 
Contact List page sees a page displaying all Contacts or just those sorted under the 
letter “A.”

Enter the pathnames of 
your custom header and 
footer files in these boxes

If you don’t know the pathnames, click these 
buttons to browse to find the files containing 
your custom header and footer
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List View Tab
Use this tab lets to determine which Address Book fields are displayed in the 
Contact List page’s List View and the order in which they appear. 

Select those fields that you want to display and drag them to reorder them.

From the Sort by drop-down list, select the Contact field by which you want the List 
View to sort.

Detail View Tab
Use this tab to determine which Address Book fields are displayed in an individual 
Contact’s Detail View and the order in which they appear.

The selected Address 
Book fields appear in 
the List View of the 
Contact List page

The List View sorts by the field you select here

When you drag fields to different positions, you 
change their order in the List View

The fields you select 
here appear in the 
Detail View of the 
Contacts you publish 
to the Contact List 
page

You can use these buttons to insert and delete 
separators between groupings of like fields. The 
separators you insert here translate into spaces 
that alter the look of the Contact List page’s 
Detail View

Drag to move the fields here to change their 
order of appearance in the Detail View
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Select those fields that you want to appear in the Detail View and drag them to 
change their order in the view. 

Advanced Tab
Use this tab to alter the attributes of the Contact List page’s HTML frames.

In the HTML Frame Sizes area, select the sizes of the header, toolbar, banner, and 
footer appearing on the Contact List page.

Using Pre- and Post-Processing Scripts
You can set Web Publisher to execute pre- and post-processing scripts before and 
after it publishes your information. These scripts can automate the, Web Publisher 
can execute the running of pre- and post-processing scripts which, You can use pre- 
and post-processing scripts to further modify the contents and appearance of your 
Web Publisher pages. 

Pre- and post-process scripts let you insert dynamic information into your Web 
Publisher pages. This dynamic information can consist of such details as the current 
system date and time, the last modification date of the HTML document, a Web 
page counter, or the contents of another document. For more details about these 
options, see “Advanced Tab” on page 160.

To run a pre- or post-processing script:
1. In the Web Pages pane, select the Web page for which you want to run the 

script. Then, from the Edit menu, select Details. 

The Web Page Properties dialog box appears.

2. Select the Advanced tab.

3. To use a pre-processing script, enter the script’s pathname into the Run this 
script before the HTML publishing begins box. To use a post-processing 

These settings let you 
change the HTML 
frame sizes of various 
areas of your Contact 
List pages

Click to reset the frame sizes to their defaults
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script, enter the script’s pathname into the Run this script after the HTML 
publishing finishes box.

4. To determine the maximum amount of time Web Publisher allows for a script to 
be executed, enter a value into the Maximum seconds for script timeout box.

5. To make Web Publisher stop publishing when it detects in error in a pre- or post-
processing script, select Stop publishing on script error.

6. Click OK.

Web Publisher is configured to run the selected pre- and post-processing 
scripts the next time it publishes HTML files.

Using the AboutTime and AboutPeople Plugins
AboutTime and AboutPeople are Netscape plugins that enable Netscape Navigator 
users to view enhanced Web Publisher pages that provide greater speed, flexibility, 
and search capabilities than can be had when viewing HTML alone. 

AboutTime allows visitors to your Web site to see pages displaying the Calendar 
Plugin View. 

In this view, you can navigate instantly to different calendar views without having to 
actually switch Web pages. You can also search for Events either by title or by words 
in the Event’s description.

A visitor to this 
page can search 
for an Event by 
clicking here

Clicking these 
tabs lets a visitor 
quickly navigate 
between views

Clicking an Event 
shows details 
about the Event
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AboutPeople allows users to see pages displaying the Contact List Plugin View.

This view lets visitors sort, scroll through, and search the list of published Contacts, 
so they can quickly find the names they want.

To publish the Plugin View:
1. In the Web Pages pane, select the primary page of the Web page set for which 

you want to publish the Plugin View. Then, from the Edit menu, select Details.

The Web Page Properties dialog box appears.

2. Select the Customize tab.

3. In the Display section, select from among the following options:

• Select Plug-in View to publish Calendars and Contact Lists viewable only by 
browsers enhanced by the AboutTime and AboutPeople plug-ins.

• Select Both to publish both the HTML and Plug-in views.

4. Click OK.

Web Publisher is configured to publish the Plug-in View (as well as the HTML 
View, if you selected the Both option in step 3).

Visitor to your site 
can type here to 
find a published 
name

All published 
Contacts appear in 
this list

Details about a 
selected Contact 
appear here

List of Contacts 
can be sorted by 
different fields

Phone and e-mail 
fields provide live 
links, so a user can 
dial or send a 
message from here
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Using the Status Pane
Web Publisher’s Status pane, located at the bottom of the Web Publisher window, 
displays messages about the publishing process when you initiate the publishing of 
a Web page set. You can select which type of messages appear in the Status pane 
during publishing, as well as clear the messages from the pane when the publishing 
operation is complete.

To set the Status pane preferences:
1. Right-click any message appearing in the Status pane.

A pop-up menu appears.

2. Select Properties.

The Web Publishing Applet Options dialog box appears.

3. Select which of the following types of messages you want to appear in the 
Status pane during the publishing operation:

• Select Errors to be alerted to any application errors that occur.

• Select Warnings to be alerted when a publishing operation cannot be 
executed due to an erroneous properties setting.

• Select Status Information to see a general progress report of the publishing 
operation.

• Select Verbose Information to have your progress report contain specific 
information about what is being published, such as the range of Events or 
Contacts.

4. Use the Max number of messages to display option to determine the 
maximum number of messages that can appear in the Status pane.

5. Click OK.

The Status pane will reflect your preferences the next time you publish a Web 
page set.

To clear messages from the Status pane:
1. Right-click any message in the Status pane.

A pop-up menu appears.

2. Select Clear Messages.

All messages appearing in the Status pane are deleted.
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Glossary

Address Book—How Eudora Planner displays Contact information. The 
Eudora Planner Address Book can be viewed using the List View or Detail 
View.

Auto-Caps—An Address Book feature that automatically capitalizes the first 
letter of any word typed into a Contact Detail field. Auto-Caps functions in 
the Name, Company, City, State, Country, and Salutation fields.

Auto-Complete—An Address Book feature that automatically finishes what 
you are typing into a Contact Detail field. Auto-Complete functions in the 
Name, Company, and City fields.

Auto-Fill—An Address Book feature that automatically adds a work address 
to a Contact’s record after you enter a company name already associated 
with an address elsewhere in your database.

Auto-Pick—A group scheduling feature that searches for a free period of 
time common to a group of meeting invitees, then automatically schedules a 
meeting for that time.

Banner—An Event type that appears in any Calendar view as a floating 
object containing a line of text. Banners can indicate a plan or activity that 
spans a number of days or weeks, such as a 3-day business trip.

busy time—Concerning Eudora Planner’s group scheduling feature, a 
period of time that is occupied by an Event for which you’ve selected the 
Show Time as Busy option or that you’ve designated as unavailable time in 
the Availability preferences. Other Eudora Planner users can see your 
blocked time when they invite you to a meeting.

blocked time—See busy time.

Calendar Event—See Event.

Calendar—How Eudora Planner displays Event information. Calendar 
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information is displayed in four different Calendar views—Month, Week, Day 
and Multi-Day.

Category—A method for classifying Events and Contacts that are related to 
each other. You can create a Category called “Work” and assign Events and 
Contacts that are work-related to that Category. Categories provide a way to 
separate and filter your Event and Contact information (see Tab).

cell—A box that represents a day in the Month and Week views or an 
increment of time in the Day and Multi-Day views.

Contact—A single entry in the Address Book that contains name, company, 
address, phone and other essential information on a person and/or 
company.

Contact heading—The area at the top of the Contact Details dialog box that 
contains the Contact’s primary name and phone number.

Contact Detail—A dialog box that contains information for a particular 
Contact, including name, company name, addresses, phone numbers, e-
mail addresses, notes, attached documents, and related Events. 

database—The file in which Eudora Planner stores Event and Contact 
information as well as and supporting information such as Categories, Tabs, 
graphics, preferences settings, etc.

complete—A term denoting the status of a To-Do or Call. A To-Do or Call is 
by default marked as Incomplete, but is marked as Complete when the task 
it represents has been completed.

duration—The difference between an Event’s start and stop times, or simply, 
how long the Event lasts.

Event—An entry in your Calendar that represents a Meeting, Call, To-Do, 
Holiday, Special Event, Banner, or Sticky Note. The word Event is used in 
general to refer to any activity you schedule in your Calendar.

Event Detail—A dialog box containing controls for changing Event 
attributes, including the title, description, attached Contact data or 
documents, start time, stop time, Category, Priority, and duration. You can 
also use this dialog box to specify whether or not an Event will have a 
Reminder alert attached to it. There is a specific Detail dialog box for each 
type of Event.

export—A function that copies Event or Contact data and saves it to an 
external file for use in another program.

filter—See To-Do and Call Filter.

footer—User-definable text that appears at the bottom of printed output; you 
can create a custom footer by clicking Header/Footer in the Print dialog box.

graphic—A bitmap (BMP file) that is assigned to an Event or used as a 
background in a Calendar View. Graphics can give special significance to 
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individual Events or add visual appeal to your Calendar.

header—User-definable text that appears at the top of printed output; you 
can create a custom header or footer by clicking “Header/Footer...” in the 
Print dialog box.

heading—1) The top section of the current Calendar View; for example, in 
the Month View, the area that shows the month and year is the heading. 2) 
In the Address Book’s List View, the area at the top of each column, 
indicating what data the column displays, that you can click to sort each 
column and drag to arrange the columns’ order.

hidden—Describes an Event that you have made invisible by choosing the 
Hide command from the Event’s right-click menu.

Holiday—An Event type that spans an entire day, rather than being attached 
to a specific time on that day.

import—A function that translates Calendar or Address Book information 
saved in a text file into Event or Contact information that is copied into your 
Eudora Planner database.

Link fields—In the Contact Details dialog box, the five changeable fields that 
contain phone numbers, e-mail addresses, and Web site addresses. You 
can click on the icon next to a Link field to create a Call Event for a Contact, 
send an e-mail message, or launch your Internet browser to open a Web 
page.

Messaging Application Programming Interface (MAPI)—The standard 
interface that allows e-mail clients to pass information to an e-mail 
messaging service. An e-mail package must be MAPI-compliant in order to 
work with Eudora Planner’s e-mail features.

merge document—A document (either a letter or fax) that is intended to be 
sent to more than one Contact. A merge document usually contains merge 
fields, which allow the document to contain personalized information for 
each recipient. See merge field.

merge field—A placeholder that you can insert in a text document that is 
replaced by actual Contact data when the document is printed or faxed.

overdue —A term referring to a dated To-Do or Call that has not been 
completed by its due date. You can view overdue To-Dos and Calls in the To-
Do List by selecting the Overdue option in the To-Do and Call Filter.

personal Contact—A Contact that appears only in your Address Book. 
Personal Contacts are assigned only private Categories, and therefore 
cannot be view by other users over the network (compare with workgroup 
Contact).

personal Event—An Event that appears in your Calendar only. Personal 
Events are assigned only Private Categories, and therefore cannot be 
viewed by other users over the network (compare with workgroup Event).
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plugin—A small, specialized application designed to enhance and work 
within the framework of a larger application. You can access Eudora Planner 
plugins from the shortcuts pane.

preferences—A set of user-definable criteria allowing you to specify how 
certain functions of Eudora Planner will work and determine the appearance 
of the Address Book and Calendar.

priority—A level of importance that you can assign to a To-Do or Call. 
Eudora Planner allows you to define up to ten priorities and assign them 
freely to individual Events.

private Category—A Category that is stored in your personal, local 
database and is not shared over the network or visible to other users 
(compare with public Category).

proxy—a user who is selected by another user to act on his or her behalf in 
scheduling meetings and accepting or declining invitations to meetings.

public Category—A shared Category that is stored on a workgroup server, 
and that contains public Events or Contacts. Public Categories, and the 
public Events they contain, are available to all users on the network 
(compare with private Category).

QuickAccess—A suite of three small, background applications that allow 
you to view and add to your Calendar and Address Book information without 
having to open Eudora Planner. See QuickContact, QuickDay, and 
QuickPad.

QuickContact—A small, background application that gives you access to 
information in your Address Book without having to open Eudora Planner. 
QuickContact lets you view all your Contacts or search for specific ones, dial 
and send e-mail messages, and create new Contacts and Events. You can 
open QuickContact from the Windows taskbar.

QuickDay—A small, background application that gives you access to 
information in your Calendar without having to open Eudora Planner. 
QuickDay lets you view any day’s activities and create new Events and 
Contacts. You can open QuickDay from the Windows taskbar.

QuickNet—A Eudora Planner feature that uses the search capabilities of the 
World Wide Web to find information about a Contact, such as Zip+4, e-mail 
addresses, white pages listing, and a street map to the Contact’s address.

QuickPad—A pop-up menu located on the Windows taskbar that allows you 
to create new Events and Contacts without having to open Eudora Planner.

reminder—An alert of an upcoming Event in the form of an Alert Dialog, a 
flashing Event title in the menu bar, or a sound. You can set a Reminder for 
any Event in your Calendar, including Public Events.

repeating Event—One of a series of Events that you have configured to 
repeat at a specified interval and for a specified number of occurrences.
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server—See workgroup server.

shortcut—In Eudora Planner, a program icon that points to another 
application or document or to a Web site. When you double-click the icon, 
the application or document is opened or, in the case of a Web site, your 
browser is launched and opens the appropriate site.

shortcuts pane—An area in the Eudora Planner window that contains 
shortcuts to other applications and documents, as well as plugins. The 
shortcuts pane can be moved or hidden from view.

sort—A function available in the Address Book List View allowing you to 
define the order in which Contacts are listed.

Special Event—An Event type that spans an entire day, rather than being 
attached to a specific time on that day.

Sticky Note—An Event type that appears as a movable object in the Month 
View. Sticky Notes can be used to display short lists or important notices.

style—1) A set of criteria for defining the appearance of your Calendar and 
Address Book views. You can create multiple styles and assign them to 
different Tabs, so that each Tab has a distinctive appearance. 2) Font and 
color settings applied to specific Categories, to give the Events and 
Contacts belonging to those Categories a distinctive appearance.

Tab—A method for organizing and displaying Calendar and Address Book 
Categories that are related to each other or contain similar information.

Telephony Application Programming Interface (TAPI)—A standard interface 
that allows an application to send commands to telephone hardware. Your 
modem or dialing device must be TAPI-compliant in order for you to use 
Eudora Planner’s dialing feature.

template—1) For printing in Eudora Planner, a predefined set of formatting 
specifications that determines the appearance of printed output. A print 
template specifies the page size, margins, text formatting and other aspects 
of your output. 2) A predefined set of Contact or Event information that you 
can use to create multiple Events or Contacts that use similar information. 
Event and Contact templates are defined and used from the Insert menu.

To-Do—An Event type that represents a task to be completed. A To-Do can 
optionally have Start and Due dates, but is undated by default. An undated 
To-Do is carried forward to subsequent days until marked as completed. A 
dated To-Do also is carried forward until marked completed, but is visible 
only on the range of days from its Start and Due dates.

To-Do and Call Filter—A Calendar feature that lets you determine which To-
Dos and Calls appear in the To-Do List. You can filter To-Dos and Calls 
based on a variety of criteria, including due date, completion status, and 
overdue status. To use this feature, right-click in the area above the To-Do 
List or in any empty cell in the To-Do List.
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To-Do List—An area of the Calendar in which you can view, track, and 
create To-Dos and Calls. You can use the To-List to sort To-Dos and Calls 
by title, Category, priority, due date, and completion date.

view—A graphic environment provided by Eudora Planner within which you 
can view, modify, and create Events and Contacts. For example, the Month 
View is one of the available Calendar Views. The List View is one of two 
available Address Book Views.

workgroup Contact—A Contact that has been assigned a public Category, 
and thereby made available to other users on the network (compare with 
personal Contact).

workgroup Event—An Event that has been assigned a public Category, and 
thereby made available for viewing to all users on the network (compare 
with personal Event).

workgroup server—A program that runs on a network file server, which 
stores and maintains public Categories, allowing users to share Event and 
Contact information.

Web Publisher—A Eudora Planner plugin that lets you export Event and 
Contact information to HTML, enabling you to automatically publish Web 
pages based on the contents and look of your Calendar and Address Book.
Glossary



Index

A
Address Book

described   1
organizing

using Categories   83
using Tabs   83, 89

setting List View preferences   79
Address Book views   16

B
background images, hiding   19
backing up your Eudora Planner database

7
Banners   35
blocking time   29

C
Calendar

defaults for newEvents   52
described   1
organizing

using Categories   83
using Tabs   83, 89

setting preferences   52
using   21

Calendar views   10
Calls
completing   33
dated   27

overdue   27
linking to Contacts   29
prioritizing   33
viewing   31

Categories
assigning

to Contacts, multiple   86
to Contacts, single   85
to Events   85

assigning to Tabs   96
creating   84
deleting   88
described   2, 83
modifying   88
primary Category   84

assigning   87
removing

from Contacts, multiple   87
from Contacts, single   86
from Events   86

using   84
Contact templates

creating   68
creating Contacts from   68
described   67
Index 171



172
Contacts
and custom fields   57, 59
assigning Categories to   65, 67
attaching

Contacts, other   63
documents   63
Events, existing   61
Events, new   61
Events, with QuickContact   115

creating   55
from templates   68
with QuickContact   113
with QuickPad   115

deleting   73
attached Events   62
duplicates   72
notes   62

described   55
dialing   74

with QuickContact   114
e-mailing

with QuickContact   114
e-mailing to   75
faxing to   74
linking Calls to   29
notes in   62
organizing

using Categories   83
using Tabs   83, 89

primary fields
described   65
selecting   65

QuickNet   79
searching for   69

saving search results   71
using Find feature   69
using QuickFind feature   71
with QuickContact   113

sorting   73
viewing Web sites linked to   78

conventions used in the book   xii
custom fields

changing names of   60
creating   58
deleting   61
described   57
Index
types of   58
Custom Fields section   18

D
database, backing up   7
Day View   10
Detail View   17
dialing Contacts   74

with QuickContact   114

E
e-mailing to Contacts   75

with QuickContact   114
Eudora Group Planner

administrator   120
Administrator’s Guide   120
group scheduling   129
home server   121

changing   122
functions described   121

logging in to server   120
permissions

described   133
object   140
privacy   138
security   135
viewing   135

setting server update preferences   122
users and groups   134
workgroup server

adding Categories to   127
adding custom fields to   128

Eudora Planner
features listed   1
installing   4
navigating in   10
registering   5
setting general preferences   19
starting   8
window features   9

Event Detail   15
Event templates   48



Events   21
adding pictures to   47
attaching Contacts to   43

in QuickContact   115
attaching email addresses to   41
attaching files to   39
attaching OLE objects to   42
attaching Web sites to   41
changing appearance of   46
creating   22

with QuickContact   115
with QuickDay   111
with QuickPad   115

creating from templates   49
cutting, copying, and pasting   45
finding   46
Meetings   23
organizing

using Categories   83
using Tabs   83, 89

repeating   37
types of   21

F
faxing to Contacts   74
filtering the To-Do list   14, 31
finding

Contacts   69
with QuickContact   113

Events   46

G
General Information section   18
General Preferences   19
group scheduling

described   3
with Meeting Details dialog box   24
with Meeting Wizard   23

H
History section   18
Holidays

scheduling   33
home server
changing   122
functions described   121

I
increments of time

setting in Day View   10
setting in Multi-Day View   11

installing Eudora Planner   4

L
List View   16

moving and resizing columns   74
sorting Contacts   73

Login
setting name   19
setting password   19

M
Meeting Wizard   23
Meetings

and availability   50
and resources   130
inviting users to   130
responding to invitations   49
scheduling

using Auto-Pick   130
using Details dialog box   24
using Meeting Wizard   23

using   23
Month View   13
Multi-Day View   11

To-Do area   31

N
navigating in Eudora Planner   10
Notes section   18
Index 173



174
O
OLE objects

attaching to Events   42

P
Plugins

described   2
Preferences

Address Book,setting   79
preferences

Calendar, setting   52
general, setting   19

primary fields
described   65

printing
Contacts   102
envelopes   103
Events   100
labels   104
previewing your printouts   105
print templates

saving   106
using   105

restoring settings   106
sample printouts   107

priority labels
assigning to To-Dos and Calls   33
creating   32

Private Categories
described   2

Public Categories
described   2

Q
QuickAccess

closing   117
components   109
described   3
hiding   116
preferences, setting   116
starting   109
starting Eudora Planner from   116

QuickContact
Contacts
Index
creating   113
dialing   114
e-mailing   114
finding   113
viewing   112

Contacts making a Quick Contact   113
creating Events in   115
described   112

QuickDay
creating Contacts in   112
described   110
Events

creating   111
modifying   111
viewing   110

QuickNet   79
QuickPad

creating Contacts with   115
creating Events with   115

R
registering Eudora Planner   5
reminders

dismissing   39
setting up   38
snoozing   39

repeating Events   37
running Eudora Planner   8
running Setup   4

S
scrolling view

enabling in Multi-Day View   11
Setup, running   4
Shortcuts

described   3
shortcuts

adding   97
deleting   98
renaming   98
using   9, 97

Special Events
scheduling   33

starting Eudora Planner   8



Sticky Notes   36
system requirements for Eudora Planner   4

T
Tab styles

assigning to Tabs   96
creating

for Address Book Tabs   94
for Calendar Tabs   92

Tabs
assigning Categories to   96
assigning Tab styles to   96
creating

for Address Book   91
for Calendar   89

default   2
described   2, 83
hiding names in all views   19
using   89

Time increments
setting in Day View   10, 11

To   33
To-Do List   14, 31

using To-Do and Call Filter   31
To-Dos

completing   33
dated   27

and Multi-Day To-Do area   31
overdue   27

overdue   31
prioritizing   33
undated   27
viewing   31
W
Web Publisher

described   3
Week View   12
workgroup server

adding Categories to   127
adding custom fields to   128
administrator   120
Administrator’s Guide   120
group scheduling   129
home server   121

changing   122
functions described   121

logging in to   120
permissions

described   133
object   140
privacy   138
security   133
viewing   135

setting server update preferences   122
users and groups   134
Index 175




	Table of Contents
	Introduction
	What Is Eudora Planner?
	Flexible Portability
	High-Speed Access to Your Data—Anytime, Anywhere
	Share Schedules and Contacts on the Network

	Conventions Used in the Book

	Getting Started
	Eudora Planner Features
	The Calendar
	The Address Book
	Categories
	Tabs
	Plugins
	Shortcuts
	QuickAccess
	Group Scheduling
	Web Publisher

	Installing Eudora Planner
	System Requirements
	Running Setup
	Registering Eudora Planner

	Uninstalling Eudora Planner
	Getting Technical Support
	Free, Unlimited Support
	Limited Technical Support (U.S. Only)
	International Technical Support
	Back Up Your Data!

	Starting Eudora Planner
	The Eudora Planner Window
	Using the Toolbar
	Using Shortcuts

	Navigating in Eudora Planner
	Calendar Views
	Day View
	Multi-Day View
	Week View
	Month View

	To-Do List
	Event Detail
	Address Book Views
	List View
	Detail View


	Setting Eudora Planner’s General Preferences

	Using the Calendar
	Types of Events
	Adding Events to the Calendar
	Using Meeting Events
	Using the Meeting Wizard
	Using the Meeting Details Dialog Box
	Scheduling a Meeting


	Using To-Dos and Calls
	Scheduling To-Dos
	Scheduling Calls
	Tracking To-Dos and Calls
	Viewing To-Dos and Calls
	Tracking Priority and Completion of To-Dos and Calls


	Using Other Types of Events
	Scheduling Holidays and Special Events
	Adding Banners
	Using Sticky Notes

	Setting Up Repeating Events
	Using Reminders
	Setting Up Reminders
	Responding to Reminders

	Attaching Items to Events
	Attaching Files to Events
	Attaching Web Sites and E-mail Addresses to Events
	Attaching OLE Objects

	Attaching Contacts to Events
	Getting More Out of the Calendar
	Editing Events in Any Calendar View
	Cutting, Copying and Pasting Events
	Moving Events

	Finding Events
	Changing the Appearance of Events
	Changing Event Text and Color
	Adding Pictures to Events

	Using Event Templates
	Creating Event Templates
	Creating Events from Templates


	Handling Meeting Invitations
	Responding to Meeting Invitations
	Setting Your Availability for Meetings

	Setting Calendar Preferences

	Using the Address Book
	Creating Contacts
	Adding Information to Contacts
	Using Custom Fields
	Creating Custom Fields
	Organizing the Custom Fields Section
	Changing Custom Field Names
	Deleting Custom Fields

	Attaching Other Information to Contacts
	Attaching New Events to Contacts
	Adding Notes to Contacts
	Attaching Documents to Contacts
	Attaching a Contact to Another Contact

	Selecting Primary Fields
	Assigning Categories to Contacts

	Using Contact Templates
	Creating Contact Templates
	Creating Contacts from Templates

	Finding Contacts
	Using the Find Feature
	Using QuickFind
	Saving Your Search Results
	Finding, Viewing, and Deleting Duplicate Contacts

	Getting More Out of the Address Book
	Editing Contacts in the List View
	Duplicating Contacts
	Deleting Contacts

	Sorting Contacts in the List View
	Moving and Resizing Columns in the List View
	Dialing Contacts
	Faxing Contacts
	E-mailing Contacts
	Using Mail/Fax Merge
	Creating a Merge Template
	Merging Address Book Data with a Merge Template

	Viewing Web Sites Linked to Contacts

	Using QuickNet
	Setting Address Book Preferences
	Data Entry Preferences
	Phone Formats Preferences
	Full Name Style Preferences
	Miscellaneous Preferences


	Organizing Eudora Planner
	About Categories and Tabs
	Using Categories
	Creating Categories
	Assigning Categories to Contacts and Events
	Changing the Primary Category
	Editing and Deleting Categories

	Using Tabs
	Creating Tabs
	Creating Calendar Tabs
	Creating Address Book Tabs

	Creating Tab Styles
	Creating Calendar Tab Styles
	Creating Address Book Tab Styles

	Assigning Tab Styles
	Assigning Categories to Tabs

	Adding Shortcuts

	Printing in Eudora Planner
	Selecting Print Settings
	Printing from the Eudora Planner Calendar
	Printing Contact Information
	Printing Envelopes
	Printing Labels

	Previewing Your Printouts
	Using Print Templates
	Saving Print Templates
	Printing from a Print Template

	Sample Printouts
	Month View Calendar
	Week View Calendar
	Day View Calendar
	Address Book


	QuickAccess
	Starting QuickAccess
	Using QuickDay
	Viewing Events in QuickDay
	Creating Events in QuickDay
	Modifying an Event in QuickDay
	Creating Contacts in QuickDay

	Using QuickContact
	Viewing Contacts with QuickContact
	Making a Contact a Quick Contact
	Creating Contacts with QuickContact
	Finding Contacts with QuickContact
	Dialing Contacts in QuickContact
	E-mailing Contacts in QuickContact
	Creating Events with QuickContact

	Using QuickPad
	Setting QuickAccess Preferences
	Starting Eudora Planner from QuickAccess
	Closing QuickAccess

	Using Eudora Group Planner
	Using Eudora Planner in a Workgroup
	The Eudora Group Planner Administrator

	Logging in to a Workgroup Server
	Selecting a Home Server
	Setting Server Update Preferences

	Sharing Eudora Planner Information with Others
	Viewing and Creating Shared Events and Contacts
	Sharing Existing Events and Contacts

	Creating Categories for a Workgroup Server
	Creating Custom Fields for a Workgroup Server

	Using Group Scheduling
	Scheduling Users, Rooms, and Resources for Meetings
	Showing Your Time as Busy

	Using the Proxy Feature
	Understanding Eudora Planner’s Workgroup Security Features
	Users and Groups in Eudora Planner
	Knowing Your Security Permissions for a Workgroup Server
	Setting Privacy Permissions
	Setting Object Permissions


	Using Web Publisher
	A Web Publisher Overview
	Improve the Look of Your Web Page
	Drag and Drop from a Calendar or Contact List Page

	The Web Publisher View
	Basic Web Publishing
	Creating a Main Page
	Choosing Export Options
	Adding Calendar and Contact List Pages to the Main Web Page
	Publishing Your Web Page Set

	Advanced Web Publishing
	Customizing the Appearance of a Main Web Page
	Customizing Calendar and Contact List Pages
	Calendar Page Options
	General Tab
	Categories Tab
	Customize Tab
	Calendar Views Tab

	Contact List Page Options
	General Tab
	Categories Tab
	Customize Tab
	List View Tab
	Detail View Tab
	Advanced Tab

	Using Pre- and Post-Processing Scripts
	Using the AboutTime and AboutPeople Plugins

	Using the Status Pane

	Index

